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THE CONSTITUTION OF INDIA
PREAMBLE

WE, THE PEOPLE OF INDIA, having sofermnly resohed to constitute India nto a "SOVEREIGM
SOCIALIST SECULAR DEMODCRATIC REPUBLIC and 1o sovure to all jes

JUSTICE, ¢

EQLIAUT\’ of stabus and f r.l.ll'llr.!..-u'-'l.l [0 PG '|'|:'l|'|l_11:':-.'|'||-:|||

FRATERNITY assuring the digmiby of the individual and the” wndby and integrity of the MNation:
IN OUR CONSTITUENT ASSEMBLY this bwenty-sixth day of Movermnber, 1949, do HEREBY ADOPT,
ENACT AND GIVE TO OURSELVES THIS COMNSTITUTION,

] A, 1970, s, 2

THE CONSTITUTION OF INDIA
Chapter IV A

FUNDAMENTAL DUTIES
ARTICLES1A
Fundamental Duties - I shall be the duty of eveny citizen of India

tor abide by the Constiution and respect s ideals and institutions, the Mational Flag and the Malional

wational -'.n|!'.|!:=l|-r'ur."ru;-q_'n;lr,.:n
ndia
1ty and render national ser i Lipom (o do so;

| ez spririt o Teon brotherho all thee pe

| regional or il diversities: o

PO CuEiiee

forests, lakes, rivers, wild life and 1o have




< PREFACE

CBS5E has introduced Information Technology (IT) as Vocational course at
secondary level in class IX (Level-1) and class X (level-2), In the present day
of globalized competition, Information Technology plays a significant role.
Information Technology (IT) has created a revolution in every field and
onabled students towards I,'?T-H_gl'l.:'h"\:il..'q_l |1_-;!|r'|:'|i|‘4:|'_"|. To enable students owards
progressive learning CBSE equip the students with specialized vocational
fraining,

This Students Handbook titled "Information Technology NSQF Level-2" for
class - X was prepared by PSSCIVE Bhopal for the benefit of the students who

opt for the course.

Ample care has been taken to align the subject with National Occupation
Standards (NOS) which are competency based standards identified by the
IT industry to train students in knowledge and skills that equip students to

F'ut.*!'fl.!ﬂ]’l'l:‘.l L'".i."l._'li.‘.'l.‘l:l.' with -;.'r.'|11.l-'i1.‘]1"!"|-:'r.*.

The language used in this book is simple and easily understandable to the
students at class X level. Relevant pictorial illustrations, tables, examples and
simplified concepts provided in this book help the students to learn with case

and comifort.

This book is authored by competent educationists in the field of Information
Technology under the supervision of PSSCIVE with focus on helping the
students to learn without any difficulty and use this book as a tool for easy

learning.
| congratulate everyone who is associated in developing this book which is a

very useful resource for the benefit of the students,

Dr. Satbhir Bedi, IAS
Chairperson, CBSE
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SESSION 1: ORDERING FOOD AT A RESTAURANT

Relevant Knowledge

Imagine that you are at a restaurant. The waiter has come to ask what you would like to hawva, and
you want (o order a plate of vegetable chowmain. How would you place the ardér? Think aboat it
and try 1o frame some senences 1o do 50

When we place an order, there are some common terms used. Some of them ase introduced here,
Read aloud the following terms

= Starters - The first course in a meal, also called “appetizers” or “starters”
Wsage: “l would like to have Fried Vagetarian Momos for starters.”

Main course - The pnmary of main dish i a meal
Ltzage: I would like to have Shahl Panesr, Chane Pingl, Raita and Rumal Roli for the main
COUrse.”

Dassart - The final course of a meal - i may be fruits or a sweel dish

Study the -:jlilll:tgl,lq} gEvEn bedowr and fll up the blanks UEing it I‘-::;llll:r.\'lng TP O
«  Starters - Chilly Potatoes.

= Main cowrse - Vegetable Fried Rice and Chicken Manchuian with gravy.

= [essert - Chocolate lce-cream.

= Abotile of mineral waler,
Using Articles - a, an, tha
Examples

A fakse fend 15 worse than an by
Are you a good teacher?

Are you the teacher who is going 1o teach English?

Given balow is a conversaton betwean a wailer and the customer at a resiaurant. ||'l1-':|gll'lr.! art
Wi Ang e cusiomiEr, Mow Bl e banks with the stalements thatl o likiE o make while 1:_'|!:-:|r'|_:_|
I thie wianer,

1. Waiter : Are you ready lo place your crder, Ma'amiSe?

Informaton Techng oy




Customer: es, For N vl Bke to have

Waiter  : How many?

Customar: Just one plate will do

Waiter : Okay

Customer: For________  lwillhave
Waiter : Okay Anything else Ma'am/Sir?

Customer: Yes, | would kke 10 Onder a

Walter : Okay One Chilly Potatoes, one Vegetable Fried Rice, one Chicken Manchurian
with gravy, and oneg Chocolate lce-cream. |5 that comect, Ma'am?

Customer: Yes.
Waiter : Can | get you anything else?
Customer: Could you get me

3. Walter 1 Sure, Ma'amiSir

Customar: youd, That will be all

ASSESSMENT

Fill in the blanks with the correct articles A, AN, and THE, whorever necessary.
1. Could you get me bowl of chicken soupT (a. the)

| would like (0 canoel {a, tha) Masalp Dosa | ordered and have
plate of Tandoon chicken with fried rice nstead (a, the)

| perderned chocolate e cream, ndl strawberry (3. e, no article
neaded).

I will have 3 tomato and mushnoom pizza with chese lopping. (a, the,
feo article ndedod)

Far desser, plate of khear will do (A, the, no afticle neaded)

| wll Fagrg khearfor dessert (a, the, no article neaded)

Our specialty is Tandeon chicken, Do try it (a, the, no article needed)
glass of water

I would like o have onéon masala dosa and vanilla ice-cregm

Excuse me, where (5 washnoom?




What 15 specialty of this restaurant?
Can | smoke cigaretie hera?

C-an we sit on upper fheor?

What is on mianu today?

O you senve Chinese food hera?
Pleasa give me some tissue paper.

Coould you ball me recipe of this desh?

SESSION 2: MAKING RESOLUTIONS

Realevant Knowladge
Havi you ever made a promise 1o yoursaif? A promise could be as simple as:
1 1wl meoner Bl iy Dean P Adumin
I will try 10 study hird this year and get a 1 division
| will talk less on my mobde,
| will help mather out with her household chores when she comes home tired from work.
I will et 95% in Math this year.

I will bzarn to speak properfy in English within six months.

Thirk about what you would like to promise o yourself. These promises are actually what are
kntwm a8 your own “resolution”. In the session, we will learm aboud this concepl

simple future tensa

The use of words ke wall and shall denobe the Tufune bme o
Mow read the following sentences

St A
1. Dwill try ta learn English well
| will try 1o sea fewer movies,
| will lesdrmn three nes wonds eveny day.
| willl exerclse every moming for 1 hour.

| will not carry forward any regrets,

Infcrmakegn Tachngd ooy




| will keep my noom neal and clean
| will accapt the terms and condibions
He will not et you join
But we will argue in your favour,
e compane the above senfences with the !l:llh:w,un!;_]
SetB
I try to learn Enghsh well
| try to see fewer movies.
| lparn three new words every day,
| axercise avery morming for 1 hour
| take cara of the dogs in my oolony
| do ot carry any regrets,
T | kpop My POOm meat and clean

Do you see the diference betwsen the two sais e 981 A and B of sentencas? The first set of
sentences is in simpde future tensa. The second set denoles a fact or a habit, and are all in the
sirmole presen! fense

Read the following sentences. These are incompdete sentences. Try to fill them with what you
wish o dain yiur ke

1. | promise to...
| proay
| resolve mever io..
| resolve 1o,
I will fry ..
| will try iy Beest.

| @m mener goeng 10.

ASSESSMENT

From the following options, select and tick the one that is in the simple future tensa.

1. | ded nod smoke.

(a) | will not smoke




(B} | will ng

(e | el rudd

| exercise dveryday o slay it and healthy
(a} |will exarcised everyday (o slay fit and healthy.
(B} | vl EXEICIZING everyday i ¢ il @nd ealthy,

(c) | will exercise everyday 1o stay fit and healthy

| opaened a small fower shop in the marked
(@) | will open a small fliower shop in the markel
(b} | il opened a small fiower shop in the market

ic) | will opening a small figwer shop in the market

The president and his wife ralsed funds for charity
(a) The prescent and his wite will 1 funedds: for chanty
(b} The Fresident and his wile will raised fund for charity

(c) The President and his wie will raise fund for charmty.

| stuck i My negolutson
I:E_I' | vl E-DCH.II'IEI 18] my resolution

(o | wall sk o my resoluteon

{c) | will shuck to my résalution.

| I::I'l:_'ir'lgf:-:_‘.l most of the furmbure n my ouse batare Deawal
(a} | will changed most of the fumiture in my howuse before Chbwali,
(B} | will changeng most of the fumitenes B my howse before Diwali

ic) | will change most of the furmiture in my house before Dewali.
| staried going for driving classes on Tuesdays.

(a) |will started going for driving classes on Tuesdays

(b} | will starting going for driving classes on Tuesdays.

(e) | vl st going far dma ) classes on Tuesdays.

Team India won every match against Australia in the Wordd Cup

(a) Team ndia will won every match against Australia in the Woeld Cup

Infcrmakegn Taching ooy




(b} Team india will every match :ag.a.-n:ﬁ Australia in the Waord Cup

(e) Tedm ndia will WNIfg ey mabeh AEARTS A in the Ward Cup

| spoke n Er‘l{;li:‘;i': wilhy Ty friEnds
(a) |will spaak in English with my frignds
(B} | vl .-'_:;;rE::_'lli.lr'lg j] Englu:.-h wilh mry friemnds

() | will spoke in English with my friends

| weare the Saal bl while driving
(@) | wall wore e seal bell while driving
(b} | will weanng the seat bell while driving

ic) | will wear the seal belt while driving

SESSION 3: TALKING ABOUT CHANGE

Relevant Knowledge

Ini this session, you will leam how to talk about change. Read alowd and try o understand from
i Examples given Below

1. Change for the betier - to change 50 as lo improve.

Exampla: He does nol wabtch junk mdvies anyn and Hisa 1:J"|.i].|‘r!]|3 for thie beller. He i
efNgdys Seniug cingma

2. Change for the worse - fo change bul become worse.

Example: She has started readsng novels. But it is a change for the worse as she reads them
mare than her school books!

i1

3.  Change with the times - fo accepl and adag! fo new developments

E::ampla: Cur schoal ts changing wiih the Bmeg. We now have computer kabs with free infenmet
connechion

4. For a change - as something different
Example: Wiy don'l you wear a sabsvar sudl for a change? You always wear sarees
5. Time for a change - an expression used whan / is fme fo make & change

Example: | asked her if £he wanied a cake for her birthday, and she said, “It"s bme for a tlu'ln_r_;&.
lei's have pizza instead!




7] Times ang tl'lﬂl'lﬂll'lﬂ - @ resSponse made wihen you Dear 8 Surprsng plece of news

Example: Man: “The ::h{n'-;;u‘_-.lﬂ e 500 Rupe oFf TS el Wodmnan: “Wal, BimsES ang l:h'._':r'lﬁu'r{;
Teea do nol cost 100 Hupees anymore,

7. Seachange - 8 major change

Exampla: There s a sea-changs in the choica of caredrs. Many youngsters ane mons intenested
n MEA nowadays than in medicing or Givil Senvices

B. Times change - as fime passes, diferent things become accepiable,

Example: The old man scolded his grandson for not cutling his long hair, He sald that when
he was young, he had to keep it shor and ociled. His grandson said, “Times change,
Grandpal”

fctive and Passive Volce

Fead {he axamples given By

Actlve : The hair stylist changed the color of my hair.
Passive : The color of my hair was changed by the hair stylist
Passive : | was praised by the headmaster

Active : The headmaster praised me

In cartain sentances in the passive voice, the subject may nol be mentioned
1 You shoubd do the work - The work shoold be done
2. ‘We completed the marathon at last - The marathon was completed at last

3. Has she finished her homework? - Has her homework been complefed?

Mow, identify and tick the sentences that are in Active Voice:
1. They have been scolded.

| bouwght some clothes yesterday.

The leacher 15 cormecting he tesi paperns

The test papers have been submitted

We werl there |ast surmmer

We weare welcomead by the hotel cwner.

She belseved him but we did not

He was trusted neither by us nor by e

Informaton Taechng ooy




ASSESSMENT

Select and tick the option that is in the passive voice.
1 Hawn had o revise e costumend

(ajl Ravi had to be revised in the document.

(b} The document had to be revised by Ravi.

Eam should leann hosw 1o
(a) Adpesting o changd is

ib) How to adjust to change must be leamed by Ram

Seama has changed the curtains of the bednsom.
(@) The cunains of the bedroom have been changed by Seema

ib} The curiains of Seema’s bedrogm are changed

Can Mayan update this file?
(a) Can this file update Nayan?
(b} Can thes file be updaied I:}"' Mayan?

T 1l|||:||,|'|h aiould |::l'||{||‘|-g]|3 Ihl:l‘-g]r} for the babhes
(a) Things should b changed for the better by the youth

(B} The youth hawve (o change hings 1or 1he befter

He made some changes to this docwmean
(@) Tothis docwmen Some changes he made

(b} Some changes wide made to this dacwment by him

You can change your future by leaming English
(a} “our English can change your fulure

(b} ‘our future can be changed by lxaming English,

Mothing can change his mind,
(a} His mind can't be changed by anything

b} His mind can be changed by nothing




orkers do not ike the new policies
(a) The policies do nod BKe e niw Workers

] The new podicies are nol ked by the party workers

Change makes progress possible

{a) Progress is made possible by change

SESSION 4: PLANNING AN OUTING

Rélavant Knowladga

AR auting can (42 ] Cping Tof & picnie, QNG O @ Mo, Qoing oul for lunch oF dinnid. o <4

for shopping. All guch oulings reguire some preparation -the exient of the preparalion may vany
depending on the nature of the outing.

imagine that you have to plan a picnic for your famdly and friends. You may hawe to prepare a “To
D™ list of all that you need to do and take fo the picnic. YWhat would you do o prepare for the
picnic? Thinkl
Making a suggestion for an outing:
1 Led s =la) 1o an :H.ll:lr'lg"

Let us go for a picnic

Let us go lo the movias!

Let us go out for lunch!

Left us go shopping and hawe lunch oulside

How ol going for a mowie?

Shal we G 1oF @ picd hes Eur‘l-:].;‘i:,r'-"

How about 8 shopping trip and lunch afterwarnds?
Flanning the outing:
1. |will book the cab and you can amange for the food.
2. You can take care of the plates and glasses

3. Bring bottles of water, napkins, and some plastic bags

Infcrmakegn Tachingd ooy




4 L-an you bnng two maks or an old bedoover 0 spread on the grassy
Can youw check Gl whal tirme the park is opan?y

Can you book the movie lickets?

B
7. 'We can meet at & outside the theatre.
B

I will call up Meena and Rakesh and e if they want b0 come along
Pronouns

In this session, you will learn how to make use of pronouns. The reflaxive pronouns
discussod in this session are: myself, ourselves, themselves, yourself, yoursehses, himsalf,
herself, and itsell.

Reflexive pronouns are used usually in 3 situations:
Situation 1: When the subject and object ane (he Same
For exampia:

1. | hurt myself

2. The music ghoup calls themselvas “Dire Straits”

3 He shol himsall

Shuation 2: As the cbied of a preposition, when the subject and the object are the same
For example,

1. | bought a presant for mysalf

2. She did it by harsell. (She ded A alone)

3. That man is talking 1o himself

Situation 3: When you wani to emphasize the subject
For example:

1. 1 do it myself (Mo one else will help me)

2.  They ate all the food themsalves (Mo cne else had any).

EXERCISE

|denisty the incorrect use of the pronouns

1. Mila% and | weni (o the cafe 10 buy us some snacks
Wihen | s mg in e mirror, | was hommifeesd (o S8 red spots all owver iy face
Did you leam byping yourself or you weni 1o a school?

What he saw was so unaxpecied that he pinchad him to see if it was for raal




Flease help yourselves 1o the 1ood - there 15 plenty|
| R mrtﬁllwﬂﬂﬂ !|:1.'|'1!3 the beoken shelf
| am busy...can't you do the work yourself?

| bought a nice dress for me from the mall

ASSESSMENT

Fili in the blanks with the correct pronouns.

1

Excipt Ruhi and . BvEfyong a&lse aifived a1 at the movies

(ap | () me

Ravi was wery hedphul to when we wani irekking in the mountains.

(@) us (b) ourselves

e really enpoyed on the tnp 1o Manali last month,

ia) us (b} ourselves

His friends did not appreciale going 1o the fair alonse.

(A} his (b) hemsel

Please bring some cotton for your ears if you do not want o be bored by

contevwous chatber on the trip.

(@) his {i) him

As our driver had fever, Maman and offered to dirive the car for the rest of
thei pourmeay

(a} rmine (o) 1

Chae o will nave o spiak o the travel afgent A Mk {tl‘l‘ﬂr‘rﬂﬁf‘r‘l&r‘l.h!: fou
tiue trip.

{a) you (b) your
W rust reach the armpor on Bme, or else II.\'L| riss e Illgh'.
{a) we {b) us

1wk wihd wanted 1o go o the mowntaans instead of the beach
(a) Himsalf (b} he

Irformaton Techno ogy




10, Two of ihe Qroup members, |=1.-.’_'J|.||:1||‘r!_.‘_| . have offered 1o make food and
travel amangements for the trip,

(&) hi () P

SESSION 5: NARRATING A STORY

Relovant Knowledge

Have you ever been iold a story batore’ Ferhaps many tmeas! What i 15 that you ke the mosl
abou the namration of stories? Perhaps you like to know whal happened to other people, or stones
tedl you what you could do in a similar siteathon, or maybe becausa it halps you o reliewe tension
and entertains you. You may hinee many other réasons. Think about them

You will 000 sse that narraling a stoey is similar bo narrating an incident - only story naration is
a able because il & presented in an animaled fashion with the r|§_|'h| monations, pauses and
exclamations

When we namate an incident too, we could use voice modulation 1o express what is being said
wilh emobons. That would defmsbedy make i g 5] for e shEner

Marrating a Story of “Two Wolvas"

Read out the following story aloud. Try bo narrate the stony as best as you can,

Ome avaning, an ald trbal tofd his grandson about & hatfle that goas an inside paople. He saidl: Ny
son, the balile is batween Two wolves” inside us all..One is Ewl § 15 anger, anvy, jealousy, sorrow,
regrel, greed, amogance, self-pify guuit, reseniman, mferonly, hes, false prde.... supenomy, and
ego. The other is good, It is joy. peace, love, hope, serenify humilify, kindness, benevolence,
ampathy, generosily, bruth, compassion, and faith. ™

The grandson thought about it for 8 minute, and then asked his grandfather: “Which woll wing?*
The ol fribal simply rephed: “The ané you feed.”

Simple Past Tense

I this seasion, you W beamm how 1o make use of Smple Past Tense, Read alowd the follaing
sentences

1. My grandmathér lowed to namabe the story of Ram and Ravan o mé when | was young

2. | used to lisien eagerty to her.




She akwayvs left aff the Slory al an |r'|l:|3|'E:.E-:I|r'Ir_:_;| point, and sasd °| will tell you wihatl happensad
after that tomormos”,

| would eagearly walt for the next day o Comee,

The next day | would pester her to tell me what happens ned

| nnjvn:.ln-ﬂ e % :r_-.llmg;. Si0nS wilh my 1_;r;_'1r'||;1'."r'||:p1h{:r Wiy much

| don™t know if | will e abde Lo entertaan my grandchild in the Ssme way

Maost probably | will not have many stories to tell or my grandchild will not be interested in
hgbening 10 Sl00es

Bul | can surely say thal telling stories helps to expand a child’s imagination in a way thal no
other thing does

| was exhausted
It was a very lifing jowrmay.
| had a tifing journay

The pourney exhausted me

EXERCISE

Do you remember the differencs in the tlenses? Mow, identity the senfences thal have been writlen
in the present and fulure lense

1

2.

My grandmother loved 10 namate the story of Ram and Kavan o me when | was young
| used to lisien eagedy to her.

| would eagerty walt for the next day to come,

| enjoyed the storvieling sessions with my grandmother very much,

| don®t know if | will be abls to enbertain my grandchild in the same way

Maosi probably | will not hawve many sfories to tell or my grandchild will not be interested in
lisbening 1o stofies

| was exhausted
1 Wwas & vy lifing jounmiay,

| had a tning journey
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ASSESSMENT

From the options, select and tick the sentence that is in simple past tense.

1. (&) Seema visiting auni Rekha at her house near the beach last weekend.
(b} Seema visided auni Rekha at her house near the beach st weekend,

(] Seama vigd aunt Rekha at her house near the beach last weakand

(a) Itwere a beautiful summear day
it was 8 beautifl summer day.

Itis a beautiful summer day.

Seema building & giant sand castle on the baach
Seema builkd a giant sand castle on the beach.

Seema built a gquant sand castle on the beach

Aunt Rekha took pectures of ihe castle
Aunt Rekha take pictures of the castle

Aupni Rekha taking piciures of the castie.

Seema wanked 1o play on (he beach and build another sand casta
Senemia want to play on the beach and build another sand casthe,

SEama wanking o play on the beach and build angther sand casthe

Bt s00n it has become very hot outside
Bul Sodn i Decame ey hol outside

Burt so0n i becomes very hot culside

Aunt Rekha advised Seema to wear a hat
Aumt Rekha advising Seema to wear a hat.
Aunl Riekha advises Soema lo wear a hal
But Seema does not have a hat

But Seama did not have a hat.

Baurt Seema didn'l had a hal




=0 Aunt Kekha gane Seama one of her hals

SoAunt Hekha Givineg SieEma o of e hals

So Aunt Rekha gives Seema one of her hals

Seema wearing the hat and made another sand castie.
Sefma wears the hat and made andlher sand castle

Seema wore the hat and made another sand castia.

SESSION 6: DESCRIBING A KNOWN PLACE

Relavant Knowladgea

DhEgeripinag '..'.'rr.llr'lg] 5 an art foom. 11 s ke painting a word piciung 5o that the person who resds
wihat you have writien or ksiens i whal you have sasd, "seeg exacthy whal you meani 1o descnipe
To praciice descriplive writing, think of a few sentences about the city you grew up in. You could
siart off as:

The city that | grew up in is iname of the siate).
It iz & largedsmall city in {name of the state)
The weaather thera is quite
Adjectives and advaerbs
1. | am ready to take the test. - adjective
| am raadily taking the test. - advwerb
She ran oul of the room in a hasty manne. - adpacine
She ran out of the room hastily. - adverb
I was happy whan | received the certiicate, - adjectiva
| happily recerned the certificate, - adwerh
Here are some adjectives (o dascebe a city
= Gty actve, bustling, noigy, busy, cheen, dty, windy
Traffic: loud, congested, snarled.

Euil-l:lil'lgs.' old. shabby, rundown, crumbling, modem, fulunstic, skeek, fowenng, squat
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Buildings (walls): bnck, stone, marble, glass, stesl, graffiti-coverad

Monuments, statues; 5 s, COpper, canned, ancient, moss-cowened, faded, green, Bronse
Sidewalk: concrete, cement, slick, cracked. tidy, Mtered, swept

Paint: fresh, weathered, pealing.

Signs: neon, wealhened, worn, baght, weltoming, flashing

Busas, cars, taxis: balching, crawling, speeding. honking, waiting. screaching

Poopla: humied, bundled r:-:l‘|13|||1!_:_| h‘l]m‘m‘lg_ eRGer, rugshed

Mow, try to describe your cify using the above pointars

I, Read aloud the following phrases on “Describing Nainital”, Combine the phrases so
farm & paragraph ihat descnibes Mainital, For examphe

Exampla: Nainital is & beautifid hit-stalion in Ultarakhand
1. Mainital is a beautiful hill-station. .
It is surrounded by,
in Uttarakhand
above sea-level,
hlgh Mauntain peaks
Mainital ks a verny...
-especially during winter,
popular bounst spot,
wiikn the snow falls,
il atiracts a kot of tourists n
-during the British Raj.
The temperature varies between..
wihsch were eslablished...
16" Cand -3 "G af that e
and iz situated al an allitude of 1, 938 melers
Apan from its beautifg Sosneny
IS many SChiooes

Mainital i5 also known for.,




Mow read aboud and veny canelully, ihe descnpbion groen below
“Ladakh".

Leh, Drass valley and Leh-Manali track are popular tourist Spots.

Ladakh s a FEC Silugied o Jammiu and Kashmir

Tourists come for fishing and trekking.

Ladakh has a population of about 2,680,000,

The Kunlun mountain range es 1o the nonh and the Himalayas e 10 the south
Th I'.{ll'lgl.l:J{H} % writben in the Tibetan scripd

The people of Dha-Hanu follow Tibetan Buddhism

Ladakhi cullure and Tibetan cullure share ma Iy Samitariees

Popular spons inClude ;u-::;l"liﬂ":,r_ o hoCkey, and cricked

Buses and laxis are available az means of transport.

The dances are about the fight beteaan good and ewil

The peophe speak Ladakhl which is also Known iy Archaie Tilbetan
Abourt 18,000 towrisds visil Ladakh @wery year,

On the other hand, thoge Ipsing @anound Dras have converted 1o Islam

It is the highest plateau of Kashmir,

The Ladakhis celebrate masked dance festivals

Read carefully the following passages on “adjectives and adverbs™ and identify whether
the words in bold ane adjectives or adverbs:

| weisnit 10 Jaipur, also known a8 Pink City. Many paople r'l}.l-di[y ag ree it is one of the bast
structured places in India. The fown was carefully planned according bo Vastu Shastra, i
was built in the form of an eight-part Mandala known as Pithapada.

| hawe never seen as heavenly a place as Kerala's backwaters. | took a ride in 8 keffuvallam
(hoasse boal) and what | saw was truly beautiful. Palm treas, pandanus shrubs, a variety of
braty plants and bushes attractively decoraled the place

My family went on a trip to Manipur, One of the many places we visited was the Keibul
Lamjao Mational Park. It is the only floating national park in the world. The place is marked
by floating plants called Phuwmdll The park s the home of the Sargal of Brow Antlanid Deér,
an andangered Species which canndl be Tound anywhare elde on eanth
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ASSESSMENT

Fill in the blanks with the appropriate word from the given options:

1

| moved o a new city

(@) recently (D) daily

| niowr live in the: heart of Dalhi.

(a) comfortable (b) comfortabhy

My houseé is a tweo-bandnoorm flat in Mayur Lok

() spacehd (b) spacious

| Iree Inere waih my frend, Manigh,

(@) best (b) betfer

There is a MomUMent Nearn our Nowse.

(a) histery (b} historical

Whan | farst moved to Delhi, | found the city (o ba (oo and crowdied,
(a) noisy (b) noiseful
Mow that | have lived here for 3 couple of years, | can't magine moving back o my

el

(@) smal (b liny

Lrelhi 15 the capatal of Indsd amd connecied to 8l mapor cibes of the
IZ'CIIJFIIIF:.I' h!f' romd, rail, ang i

(a) good (b) well

Maywr Lok is one of the kncalities in Delnd

{a) best (b) good

The area is well-maintained and planned

(a) prathly (b)) beautifully




SESSION 7: GIVING DIRECTIONS

Relevant Knowledge

Look ai the following map. How would you give the direction to City Mall?

Tors Bus Depot
L

Head the "Terms and phrases for giurng directions™ green below

1.

intersection - Alsc known as “junction” and “crossroad”, it is a place where two of mone
roads maeel.

Example: We kKepl -:_Il'ml‘:;:; Bl we came 1o an inlersechon, YWe did ndl know wihech road 1o
foliow, 30 we asked the traffic police for directions

Fork - The point a1 wiech a road divides inio branches

Example: Keep walking left till yvou come to a fork; take the road on your nght and keep
walking. The shop ks thera at the end of the road.

COurge

Exampia: The markel is on the other side of the road. You will have 1o take a U-twn to reach
il

Turn laft/right - Go to your lefiiright

Exampla: The man told me o walk down the Streal and al the end, burn R
Signpost - A post bearing a ségn that gives information,

Exampla: The sigr says thal we have o (ake the road on Ehe kel for Moida
Landmark - An easily seen building or place that serves as a guide,

Exampla: The City Mall sarves a5 a andmark for their office
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Across the street - On the other side of the street,

Exampla: The Daok slong 5 just 8tross the il

MNaext to - Beside

Exampla: Mchan Lal Grocery is next to the mabile shop.

Go straight down - Keep walking along the road

Exampla: Go straigh down this road and tum righl. You will find the hospital thane,
Take the first'second road on the left/right,

Exampie: To reach the school, go straight and then take the second road on the right.
Around the corner - Mear the comer,

Exampla: The markeat is just around the comer of the DESU residential complax.
At the end of - Last Pan

Exampde: You will find the sione at the end of this road

EXERCISE

abudy the lowchart Ve e b

Litthe Anges Sehood

Khadi Home

(areen Fark




Roulg A : Fun ".-’lllagi_‘.'_ Fushpak Book Store, Traffic Point B, Traffic Pomt A Orental
Restauran

Route B : Green Park, Khadl House, Traffic Point B, Traffic Point A, Onental Resiaurant
Route C : Green Park, Khadi House, Working Women's Asscciation, Litte Angels School,
Orriental Restaurant

In short, there can be mong than omne route n which you can gve dwections o neach DMK
Hompetal
Prapositions

A prepositon i a word that links a8 noun and pronoun o other words m a senlence. For
examgle:;

1. We went bo the market,

2. The market is just around the comer,

A, Many kinds of slores can be found at the market

Prepositions are used as follows:;

*  Prepositions of time: at. on, in, during, since, until, by, afc. We reached the hostel at S pm.
W reached the hostel on Monday, We will reach the aipart in an hour. Mote: Lise at for
spechc limes, on for days and dates, and in tor non-spacfic limeas

Prepositions of place: al, on, i, over, above, under, beside, behind, efc. We went to the
library. The Borary is on Hudson Lane. Mote: Use at for specific places, on for roads, sireets,
atc., and in for cities, countres. alc.

Prepositions of direction; to, from. across, through, around, ino, towards, efc. The
electronics shop k5 across the sineel. The cricketers went in that direchon

Prepositions indicating other relationships: by, with, of, for, elc, This sar is made of silk,
A surprise is waiting for you

ASSESSMENT

. Fill in the blank with the correct praposition given in the bracket:

1 Go straighl dosam Kengsway Streal and yoan vall fimdd e ahop wour mght (in,
onj

The jeweler's store is right mexd the bus-stop (for, o).
The flarist’s sall is Kamna's house (below, under)

You can find her house the comer of the main street. (around, from)
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Walk you reach the trafic poent (M, before)
The book stone s jIJ5-1 the sireel (2Ccrogs, under),

Walk straight this road and you will come to a traffic point (down, beside).

Fill in the blank with the correct preposition given in the bracket:

I'm wery excited aboutl mesing my fiend today Dilli Haat in the
Evening at 4

(ayon {b) at

My friend stays in INA colony near Dilli Haat, whereas my house is quite far

(@) across (b) from

In the mderning, my friend had given me the directions this place awer the
P,

(a) to (b about

| will take Bus no. 540 the Centrad Terminal and get off the INA bus stand

(a) from, i (b)) froem, ad

My friend had said that Dilli Haat is right the road.
(a) across  (b] owver

She will be wailing for me the Sikkim food stall,
(a)on (b at

The Sikkirn food siall s ocaled the Manipur and Rajasihan food sialls

(@) across (b)) between

The hot momas sened thene ang 50 tasty - | can wail éat tham!

(@) or () Lo

Oihd | think that's my bus that red truck.
(a) bahind () onir

| must hurry up and get it or my plans for a great evening will be spoilt.

(a) onto (b} im




SESSION 8: DESCRIBING AN EVENT

Relevant Knowledge

Have you attended any event recently? |t may be a wedding, a birthday party, or any function -
any evend. Try and form sentences about the event. Maybe answering the following questons
maght hadp wou

1. 'When was the evenl held?
Where was it held?
How many peopla camea?
How wias the food (if it was a party)?

5 ‘Were thene any special programs? I 50, what wera they?
Present Continuous Tense

Thie Present Conbngous Tense 5 used (o descnbe an acbion 1hat s oonl aLiing at thiE modmen
| am walking.

2. Bhe is preparing lunch for everyone,

The verb will abways lake the form “slamfare+verb+ing” depanding upon the subject
ritMeena/Hajan is wa'lliing-
Thayhwelyouwthe people are walking.

| am walking.

Read the following:
1. | describe an event. | am describing an event,

She/he/Reenaaran/etc. describes an event. Shehe/ReenaMaran/etc. s describing an

Youlwe/they/the students/ele. deseribe an event. Yow'weltheyithe studentsietc. arg
deseribing an event.

The sentences with “is'amfare describing” as verb describe an aclion that is continuing al the
mament. Therefore,

1. We are learning the Présent Continuouws Tense,

2. We are learning how to describe an ewent

Wie arg |i:rﬂl"l'!|r'lg F:-I‘lgll.‘].h
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Read the following sentences and identify whethar they are in the present continuous
lansa or nol.

Everyona is enjoying Sarita's party

Sarda 4 distributing oold dinks 1o her guests

Devidl wants io play his guitar and sing a song for her,
All the gueests encouraging him to do that.

Ewen Sarita herself s teliing him o perform.
Read the sentances on “Smita’s Birthday™ given balow.
It was Smita’s birthday
We amanged a surprise berthday
All her friends
as it is her favourite
Everyone arived

at 12 p.m

We screamed © “

Then, she blew the candles and
Asha and Sumeet
gang & song and enfertained everyone

We played Anfakshar
Using the following phrases fill in the blanks and complete the sentences.

Bufise”

were imviled
Smita enered the room
Cif it for everyone
Smita aven...

party T e
.an tifme

digiribuied faod and drinks




9. Wepgdlard
10 an Sunday

11 and gumb charada

ASSESSMENT

Choose and the tick the correct option, which is in the Present Continuwous Tense,

1 i i e 1o atbend a fnend's wadding al Sainik Famms on Salufday avening.
We are going 1o atlend a friend's wedding at Salnik Farms on Saturday evening,

We wen! to attend a friend's wedding at Sainik Famms Saturday evening.

Everybody will h'.:wm;_'| a greal tirme o i Pty
Everybody is having a greal time af the party.
Everybody hive & grest irme at the party

The bride is lcoking gorgeous in & traditional red silk sanes.
The brice looking gorgecus in a traditonal resd silk sanee

The bride will xoking gongeowus i a tradibonal red silk sanes

The waitars sarving delcious snacks and drinks.
The waiters serves delicious snacks and drinks.

The wailers arg Senving delicious snacks and dinks.

The D is playing soft music while the guesis have their dinner,
The D is playing soft music while the guests are having their dinner.

The DJ plays soft music while the gueesis are having their dinner.
Hi is going (o play Somdé popular Bolbywood numbiers,

He has some popular Bollywood numbers io play

He going to play some popular Bollywood numbsers.

miE ks have runming a roand wide Some wall be dancing on e dance foos

Some kids ang running around while some ang danding on the dance Aoor

Some kids are running around while sgme dancing on the dance foor,
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e ane r.-'l.ﬂl'u'ur'lg o dnnk coffes 10 stay awake hrough the nn_:]hl:
] |;_:-:l'.'||'||‘||r'|5_| o dink colfed 16 ba :;1:]-.'||‘|E| ek l:hrr_'u.li;h EhE ﬁlghl.

Wa dnink coffea to ba slaying awake throwgh the night

Pandit Ji reciting manitras and parforming vanous rtuals.

Pamedit s gaing 4] reCiting maniras and p&rmrn'.mg Vanous rtuals,
Fandit JH Is reciting mantras and performing varous rituals
Everybody is Showanng flowers on the newlywbis

Everybody are showering flowers on the newhpaads,

Everybody :&hl;‘m&ru‘ﬁ:; floerers of the |'|E:'.'|.'I:|rw&ﬂ§:

SESSION 9: RECOUNTING AN EXPERIENCE

Relavant Knowledga

The purpose of a recount is to list and descrnibe past events by retelling the events in the sequenca
in which they ocourred, A reécount tells about somathing that happened in the past. Hence il is
wrilien in fhe past lense, (8 q | roa = | £@n, |1 g - | went), The defails in the recouny can include
what happened, who was involved, where it took place, when it happened and why it oocumed

Acowniter or speaker uses a recount (o el us aboul a story oF an eveni. Kecounts ane usually gren
in the order that the event occurred. Recounis can be;

. Factual, such as a news slony
= Procedural, such as telling someone how you busd or make something
= Personal, such as a f{m‘ri':.l hnlu;l.:qll OF yOurr GOEnion on a .*;|_|I:||{r-::l:
Examples of a reécount includae:
- Eu.'.;-\';ra[!ll'nﬁef_: and autobiographies

Mewspapers of the elevsion news

Latters and FI-EE.II-.'.-!FIL'E

Teudbooks

Convergatnng with inends




Awell-smeciured recount inchides detaals of ihe event of iopec and personal opemons I.'_']r;ﬂlﬂirr:]{l:E:n;
recounts may hawve a tithe if you are giving a presentation. However if you are simply talking with
friends you wouldn't announce the tithe of your conversation|

Past continuous tense

The Past Continuous Tense describes an action that was happening at a time in the past, A verb
in this tense will akways take the form: Washware + verb (+ing)

= lishefhef/MesnaRajanithe man was walking.
- Theyhwelyowthe peophe were walking.
She was 'm:rh.lng on her pamiing
He was rehearsing for his performance.
Some examples of Past Continuous Tense are given balow:
= | am walking - Present Continuous Tense
I was walking - Past Continuous Tense
Shah it Tma is walking - Present Continudus Tensd
ShefheitTing was walking - Fast Continuous Tense
Wetheyihe people ang working - Fresent Conbinuous Tense
Weltheythe people were working - Fast Continuous Tense

Can you tell the difference between the two tenses?

The Present Contineous Tense descnbes an action that is happening présently while the Past
LConnuous Tense descrnbes an action that was hap pening at a tireg 0 e past

A wierh in the Past Continuous Tense will Bake the adm
Washwere + varb (+ing)
Mo, from the following sentencas, identify the sentences in the Past Continuous Tense.
1 | Wras gn-ll'lg b dell ¥ou A slory
Thaey told mae thay playing a gamaea
She is making brea
We were planning to visit the zoo.
The zoo was closed,
Celebrations wene happening all over the world
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Read the points given below, wery carefully. Now, construct them into a paragraph:
= Taking a walk in the park.
. Saw some people playing badminlon
= St down and wakched,
Realized one of the players was an old classmate
Called out o her,
She came o me,
Todd mie she was my classmale’s hwin

| apalogized

She asked me 1o jen Eheir Qarme,

| agreed

Enjoyead a nice round of badminton with them.

Read the phrases in “Trip to A Mall". Fill in the blanks with appropriate phrases.
. wi decided o go
" | tald hirm.
= Tor our lunch®
Then we went looking...
if | had any plans this Saturday,
Ahe food cowrt had nod bean built...
in the rall
wiere i was located,
Tor @ wihale
..o search the huge mall

We ware already hungry...

Ity frierd calbesd rmae up and asked me
to the mew mall. These were many good siores - We
wndow-Sshopped. for the food-court. Bul we couldn't find i

W werne forced I At last, we asked B guand




and he iodd us that as yel, 'We came out of the mall and had 10 go

1o a ahalba

ASSESSMENT

Fill in the blanks with the past continuaus form of the verbs given In brackets. The first two
have baen dona for you.

1 | was ui:'lti:ng iy childnood friend Venkat 'g.'r_-.:;mrd.[r:,r
2. 'We were golng to watch the movie Don on DVD,
W {zea) the mose for the second Eme
e (empoy) the popooms more than the movee.
Ini khe evwening, we fpfan) to make a chocolate cake
Both of us fera) b0 the marke! 1o buy uﬁ;_in_‘.la'[!lh:r} bar dinner
Wi farmvirng) o the suparmarkel
Thie sugermarke {affer) sale on all shocks

E'-'EF!.'DDEI',' {mova] lowards the entrance at the same tme

SESSION 10: FINDING A PLACE TO STAY

Relevant Knowledge

I|'r'|'.3|E|.'-.1".4: hat you have ju 81 moved inlo 8 mew City and ang h::l.ljk_-:n;; hor a plase o .E-:I{Ir:.l How IﬁE!,-'
would go about doing 07 You can use the following pointers

= 'What kind of place do you wani?
= What would you reguire in & room?
¢ Would you take the halp of a brokar?

= Wiould you negobate the rent’s
Make appropriate sentences

Given below is a list of terms you will encounter when you want to rent a residence. Read aloud
1iH "thnting Terms™, understand 115 LeanIng and USage

1. Broker: One that acis as an agent for others in negotiation, bargain, ele.
E.g. The broker hedped me find a room at a8 reasonable price
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Rent: Fayment made by a person for slaying in a place owned by ofhers
E.g. I and my fhree fignds are vang on rent naw.

PG [Paying guest): Someane who vas on reént in the owner's housa
E.g. PG accommodations ane sasily available these days

Apartmant: A flat

E.g. Sheila and Renu have renfed a hvo-room apartment in Pune,
Landiordlandlady: A mantwoman who provides rooms for rent.

E.g. Our lanaiady alfows s o sfay oul B 10 p.m. anly

Tenant: A parson who lives on rent.

E.g. Mr. Gupla's fenants always pay their rant on time

Single-room flat: A flat with anly one room

E.g. A | am planning 1o stay &one, | wall ook for 8 Smgie-room Ral
Doubsle-room flat: fat with tao rooms

E-'E- AL s e r'_:i.fnr'lr'lrﬂg to stay r-:-ggr.t-g-r W Wil ok for 8 double-roorm fal

Commilsalon: A fee that you have 1o pay to an agentbroker for their senices
E.g. We aiso have io pay the broker his commission.

Motice: A Tormal ann
I e grvie

E.g. The landiord Ras & simple g - gvery lenam musd ghve 8 moanth’s aolice f they want
their sacurily Dack,

Fead the dalogue seclion belon on "Flt'lﬂil'l.-g & Place 1o ST.B'H'". This is a conversan/dalpgue
between a broker and his client. The client is |l5I'2I]':|ﬂg for & noom.

fou have to fill in the blanks by forming complebe questions using the points given in brackels
Twao of them have been done to help them understand

EXERCISE

Client : | am kooking for a place to stay.
Broker : Ok, Do you want 8 single room of doubile room? (Single room o double noom)
Client : Since | am goang 1o stay aone, | would prefer a Single foom.

Broker : 7 {just a single room, or with kibchen)




Chent : |wantaanghe room with altached bathroom plus a separate kKilchen, Brokes You have
Lo Fll]h‘l on ime. A oo wikch has all these has |u£|: been vacabed

Client : ? [how musch the rent is)

Broker : 4500 Rupeas.

Céent . 7 (whether includes electricity bill and water bill)
Broker : Yes, yes. |t incledes both

Client : Do | hawe to pay sacurity? (whether | have to pay secunty] Broker: Yes. You have to
pay a security of 2000 Rupees

Cliant : T (hiovar msch wour fea ig)

Broker : | charge only 25% of the rent

Client : 7 (whether fee is negobiable)

Broker ; | am afrakd it isn. | is quite low. Most brokers charge around 50%. Chent: Ok then.
Brokaer : 7 {(wtvther you want bo sed the rotm now
Client : Yes

Future continuous tense.

The Fulung Tense deschnbes an achan that wall be ONGOING in e fubune, A vedh an e fufune
conlmsous tense will ablways take the lom
"'l'l'|||"ﬂ-ﬂ-‘|"llﬂl'hiil'lﬂ". For example
* | will be reporting on the news channel tonight
Hix will b coming home at arsund 10,
They will be working hard to win the maich.

Yo wiill b dn-jng wour omEwork

We can understand the Fubemn Continuous Tense with the help of the 1|;'ﬂi'|;';r|.'a1r'|-;; ExXamples

= We are looking for a new room, (Present Continuous Tensa), We will be looking for a new
rom. (Future Continuous Tense)

I am looking for a new room. (Present Continuous Tensa). | will be looking for a new room
(Fuabure Continuous Tense)

She is looking for 8 new room. (Present Continuows Tense), She will be looking for & niw
roacHm. (i ufure Conlinpoug Tense)
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While in the Present Continuous Tense, we describe an action thal s Ceing, N e Fufure
Continupus Tense, we describe an action that will be ongoing in the future, The verb will always
take the form: will / will mot + be + verb {ing)

Mow, read the following sentenceas and sdentify the sentences that are in the Future Continuous
Tense:

1 Tihe rent will be 4,000 Hupeas

2. | will be hiring a broker to search for the room,
3 She will not be taking the flat
4. The landliord will not returning the saecurity.

5 They will be staying in a doulde room fal

ASSESSMENT

Change the following sentences to the Future Continuous Tense,

1.  Shantanu helped me locate a good room
The landiond charged me too mach
| wars negotiating with him Lo boaser the rent,
| also asked the landlond o e would provide me a Cooler,
11 mal, | am I:I-ujliﬂ.g e coober ryse
| am staying here till December,
Mext year, | am moving to Mumbal
| eontacted my broker Wiy
Vijay i searching for & two-room flal for me

10, | remindod him that the flal shoukd have a separabe kitchen




SESSION 11: SAYING NO

Relevant Knowledge

Somatimes. in cur Bves, situations arise whare you have (o politely decline a person's offer. This
can b difficull; espacially when you cane aboul the olfser person

Some people might say “Yes"™ when thay aclually méan “No'. As a result, they fes] bitberness and
anges towards the person I_I'rE::,' have Said “Yes 1o, &ven I:h{ru-:.:;h the person has gdone r'|{|l:h|r'|g
wrong. People who cannot say “No® often become annoyed and upset with themselves and if
anyone conlinues this behavior for a long tme, it affects their self-esteem and adds to siress,
On the other hand, some pedple might say “No” bul, in an impolite, disrespectful and aggressive
mEnner, Thas iy rEull i otheErs |:||.-_:I|I-|.|r'|g them foe l:lq;ﬁ'l"q; angry and ruhe, S0 what's the wiy
out?

How would you say “No™ to the following?
1 A fnend insahes s RO @ puart Y but wou have o nehuse

2. Afrend wants to bommow a book but you have to refuse

3, Afrend wants to go shopping with you bul you have o refuge,

Think about it!

Read aloud the following phrases (polite ways of refusing):
{ am sowry but - | am sormy but | wont ba able (o come.
Thanks for he offer bul - Thanks for the affer but | wont be able (0 come
! walt have lo say no - | really want to come but | wall have o say no.

THi% i% vary kind of pou, Howaver., - Thig is iy kKind aof vou, However, | won'l B2 able 1o
Come

| would love fo..but can'! because of prior engagemant - | would kowve to come but can't
because of prior engagement.

Read aloud the fellowing phrases
. You can'l work against ihe law
= |can't abide by the Law if it s not tair
= | am working at the warehouse,

¢ You are working for the manages

Informaton Techno ogy




Study the following situations in “Saying MNo®, Choose what would be the appropriate way of
saYing no in each situation. Some siluations may have more than one appropriate option. Fill in
the blanks with the appropriate apbion(s).

Sitwation 1

Speaker 1: Can | bormow some money?

Speaker 2

(@) MO, YOu canmdi

(b} | am sory but | won'i be able io lend you.

[c) |am somy but you can't bormow right now.

Shtuation 2

Speaker 1: 1 am gedng bo my aunt's house, Would you like [0 ooy
Speaker 2

{a) |won't be able o come, bul thanks for the offer,

() | am soery but | won't be able 10 oome

(c) | am samy bul | won'l like o come at all

Situation 3

Speaker 1: There i3 a party al my place on Friday. You have to come,
Speakar 2:

(a) Thanks. But | can't come as | have a prior ¢ngagoment

(b} Sounds great! But, mo! | am nol ooming,

(c) |am somy. | will not be able to make i, But thanks for the nvitation.

Situation 4

Speaker 1: It is quite late now. Why don’t you stay al our place tonight?
Speaker 2

(@) This is very kKind of you. Howewer, | can’t sltay

(b} Thanks! But | really have 1o get back home,

(&) Thanks a kot But | can® Stay at wour place lomght




Situation 5

Speaker 1: Would yiou ke 1o o e fowr & drink?
Speaker 2

{a) Thanks! But | will have o say no.

(b) Sounds fun! Bul, nol | can'l join you

(e) Adrink? Mo Mot now

ASSESSMENT

I, Fill im the blanks using the correct preposition given in the brackot:
1. They invited me their party, but | had refuse (to, for)
2. They said they will meel 3 sharp. (in, af)
But | have o meet my grandparents Monday. (at, cn)
=0 | sasd no mow. | anve never refused them. (G, bedone)
They were a Eithe disappointed e, (0N, with)
Buf | haven't met rmy gr;an-:j|'.u_'1rer11.-} a long bme, (for, from)
| haven'i seen them kast July. (sinca, from)
. Fill in the blanks using the correct preposition given in the bracket:
with against for from by on at

Vikrant Kedos t;r::;lrrnwlng iy miE, The next e he % me. | woll Say,
I am so0ry, Vikrant, | can't lend you anyimone,

My fiends wanted o share a drink me. But | refused saying “Thanks
the offer. But | will have to say no.”

My boss makes me get tea him every day. So, yesterday, | finally said °|
arm soiry, Sir. | hane 9ot work to finksh.” Al that moment, | really did nod cane if it would have
any effect = e _ my pody

My grandfathes wanis me o gel up at 4 every moaming and jog for an hour. | had to politely
refuse saying, "Great idea! | will try that some day. Thank you”

Leena asked Rajul to do her homawork again. 1 seems Rajul replisd, *| am nod gong o do
whatever you ask me (o, And now, they are not I{i‘.kls‘:_’._] eath ather

The opposition candidate wanted the people tovale __ tha ruling pany, bul
they ghouted  vim and told him 0 g0 back

Though it was raining hard yesierday, my tutor wanbed me o buy a book the
market. | said, °| am somy, Sir. But the weather is really bad. Can | buy the book tomoarmow?”
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SESSION 12: DESCRIBING ALOST ITEM

Relevant Knowledge

Describing a lost ifem is a simple maber of stating the featuras of the dem that may help in
identifying 0. For example 1o describe a book you have lost, you could descnbe its following
atnbales

= Mame of book

= Authors name

= Size of book

= DrEscription of cower

' Publishers’ name

some words that are used to express the guantity of things that cannot be counted. Study the
fodlowing lable:

For Countable Mouns For Uncountable Mouns For Both

bany Much

| A few, faw A litthe, little

A b ol

A couple of A goodigreal deal of [ Aot ofiots of

| Hone of the Plenty of
Some morg examples are.

= Their family has a ot of influence over the local govenmmeni

= | l:h:::i._.'{;hl a lot of children's Books 1o my Son

=  Some people don't agree with the new bl

There was much disagresment ower the new bill.

Mo, read the delmis QivEr below and fill in the bBlanks usng the informaton grven
= A mobike phone
Mokia 0010




Black oolos

Lot while Is.i'i'u:','lu"r;; A lfEn

157 May, 2008, 2:00 p.m. fo 9:30 p.m,
Train from Allahabad to Delhi

Shiv Ganga Expréss

Compartment no. 5 14, Berth 28, Sleaper Class

Policeman : ‘Yes, may | help you?
Complainant :

Policeman : Where?

Complainant : | was traveling from
Policeman : ‘“Which irain was i{?
Complainant :

Policeman : ‘When was the joumney taken’?
Complainant : =
Policeman : ‘What time approximabely?
Complainant :

Policeman : Where was your seal?
Complainant :

Paoliceman

Complainant : Itisa . The colowr is

Paoliceman : Okay

ASSESSMENT

Choose the cormact quantifier from the given choices and fill in the blank:
| lost books when | stayed at the hosiel (several, much)

Hema asked students f thay had soen had new leather wallgt (S50me. a
littie)

The warden confimed thaf thefts had occumed in the hosiel, so she had
avary room checked (& few, any)

e ciudenis, ||‘|::I|_1|j|r'|5} Hema, pul up posters ﬂ{!:‘_:ilf'd'll'_'lll'lg I sledns thad Ihq}':.l Fad
o5t (A kot of, much)

Irrfcmiadsgn ]El:hn:ll:r!;!.'




Finally, @l the oSt dems wene Tound In Hema's mom - $he had nense 1o
pretend that her wallet too had been stoben! (much, many)
Flil n the blanks with the cormect guantifier from the options given balow:

| was having fun wath miy family at the airport until | realized that two of my
bags wefe missing.

(a)alots of (b)many  (¢)a kol of

The black bag contaned valuable things that | had bought for my sisiers
wisddin ]

{a) mamy (b} more  {chmuch

It comtained a diamond pendant, gold bangles, a diamond ring, etc
ia) a few (b} encugh  (c) a litle

It alsd had Sibver pewedhery,

ia) rany ib)atew {c)sc

The brown bag had importand documents such as my passpod, pan cand,
driving lcense, ebc

(@) many (b} more {c) much
The bag also contained dothes. silver coins, and a siver key.
(a) enough (b)) afew  (cha bkl

Though the black bag oontaned expensive Ilems, its Dss does nol bother me
as much as the K ol e B b.-jg chiomis

(a} litthe {b) alile  {c) plenty of

It is more important to find the brown bag because it contains important
documents.

(a) mwch (D) vy (G S

| by it hiawe: hope of -;:]E!|_1II"IEF back my bag. S, | am GEHng fo |I;II:|E|1': an FIR
al the police stabon,

iaj litle i) much () few

I 'will atso post an advertisement about my bag in the ‘Lost and Found” section of
NEWSpapens

{a) more (b} likthe {C) some




SESSION 13: APPRECIATING SOMEONE

Relevant Knowledge

for everything a person means o you |5 absolutely necessarny. It lifts your hearl and makes the day
to day stresses that you face more manageable. Take the time today to tell someone °| appreciate
you,” Ta do 50, you need 1o know how (0 appreciabe and that's what you will leam today.

Look al the following siluation: A friend of yours has done a favor for you Mow, how would you
EXprEss your appreciation fof your frerd 7 Think abouf i

We generally show our appreciation whan:

1. Someone has done something for which they are grateful or thankful

2. Someone has done something praise-worthy

Thrafong, S licsn iy b shown ol nnl:,- when someane has done WO 8 tavar bul also
wihen a [PeEar SN nas domne !k}l‘l'l-{ﬂhlﬂg g-."i;'ﬂﬂ or pdmarable

Read the details gren Deiow

“Appreciating Someone 1"
1. When someone has done you a favor:
*  Thanks a lot!
*  Thanks! You are a life-saver
Thanks! | really appreciate if.
Thanks! You really made rmy day
When someone (e.g. a junior at work) has done his job well:
Great job!
Well dona!
Mice: wark]
Good work! Keep it up.
Yiou didl wery well®
Kieap up the good waork

| appreciate wvour effort
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When someons (2.9, a singer'dancer) has performied well;
Thal was a grr_'::_l",n'{ll'l gxcElent'an -;';||_1|1'1't.']|‘||‘_1|r'u;r pformandce!
You perlormed wery well!

| enpoyed your parformance.

When someane shows concarn and support:

| ApEreCIAle Wour COMncEn,

Thank you fiour WOUE COnoem

Thanks for the support. | r:}{lli:,r e it

Thanks for standing by me

Appreciating someone close to you (parents, friends, abc.):

You are a wonderful'an amazing person

Thank you for baing who you ne

Study the siluations described hens, Fill the blanks with how you would express your apprsciation
in the gréen ssuations. You can use the phrases and senfences you leami earlier

Situation 1: You want o by a Book Bul o nol Rawes ¢ .r-g:;l'l Y, Wour foeend lends q o Yo
Shuation 2: Your junsor at work used fo perform badly. Lalely, his performance has improved

Situation 3z 11 is Mother's Day and you have boughi a card for yowr mother, You wani o write a
line shonwing your apprecialion.

Siuation 4: Your younger brother has come lop of his class,

SkHuation 5 You are organizing a campaign for the adoplion of stray dogs. A man donates an
amount (hugelsmall) for the cause

ASSESSMENT

Fili in the blanks using the cormect option given in the bracket:
You did me a favor (greal, large)

| am so that you won! (happy, cheerful).

You are looking tonighd (wonderful, brlliant)

You cdud a ting by I'|E!I;-|r'rg thal poor Doy, (well, gpod)




We thank you for Deing 50 (kind, geribe)

Thal was a performance! I:lﬂl‘lh'lrii-}'. famtashc)
Your generosity i3 appreciated by {many, much)
You are doing your job wiall (wery. vary).

Choose the right word from the bracket to fill in the blanks:

Rama presentied the show really well, | think she is very_  (amogant,
conisdent)

Sheela s ey (patent, lenient) while talking o chenis. She tries 1o
understand them.

| wonder how Milanjana can be so (relaxed, lazy) before any beam
megbng.

Priva 15 axtremely . — [[:Ilgr'u‘lit'e{l_ 5:;|';!|‘|d|-_ and thal makes her e eam
favorite

| like the fact that Ram is {inquiring, nosy), that way he gets his doubls
clearad

Ha| spends s money (wilh @ kol of care, ke a miser), 20 he has no
Mmajor debts.

I was because of Ham's (hard work, ovenwork) that we gol a new
deal.

Raj usas (odd-fashioned, culdaled) ways 1o sohe problems because he
fesls Ehat if abways works

Favi is ahkways {up-lo-date, modem ) wilh his work

SESSION 14: ATTENDING A PHONE CALL

Relovant Knowledge

How do you answer the phone when i nngs? This session is aboart taking phone calls, and
that you will begin the lesson with a role play on the situation. Now read aloud the following
COMMErsalions

Role Play 1
Student 1 @ Hello?

Student 2 @ Hellp!
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Student 1 @ s this (name) speaking?

Student 2 @ This s (name) speaking

Student 1 : | am [sludent’s name). |s this a good time to talk?
Student 2 @ Ok What is it about?

Student 1 : 1 am from Public Surseys. We would ke bo nguirs if you ane a negular user of the
imEre

Student 2 : Yes, | am

Student 1 ¢ That's all. Thank you for your co-opanation. Have a mice day

Role Play 2
Student 1 :
Student 2
Student 1 : s this (your name) speaking?
Student 2 : This is (your nama) spaaking
Student 1 & | am (Sludent’s name). |5 Ihis 8 Good lirme 1o talky
Studéent 2 : Mo. | am afraid | am a lithe busy at (he Mok
Student 1 © Can | call you later?
Student 2 + Ok
Student 1 : Thank you for your time, Have a nice day!
Eead the details bedow:
Making a phone call
Asking for the person you want [0 falk io
= May | speak o (name of the person)?
Is (name of the person) there?

Am | speaking o (name of the person)?




I ntyang yoursedr
| A 1':,!;':!:_'.r P
My name Ig (Your name)
| am {your name) from {company or organization on whose behalf you are calling).
M‘.I" Fal 15 (yOur nane) | @Em l:.alllng from (Company or ofganizaiein on whose behall Yo
are calling)
Agking if the cal-recipiend i frge [ ok
= I3 this a good time to talk?

. Are you free to talk?

Whan the parson you wanf fo lalk to is not in:
| weoubd hloE o lEded & mies e
Ciould you take a message for himher?

| wall call laterd | wall call atter some ime

Wrula hﬂr}g'.'.".'g (1]
= Thank you for your time. Have a nice dayl

= Thank you. Have a nica day!

Receiving a phone call
When the cailer asks for you
. This is (yOuUr name ) speaking
. Yo are r}[_‘rE::_‘ih.lr‘lg 10 (WOUr RAme)
When the caller asks for someones who is not in‘cannot come fo the rone;
= | am afrasd hefshe is nod in af the moment Or Helshe cannod come (o the phone right mow,
¢ Would you like 1o leave message? Or Can | take a méssaga?
Cipuld il call aler some b7 Or Could you call 1a
When the caler asks you i you are fres fo falk:
- Surel What (g this aboul?

= | am sodry. | am a litthe busy at the momsent

While hanging up:

= Thanks for calling.
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Study the detads below and T in the Manks

1. "Attending to Phone Calls 1"

Recelver : Helio?

Caller : Hedio (recaiver's name)?
Recalver : This is (receier's name) speaking.

Caller ¢ (nRCEEET'S NAME) (caller's narmia)
Recelver @ Ok

Caller _

Recelver | Sure, we can talk.

Caller : Are you availing any Efe insurance policy?

Receiver |

Caller : Ok Would you like to buy anothar policy?

Ricebver @ No. thanks

Caller : Ok, Sirfdia‘am

2. “Attending to Phone Calls 2"

Recaiver : Hello?

Caller » Hella,  (name)y

Recalver : | am somy. Helshe is not in righl now

Callar ¢ Oht

Receiver :

Caller o Mes. _ himvher that Rajesy Kurmar called?
Receiver @ Ok

Caller

Recelver : Mo problem. Anyihing else?

Caller : Mo, that's all.

Read the following examples:
= | eat ice-cream daily - Simple Present Tense
| am eating ice-cream - Prasant Confinuous Tense

| have aaben ice-cream - Frazenf Parfect Tense

Lite Cang Insurance




eating ice-cream righd now. In the third, e ate ice-cream in the recent past.
The Present Perdect Tense is thus used to describe an action which oocumed recently
I &l sad 1o descnbe an action which stared in the past and 6 siill conbnuing. For example

= | have worked hene for 5 years

= She has lived there for 2 years

Verbs In the Present Perfect Tense will take the following form:
= |lfyou + have + perfect form of the verb
IWsheheReena'Akash + has +perfect form of the werb

Wethayihe peopdeithe ssters + have + perfed] form of the varb

Raead this before you attempt the exercise:

Present Perfect Tense is used to describe an action which eccurred recanitly.
= | have read the essay
ahe has taken breaklfast
i also used to describe an action which staried in the past and is still continuing. For example;
= | have worked here for 5 years
She has lived thene for 2 years,
‘Verbs in the Present Parfect Tense will ake the following form:
l'yau + have + parfect form of the verb
Ishiehe/Resnalikash + has +parfect form of the varb

Wetheythe peoplefihe sisters + have + perfect form of the verb.

Idantify the sentences in the Presant Parfect Tense.
1 She hag donde her b well

2. | hava a file hang,

3.  They have been upset,
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4 You have won the compeliton

5. The man has a ol o say

ASSESSMENT

.  Change the verbs in brackeis to Present Perfect Tense and fill in the blanks:

Two examples are given below

« | have driven a car.

= Shit has driven a car
Hella! My name is Akanksha from ABC Consultants. May | speak to Ms Kavya, pleaga?
Eawvya {leave) the office. May | take a message?

{phan) & camp at Siri Fom this Safurday. Would she be
Inberested n atbending 1 d

Sure! In fact, | would atso be interestied. We (aftend) swch camps befone.
W found them usaful

That's good. Can you give me your name and contact number &5 well?

M':,r name 15 Mamzha and my contact noember is F8ET754321. Some of Friy othes Trends
{vWwnieer] al such camps before. Would waou hike me b ask them o come
along?

That's greal! You can ask them to call meé on the same number | they nistd mons infommation
i 1his |'|::1_;E|h'}'

Ole. | will tell Kavya you called. Bye!

Bya

SESSION 15: GIVING INSTRUCTIONS

Relevant Knowledge

Sentences that exprass an instruction are formed as an order of a direct command. It is always
in the Simple Presen] Tense

For example:

1 Tedl ws WO Mame - [nsiruciaan




What 15 your name? Nal an insinection

Sit on the last bench - instruction

| am asking you 1o 58 on the last banch - Mot an irstruction,

Wirile down today’s dabte on the board - Instruction

You ang '.\'l'ltzl‘r!] down foday's dafe on the board - Mol an instrection

Sentences expressing simpbe instructions begin with the main verb - tell, sit and write. The subject
of such sentences is “you" but it is generally omitied.

Read the following words:
1. First
Then
e
After that
Thits should be folloved by

6. Finally

These words are commonly used while giving a series of instructions. Lef's, read the following
axample 10 understand the concept

How 1o make an omealette

*First, heat ol on a pan. Beat the eggs in a bowl and add salt. Fry chopped onions and green
chilli as 5000 as the ol is hot enough. Then, pour the beaten egg on the pan. Was Gl the eggs get
|_‘.|rr_'|;':-:'u1':|r COORED on OMne Sade F|r'|.'JlI':.I_ Furm the BOOE OvEr On the ofher side with the help of a Rat
spoon. Cook for 2 minutes,”

Your facililator willl show you the "Letler Format™ Chart. It will have the following on it
Sender's address Date:
Recipient’s name

Recipsent’s address

Salutation {should be "Dear (name of recipient)”}

Body of leter (main part of (he lefber)

Yours santinely,

Mame of sendear
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Ablempl 0 wile down a step-by-siep el of iInstnictions on Row o wiile 8 ledter
Propositions
= We are sitting in the dining room,
= We are inside the house,
FPut the mug inskde the cardboard box
Pouwr some cofles inko the g

We spnnkled water on his head 10 wake ham up

EXERCISE

hoose the appropriabe preposition;
1 Lome (o the shop 5 p.rm, (at, in}
Fimigh the homEswork 15 minubes. (at. n)
Tum this fan . (of, off)
WWalk & straght ke, [in, with)
Gef a kilo of sugar the gracery. (at, from)
Stand that chair and see if you can reach the shell. (on, above)
Take these vegelables the kitchen. (1o, inbo)

8. Do notsmokea this area. (in, around)

ASSESSMENT

Fill im the blanks with the correct options.

1. Do ndt honk unnecessanly traffic sagnals
(aj} at i) from {chunder
Do ot siand the glass door,
(a} like (b} during () near

The manager has given a new set of instructions the staff on office
attendance.

(@) freamn () o fchan




Ag parine schoolmules, students will not be allowed 1o enter the school gales
8:30 am

(a) during (b} after o) to

ouwr stay at Khadiri in Chamba, we were not allcwed to go out in the
avening without an armed guard.

(@) E-l_zl'lng () Bedore () ARer
Tedl tha gate keaper 10 make surg thal cigareties of other lobaced products ane nol Sold
iive school buildimng,

(a) near ) on {c) through

Gel me a cup of coffee and a sandwich the shop across the sireef.
(a) fior ) of {¢) fraim

You canndl park your car ampwherns this binkdhing lor Secunty neasons
(&) from () around  [(c) ke

Fark youwr car the parking lof behind that mall.

ia}in {b) on {c) four

The shop s not far, & is just

(a) across () on (&) at

SESSION 16: REGISTERING A COMPLAINT

Relevant Knowledge

What would be your responss bo the following situation?

“Your nesghbors have Deen partyng for the kst thres ﬂb_:_;hIE: They play loud music and you cant
sheep. You had requesied them to keep the volume low but they haven't done anything about it
So you weni to the police and complained. A friend of yours does not know why you went to the
police station. How would you bell her?

Study the detalls given hara,
“Registering a Complaint - 1"

1. To register a complaint: To make a complaint before an authority.
E.g. We registered a compiainl fo the Principal reganding the bad canteen food
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To hadge a complant: 1o make a complami belgre an authonty
E.g. She lodged & comgliunt dgumnsd hér Supandsar i the CEQ
To file a complaint To make a complaint before an authority
g5 To make an official compdaint n a cowrt of law
E.g. The actor is prassing charges against the newspapar for printing rumars about her
LObject: To proles Aaansd Hll‘r‘lf!thlng
E.g. We objected fo the senving of alcohol at the camp site
Frofest: Complain
E.g. The studants are planning fo prodest against the feachars.
The Past Perfect Tense is used o describe an action which occurred before ancther action in the
past.
Verbs In the Past Perfect Tense will take the following form:
Ipowtishehetwaetheythe peoplethe sisters + had + past panticiple form of the werb,
Raead the following examplas:
= | did my homewark - Simple Past Tenss
= |'wentout to play - Simpie Past Tense

= |weni out to play as | had done my homework - Past Perfect Tense

EXAMPLES

1. Iwent cat to play as | had done my homework.
They had already et by the time we reached the place

| had had my breakfast before the alam woke you

Identify which sentence belongs to the Past Perfect Tense.
1. | had my dinner

| had had my lunch

He had gone to Paris.

Harve you understood the theony™

| had understood the theory

The dog had gone away somewhang




7. 11 had been abandoned
B, Il had a colkar on its neck

Rearrange the sentences to form a conversation between A& and B. The firs] two have been done
for you
= Because the canbisen Ovner allows Hem b0 smoke
= Theay should smoke somewhens else as it harms non-smokers oo,
- =0 e prablerm s walh him!
Then why at the canlean’?
Tod many paophe at cur college smoke in the canteen,
Alrighit
Actually, thity donl smoke anpwhens else because of the signs
That's {rua

Ll us wiile a8 lebler 3 ating our Tormal complaint and drop 1 0 the “Compladn

Exactly! Why should they make us unheaithy too?

Ta thix Principal?

Buf honw do we make them slop smoking at the canteen?

| Ehink we should lodge a complai against ham

Hmmm...ithose Mo Smoking signboards at the gate are not helping much
Yes. What do we do?

Too many people ai gur ¢ {HIE&-;]E srmoke i the canjean

That's trus.
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ASSESSMENT

Change the werbs in brackats lo Past Perfect Tense and fill in the blanks. An example iS5 given
Below 10 help wou undersiand this lense

Simple Past Tense: | did my homework
FPast Parfect Tense: | had done my homewark.
1. Rahwl (lose) cell phone on his way to Delhi from Lucknow. He

{branned) in e first class of the Lucknow Shatabdi. He had no idea howw

) gM iz cell phone back, He knew he had 1o Koge an FIR sl He knew he would have 1o

Go 10 the polce Stateon But be was not  sune if be would go. He (Feiir) Slovees
ol how taking the help of the police took a lof of time and effgn_, Then he remembered wihal
his friend {tefl) him. If his phone was used for some bad purposes, ha
would have o take responsibility for it, So, Rahul decided it was betber o g0 and deal with

the palice than and up in some problem laber on

| (drop) a complaint in the complaint-box abouf the lazy walchman as

frsdrTy peBOple [empdin ) {Ig;ﬁlr'li;t Fiirm

Shilpa (file) an FIR as soon as she found out about the thaft,

e [prodest)y arauns e uge of armal ur in T

They (object) o the use of animal fur in fashion.




SESSION 17: CALLING UP TO FIND ABOUT A JOB VACANCY

Relevant Knowledge

Making calls to inquére about vacancies is a skill you need to acquire, as, somelimeas in real kife
you may meed (o call up and find oul about job vacancies
Read the following phrases and sentencess;
1 | saw your adveriisement in the newspaper
| am calfing with reference to your advertisement in_.
Could you tell me if there s a job vacancy in your onganization?
Could you tell me if there s any vacancy for the post of .7
o you have a vacancy for the post of .7
Modals ane hedping werbs, They help (o express the mosd of the main werb
The varigus modals are can, cowld, may, might, shall, should, will, and wowd. They have vanous
LSS
= Asking for permission: May | come in? Can'Could | use your pen? Can | go?
= Making a request: CaniCould you pass me the book? Will you be my parnes?

Exprassing obligation: You should do the work yoursell. | shall be responsible for your
salely

Expressing determination: | will finish the project, come what may.

Expressing ability: | can soblse the rnddle. We could jump owver the bench when we wera
koids.

Expressing probability: | may be able to halp you out. 11 might rain Womormow

Expressing willingness: | will meet you lomomow,

EXERCISE

Fead the jumbled up comversation n the “Job Vacancy The italicized seniences have jumbled
words. You need bo rearrange the wonds in order to make meaningful senlences.

Hella!
Hello! JobBazaar this Consultancy is?
Yas. What can | dio for you?

Your in Sunday’s | Times of Indla zaw izswe adveriizement
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Ly

5 wanibed o o fnd ouf | 8 vacancy fob ihans

Could you tell me what kind of a job you are kooking for?

| am a hagh-schaod English teachar.

Looking for am | for 8 vacancy job same the posd

Oleay. You would have to consult our agent for jobs in education.
Do that | do how?

You would have 1o come ko our office with your resume. An appointment you ke wowd now
o make ¥

Suvre
Okay. Monday at 11 a.m.

2] Oy, | wall be therg, Thanks a lof!

ASSESSMENT

Fdl o the Blanks with (he cormect words ingm he gnén Labnhe mighl, oug ht, have ta, can, shall,
may, should, could, would, will.

Kavita : Hello, this 15 Cune Pharmaceulbcals, How | hedg '.'1_‘.||..|':'

Gargl : Hi Kavita. This is Gargi here. | speak to anyone from the HR
department?

Havita - Of course I conmect you to the HR manager?
Gargi @ That be gread. Thanks a ot
Kavita ;: Fiease hold on for 8 minute. Milesh; Milesh speaking

Gjl‘gi Hi Milesh, Ths S 'I'_-‘n-iirgl E:nﬁr.'-l.:l:lrl[.} wou kel me d you hide any vacancy
in your company?

Nilesh : We are a large company Gargi, which department you be interested in?
Gjl'gl That : _ b the HR departmeni dsell, as | ave an MBA in HR from Amesy,

Milesh | MBA in HR from Amily? That o b useful. Let me have a look. . You'rg
I luck wou come down herg tomarmens for an mierview?

Gargl : That be a problem I come in day after?
Milesh : Let me see. . ihal be poasible. Can you come by 9 am?

Gargl : Yes that's fina. | ba there by 9. Thanks a ol




SESSION 18: WRITING A RESUME

Relevant Knowledge

What iz a resumea and why spend timea writing one? Resume writing is a crucial part of the job
application process, If Yo rush a i':’t' application and MOUF FEsUrme without I_hlnk'.ng it could
damage your chances of iinding a pob I::Zli_‘.u'lei.r:jEerlr'lf.; the curren] eaconomic chimabte, there 15 hente
compelition In most indusines 50 spending fime 10 make your resurme siand out from the resi is
very worthnwhile.

A resume - somatimes called a 'Curriculum YVitae' or ‘CV - is a summary of your skills, education
and work expanence. A good resume demonsirates how your skills and abilities maich up with
e reguirements of a _||:|tr

Here are a few reasons why writing a good resume Is very important:

- Il prommodes you! A Pesume 15 a :'g:EIf-[!u'l:rl'l‘ruh-:_‘.lrlial document that presents you in the best
possible Bght for the purpose of getting selected for a job interddew.

A good resume will compliment youwr cover latier wiiding and make your overall appication
51rcr:'-_:;|::r

You can achieve your dream job, By spending time perfecting your resume you siand a betier
chance af landing your dream job, especially if you include all relevant work experiance.

Metaorking can be boosted with a good resurme. i your resume stands oot from he rest an
employer is mone bkehy 10 speak 1o peopke i their industny about you

It opens up refermal rl;':-b applicabons. If an E:mnln:,-l::r likiEs YOLIF FlSUMmeE Bl donesn’l heane iy
surabde vacancies they ane ikely 10 recommend you for odher 100 opemngs
Read the following list, and tick the ones you think shouwld be ncluded in a resume or Curmiculem
Witae (CW)
1.  Email address
2 Fanomle ms and aciors
Matonality
Fhosse niamDed
Computer skills
Gender
Addniess
Dt of barth

The newspaper you subscribe o
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harital Sal
Aovards and achisvimenis
Flace of birth
Your height and weighd
Duxtaats of educalion
Skills and inlerests
Languages
The festivals you celebrate
18. Dweladls of previous employments

19, Your redigion

"GV Tarms™. Study the terms given bilow
1. Contact details: Your name, address, phone nuember, and emad addness

2 Uh]l:r-ﬂl‘nrﬂ! A slatermnent of what you inbend (o achieve and contnbute :hr:lr._r-:.;h WOUF SEnice I
the crganization. E.q., To use my skl and work fo the best of my abilty for the development
of the organization

Parsonal information: You may inchude your gender, date of berth, place of birth, nationality,
mantal slatus, and |i]|'|!:_|l.|ﬂl:.:i_|EE'. knowm 10 w0ou under ihes r'h:f.’_-lr|_‘.||r'|!_:_| Lphional vlonmation includes
spouse’s name and number of children.

Arpa of explrtise: 1he work skills thal you have

Employment history: This states yourwork history. Itshould include the diferentarganizations
wheare you ware employed previously, the length of each employment, and the positions you
Frslc]

Educational qualification: Details of the education thal you have received -details of
degrees and training

Skills and Interasts: You can state here other skills and inferests that you have

Other enhancements/Awards and achievements: Any ather achievement or work that you
want to make special mention of

About me/Biography: This i3 an opbional section where you give 3 shor account of
yourself

Connectors and conjunctions

Conneciors are words used (o express relationship between ideas and combine paragraphs and
sentences. For example: but, also, however, moreover, firstly, next, then, therefore, in brief, stll,
for example, thus, of course, cerainly, hence, at the same time, on the contrary, atc




Conjunctions are words used 1o connect phrases and words, For example: bul, 20, &5, and, nor,
yet, so, althowgh, though, because, either..or, nefther...nor, as soon as, and or

MNolo: |:4:l|'|juﬂ-:[rl.'.|r|5. can also be used as conneciors

e

Look at the formal given below and develop your GV
“CY Format™

Namea

Addrgss

Email addrass:

Tedephone numbes;

Qbpectne

Personal Information

Date: of barth:

Place af birth

Mationality

Mantal status

Languiges Known

Employed: Yes/no

Area of expertise; E.g. Direct sales, customer help, and visual merchandizing
E rrpil oyt I'||.=_t||;':-|'1l.' [if any)

E.q. Worked as zalas representative for SailWell for 2 years

=

Educational qualification

E.q. 1. HSC from Amvavall High School (CBSE), Chandigarh, in 2003,
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2. Diphema course n Basic 1:.'-E|r'|‘1l|'.'ll;.|.'-ﬁ'r Educanan from AN I:_‘:.’!'ﬂﬂﬂ'rgﬂ‘."# i 2004
1.
2.

|

Computer Skills

1.

2.

Skills and Interests

E.g. 1. Possess good communication skills
2. Repading books

Awards and achievements

E.g. 1. Won “Sales Representalive of the Year” Award at Sevel
2. Caplain of the college crckel team for 2 peavs

1

2

=

Fil iry thi dietais 1o make your dwn GV, Examplis fidwd Been g 1o showw how some information
maay be hiBed

MNote: There 5 a small difference belween a resume and a curmculum vilae li{:"i":ll ., the |

of the documenl. YWhile a resume is brief and concise summary of your skills, experience and

education - less than a page or two, a curriculum vitae is a longer (at keasi two page) and more
detailed synogsis.

Covering Letter

Impinowve e 1|;'|II-:::!.ru1l'I.{i| CErErInIg lefier by J_E'L'.Il‘rg]n'lg LOme sentencd struclureés. The SEnbenoes il
CAn e ..h:ang&:l {or lmEkad) have bean undanined




T

The HR Manager
Healthy Phammaceuticals
Healthpur

H-l}.'l'llll'-:,r Pradesh

Dear Madam,

I'm writing 1o you regarding sales positions al Healthy Phammaceuticals, 'm also writing 10 you
about marketing positons,

' @ frge I3 | hawe a B Com |1r_|;|_.|;_-|- Lirmg. | wgaild like o work i
{ I have § keen inje

phanm utiﬂj_l.lmg_a nmy. Ir'n ,ggigﬂj n .-.rhr wilh Healihy Pharmaceuticals.

Though | have no expeience in sales and maketing so far | m confident that | will be 8 successiul
ERleERerson, | nawe oood pecpse skt | am discaphined. | am 8 hard worker, Adsa, gl my coliege |
participatied in many activities. | participated n awaraness campaigns for youth

| think ' Suibesd for a p';;l_'l thad requires CERTIFIURICALInG wWith CuSIoOmers

ire any additfonal informabion? Please kel me Enow

Sinceraly,

ASSESSMENT

Fill in the blanks with suitable connactorsiconjunctions
1. |'went to see her she wasn't al home. (and, bat)
It started raining wi went oul. (85 5000 as, because)
We came back she was not ai home. (a3, yet)
She was ndd at home wa Came back. (50, howenner)
. ol e waler add the Suspar (Firsi=then) | Then-last)

Wik rmissed hir sh AEver recerved our MEEEaga {Enher-or, Nesther-nor)

We drove fast we oould nod reach on e of the traffic aims
(Howewver-because, Because-howeyver)

He told you that he gave me the book? , the book is sl with ham. (Thus, On the
oonlrary)

| Carme (o S you you are not well, (bacauss, 50)

| had messaged them, (hey still were nol ready on ime |:.l5|J'|r'|-:,‘.-|,:|!_.‘_|I'| And)
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SESSION 19: WRITING A COVERING LETTER

Relavant Knowledge

A covering letler writben by Mr. A of Arjun Nagar in response to an advertisement placed by
Welcomé Travels, Sarajini Magar is ghven balow. Thire ane fowr armars in the format and you hdwe
ol Eherm

.l'-l.r'; un N'._'15:|{t T

Email: ag@hotmall com

Fh noc 0BB9126881948
Crated: 22 Dec, 2008

Subject: Application for the post of sales executive

Welcome Travels

The HR Manager,

Sarajini H{h;;ill'
Dear Sar

With reference o your advertisemeant in Times Ascent, dated 21 Dec, 2008, | wish to apply for the
post under concern

| ‘hawve jsi graduated o Commernce [walh Honours) from Dedli Unpmiersaty. | am a dedicaled
indridual who pOSSEgsES gl:lﬂl'." communicaton skls and | am eager |l'.'!ljl".|lﬂ YOUr Compaiy.

My CV is enclosed hedewith
Thanking you,

M, A,
Yours faithfully

Read the “Lings for Covering Lethars™ goaen bebow

The linez with which a covering latfer beging when f iz wrilen in response fo 8 vacancy
advartisamant:

1) | am writing in response to your atvertisement............. for the post of............

2} With reference to your advertisament in............ | wish 1o apply for the postof ... ..

The lines writian o show [had you have the abilfy fo hangle the job

1) Pwall B abile to handbe responsibaties well

2} | hawve the skills that are requened (o the concemed job




The lines writhen bafore the last paragraph
1} o attached a copy of vy S
2} My CV i3 encioged herewith

J) My resume i5 enclosed for your review.

The lines writhan in the last paragraph
1}  Thank you for your conskderation

2} | 'would appreciale i if my apphcation 15 considernad for the post

The bnes witfen m the s paragragh. following he ings ghvan above
1} Looking forward 10 your response.............

2} | ook foreard o hearing from you 5000,

Read the datails given balow.
“Siddhosh Sharma's Covering Letter”

Siddhesh Sharma's contact dedails

= B-12 Manak Chand Basti, Arjun Magar, Dedhi -11003.
= Emall: siddhesh sharma@gmall.com

. Phone: 09891223314

Contact detads of recipient
HR M;lnag{:-.l
SellWall Organization, Maurice Road, Dealhi - 110007

Subject: Application for the past of Sales Manager

Body of the betber (you have (o repaTange e seniences)
= would appeeciate it if my application is considensd for the post
= My resume 5 enciosed 106 wouUr revisw
= Thus, | have the skills a5 well a5 experiencs requined for the concermed job,
| also have a MBA in Retail from AIBM, Hyderabad
| am writing in response to your advertisement in The Times of India for the post of Sales
Manager.
| look forerard ko hearing from you soon,
| was hired by GoShop, a reputed supermarke! chain, as Sales Manager for bvo years
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Youl hasve o wrte Saddhesh Sharmas COERnng leter in the coimect formatl. The delads of the lelier
hawve been given. The sentences that make up the body of the letler have also been provided,
Hgweewer, you have to reasranga them so that they ane presented in the comect order. The salutation
and leave-taking have to be nsared by you

Reported speech

Let's understand Reporbed -E-pﬁeﬁ:t::h wth the heip of the f-:}lll;ll.'l.'lng exampies and explanations
He said. °| am thirsty” - Direcl Speach
He said he was thirsty - Reporfed Speech,
She said, “What ane you doing?” - Direct Speech
She asked me what | was dolng - Reported Speach.
They said. "Wea have won the malch™ - Direct Speach.
They said they had won the match - Kepormed .'i‘,l'u,'.'F-th

Feported speech (or inderect speech) 5 used 1o (el whal people say o think, YWhile 1:;|"|i,'l|‘rg]ir'|5| a
sentence from direct speech Lo reporied speech, the vert wil change info ifs pasd form,

For exampla:

= amfis - was

= Are - wWere

= hashawe - had
oo - did
arn chng = wi
hawve done - had done
will - would
can - could
shall - shoulbd
iy - maght

But these remaln the same:
. had - had
= would - would
- could - could
should - shoald
rmugnt - meght

oughd to - oughi o




Other standard changes include.
pEslErday - prendus dayihe day befone
thsis - that
these - those
i - hen
hire - {hers
imornow = the following day
«  next (daytweekietc. | - the following (dayiweel/atc.)

Mote: The folowing remain the samea: that - thal, those - those, then - then, and thare - thene,

ASSESSMENT

Road the following and identify the correct options:

1.  Meena said o me, "l can't go tomomow.”
(a) Meena iokd me that she Couldn't 9o bamOaTow,
ib} Meena told me that she can’i go the following day.

(c] Meaana told ma that sha couldn't 9o the following day
| asked, “Why anen’l you going tomommaw?™

(a) | asked Meena why she wasn'l going lomormo

(b} | asked Meena why she were nol going lomomow,

(c) | asked Meena why she wasn't going the following day.

She gaid, "1 have o g0 o the post offica b mall & Covenng lefher,
{a) Meena said that she had to go fo the post office to mail a covening letter,
(b} Meana said thal st will o 1o the post office to mail a coverng hetber

(e)] Meena sad thal she have 10 go o the post offce 1o mail a COMENY letler

I said, “Can | go with you?"
(a) | asked f | could go wilh b
() | asked if | c3n go with s

(] 1 sad | could go with her
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Megna sad, " That would be grf_rm"

ia} Meeana told me that would be great
(b} Meena told me this would be great.
(c) Meana told me that will be great

The I'I:!-'Elm'-'lng 15 & conversation betyeen a boy and a -:._]lrl You have o turn the direct speeach 1o
reported speech. The first three hawve been done for you

1. Boy: "l have never writlen a covaring lether.”

Reported speech: The

Girl: “Would you like 1o lzam how to write ona?”

Reported spasech: Thi skl Fam if he

Boy: “es, | would Eke to learn to write one.”

Reported speech: The boy replied that be would like fo learn {0 write one,
Boy: "Who can each me how 10 wTibe 8 covenng Eller?

Reporied speech:

Gir: *| have wintben & 1o of thiem S0 | can beach you”

Reported speech;

Boy: “Ase there a lot of meles?”
Reported speech;

Girl: *Yes. Even something like writing a covering letter has a lot of nules.”

Reported speach:

Gir: "Oflen people wrile these letters in amy way they want,”
Reported speach:
B‘-n-y! “Hawve you sent ANy COVERNG ledter recenly’y

Feported speech:;

Girl: °| sent one 1o & company st yesierday.”
teported speech:




SESSION 20: FACING AN INTERVIEW

Relevant Knowledge

Read carafully the “Common Intarview questions™ given balow:

1.

Please introduce yourselfl Could you tell us a little about yourself?

Inderviewes ally start w 5 4] o, You have to infrodece yourself by stating some
hasic pe Hormial ; on & o Leved 1 texibook)

Why have you applied for this job?

Far this question, you may need to do some background research on the company. You may
also add that the skills and experanca you have makes you suitable for the job

For example: T am mieresied i this job as | will gef o work for @ wel-known and successfiu
organizaiion. | also befeve that the skifs and expensnce | have makes me suifable for fhe
Job.®

OR T am inferested in this job because I ke the work profile. | aiso baleve thal the shills and
expanencsd | hive makas meé surtable for the job. "

What are your key areas of expertise?

Far this quesiion, you will siate the skills that you have which are related {o your job For
miple, the key areas of expertise of a sales representiative may be direcl sales, cusfomer
heddp, wisual marchandising, edc.

Why do you think you are suited for this job?

Fiar this quashon, you should talk about your quakibes as weall shills hat would make you
gurtaile for the pob

For example, a sales represeniative should have good communication skills as well as
knowledge of current trends. If the candidale is expenenced (Le. not a fresher), then he must
also talk about how the skills he has acquired from a previous job can contribute fo e new
one.

For example: o hive bean Ll.ﬂrn'.'.lng B sples representadnve for 8 year and [ am Skifed o
direct sales as well as markeling. Therefore, | can easdy adapl mysell o the new job,
Why did you leave your last job?

While answering this question, you should never give any negative comments aboul your
pravious amployers. Instead of saying. °1 was not happy with my last job as it was boring” say
I 'was nod unhapgy with my [ast job. But | am eager to take on more challenges.”
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What are your carser objectives?

While a MSanifing this quéston, talk aboud the pob birst and then aboul what you can do for the
GOy For example, "My canear objectn res bo o my job wedl and to coninbade o the
owerall development of the company.”

What are your salary expectations?

If you are a fresher. then il i belier 1o ask the inlervewer the salary range of the position you
hawve applied for. For example, "As this s my first job, | have no idea of the salary range of
this position. | would be happy with your decision.”

If you have expenence, then you must have already Quaied your cumeni income in your
resume. It is safe 1o quote around 10-15% more than your current salary if you are applying
far the sarme post I YO ang :Jpplg,r.l'r;; fod A hlgl'::_-.r past Yo Can quiade 20-25% mane. While
negatiating, wou must mentan your skills and the advaniage of Your expanence

Far example, *1 am aiready eaming and | have my expenence and skills.
Therafore, | would expect a salary of g

Can you tall me what your strengths and weaknessos ara?

While discussing your sirengths m an intenstw, facus on those skills which are related 10
e pob. For example, *| have the abilty 10 work well in & team and o communicate well with
peopie.”

While discussing your weaknessas, do not mention personal ones, such as, | have a short
bemper of "l am very lazy". Instead, falk aboul those weaknesses which can be easily
osercome, For example, °1 have nof handled swech a g leam before, Buf | am conficent that
| will bearn on the job."

EXERCISE

You need to imagine that you are having a conversation with your faclitaior. Hei'she will say the
answers and you have to frame the questions o them.

1

The fraim eaves &t 1020 a.m

| am reading a Dook

Yes, you can bommow the book

Mo, | don' thank the tram wall be Eate today

| know Decause | abways take that train and it has never been late.
The interview went very well,

Mo, They said they will inform me of the outcome nast weak.




Choose the correct option and fill in the blank:

1. Mishi: | come in, Ma’am? {may. mighi)

Inbervigwer: Coame in. come i, Have gl
Mishi: Thank you, Ma'am.

Inlberviewar: 1 s Mshi T (1=, =0t i)
Mishi: Yes. Maam

imterviewer: are you? (where, how)

Mishi: | am fine, thank you

Interviewer: Ok 50 tell ws, Nishi have you applied to SellWell? (why, how)
Mishi; Seiived s one of the Lang supermarkel chaimns in india. 1t S a s ful Of ganaEalion
that has been popular ever since it started five years ago

Inler iEwar: you have any expenance as a sales earydive? (do, did)

Hishi: Yes, Ma'am. | have worked as sales executive al Shopper's Haven for a year.
inbterviewer: That's good. We take only experenced people hare, departments
wirg you in? (which, whose)

Mishi: | worked at food sechon iof the hrs six months and |_*J|:|I_h||'|g Tor the rdad s monins

Inbarvigwar: salary ang you expacting? (what, how much)

Mishi: My previous salary was 10,000 Rupees per month. So, | am expecting around 13, 000
Rupeas at SellWell

Interviewer: Okay. That is réasonable will you b able bo joen?

(when, whene)

Mishi: | can f114] s Monday

Inberviawar: Great! We ang ong member sharlin cur shoes and bags departmen

you combortable with this post? (have, ane)

Hishi: Yes, kMa'am.

Imterviewer: Good there any question you would like fo ask? (are, is)
Mishi: Mo, Ma'am

Infcmakegn Tachingd ooy




SESSION 21: TAKING A TELEPHONIC INTERVIEW

Relevant Knowledge
Read the statements balow:

"Telephonic Intarviaw”
1. lam a kil busy nght mow. Can we reschedule the indenrew?

= Uzed when the inferaew call 15 unexpecied and you are nol prepared, or when you are
DUsY In SOME WOk

| am sovry. | will nof be abie fo join on Monday as | have some urgeni work. Is i okay If | join
ot Tuesday?

» Used when you are unable 10 join work on the day that the callerintenviowsr Suggests
| was opking forward o your cal

+ Used when the interview is pre-scheduled

I hope you can hear me .,

= Used if the phone line is not clear. Avoid sentences like “Speak lowder!” and *| can’t hear
you”

When am [ ikedy fo hear from _pm.r.'-"

o Lsad winile I'|::lr'|g||:'|.-g:;| up. when the callerinlernewer has nol specihed when hal'she g Qoing

1o call you back
Thess ane some standard lines that can be used during a telephonic intendew.

Mota: The questions discussed in the previous session under the “Comman Interview Questions”
ars aqually relevant (o a telaphonic intaniew

You will again hawve a role play ke n the st session, bul this bme, | will be a telephonic
INTBE e,

Identify the sentences in the Present Perfect Tense.
1. | have had my telephonit inberiee,

She had tried to call you.

Did you gel seected?

She has told me that | can joén on the 22nd




| haven't recaived the call as yel

| have bean asked o bieng all documents on the day | josh
| hawe read the contract and have agreed 1o sign

| hawe had miy dinner.

Have you done the pob?

10. They have not coma el

RELEVANT KNOWLEDGE

Change the ialicized sentences to present perfect tense,
Caller : Hello! This is Hanpla Mehta calling from Selihel
Sarthak : Hello.

Callar : May | speak to Mr. Sarthak Gupia?

Sarthak : T speaking

Caller : | receied the job applcation email thal you sent me
(1}
Sarthak : Okay,
Caller : | just read your resume,
(2}
Sarthak : Ok
Caller : | arm pledsed 10 inform you thal we have a vacancy al ihe mominl
Sarthak : That's great news,
Caller : Sarthak, did you ever take a tedephonic inberdewar?
{3
Sarthak : Mo, | did not
(4]
Caller : Well, we need o take your interview this way. We need to fill in the vacancy urgenihy.
Sarthak @ Okay then

Caller : So. Sarihak. We need someone who can keep an acoount of the stocks. Are you doing
anything similar to tis?

(5]
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Sarthak |

Caller :

Sarthak ;
Caller :

Sarthak :

Caller :
Sarthak :
Caller :
Sarthak :

Caller

Sarthak :
Caller

Yes, Maam. | was alsg in -:_‘.!'t.’_-lrgﬁ ol the daily stock counl apart from sales
(E]_

L'.'Ih..'_-!!,r You will be dosng something related o that. You will be placed in charge af
receiving stocks, stacking shetves and daily stock count

| arm farmiliar with thi work

And Sarthak, did you ever read planograms?

(T

Yes, | read them

(8} S
Good. This is all we reguire from you. When can you join us?
| can join this coming Maonday

LK. What ane wour Sakary E1|‘.|Ee{:|'.:11||.'_|r|5_:'-‘

| earned an annual income of 1,20,000 Rupees at my previous company, | would
therafiore ke a higher pay

: Dk Sarthak. We are offering a monthly salary of 10, 500 Rupees presently. That is what

we wrobe enformead all our website.
(9]

Yes, | am aware of that.

But on account of your expenience and excellent resume, we decided o ofer you
13.500 Rupees. |s that agreeable?

{10}

That sounds agrecabie

: 50 Sarthak, can we expic] you on Monday?

Yes, | wil be there, Thanks for the opportunity,

SESSION 22: ACCEPTING A JOB OFFER

Relevant Knowledge

Wiiting a job acceptance latled when you have ristarved 8 job offed is one of tha bast and most
pleasurabbe 1|"||r'|5:|:§. 3 0o 8% i représents the culminabon of all your efons n .‘:'iF_!'r_"II"I;::rIIr'Il_::f bar & i

job




A job acceplance lefber 15 a letier thal you write (0 a company winch has oflered you a pob. In such
a ketler, the 5I’J||I:|'.'.'II'IQ FICI-IEI.‘IE ame mcluded i the gQneen Sequence;

= Written acceptance of the job offer

= The terms and condiions of employment (salary, benefits, etc ).

= Starting dabe of empdoyrment
Thanks and appreciation tor the opporiundy
Hequest tor notikcation of any |;':h'._'1r'|5:;-|}§'. ar if 1he candsdate s requined (o do .'_'u".-:,-thing badars
glarting employment

Mole: You oon't have 1o wrbe the subsect ine of the eter
Read the details given below. “Accepting a Job Offer”

Written acceptance of a job

= |{ is with great enthusiasm that | accept your offer of the post of Sales Executive at SellWell
Org. Please consider this letter as my formal acceptance of it.

I would ke (o expréss my pleasure al your offer of the post of Sales Exscutive at Sell'well
I.'_']r_q Fles onsider thig letber a8 Iormal acceplancs of i/

| am writing this letter as an acceptance of your offer of the post of Sales Executive at Sell!
Wall Org
Terms and conditions of employment

= | wrrdeErstand it el e fEivindg a starting r;;-_‘llar‘:,'ﬂf Fs 12,000 per manih. | akso understand
it | will get full pay and benehiis |:I|.|I|.|‘rg; the 3 months’ probationary penod

A discyussed. vy Elaring ‘_'|‘q'|||1l|r will b Rs. 12,000 per monih, | algo understand (hat | will
recene full pay and benefits dunng the 3 months” probationary pemgsd,

Starting date of employrmant
g pyreed, my ponirg date will be the 15t of June, 2009

As discussed, | will be starting work from the 1st of June, 2009

Thanks and appreciation for the opportunity
Thank you once agasn for this wonderiul opporiumty. | ook Torwand o JEHRING Your bearm
organization'company and becoming a part of the continued success thal the team/
organization'company represents.
Thank you for the opportundy. |t is an honour to be selected for your leamiorganizaton
COMPAnY,
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Thank you for this wonderful opporiundy. | will put in my Best eforts 10 make a posine
conbnbubesn o WRAr !EEI"I'I-'CIH_:IEI'ILIE[EII'Iu'EGIﬂF-E .,

Reguest for notification if the candidate i3 reqguired to do anything before starting
employmant.
= Dho bet i ko i | need to do anything prioe to joaning the company.
It theere 15 anyihing | need 10 do hetore my f,:1:,’.||‘1.‘1|‘|1__:_| date, please lel me know,
Find out the meaning of the following words and phrases that have been taken from the
“Accepting a Job Offer”.
= Prior to - befora/aflen’dusing
=  Enthusiasm - lariness/eagemesshappiness
¢ Posithve - usefulluselessiunhedphul
Fef - gnefeachmir
Opporiunity - offerforder/chanca

Probatignary - on inal'sampleftraming
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SESSION 1: WORKING WITH ACCESSIBILITY OPTIONS

Relevant Knowledge

Caomputer Accessibility refars to the user frendliness of a computer system for all. regardiass of
{esir disability. Th rJu:l.h.r & salfhwarnd Eesue, However whiEn a combmahon of handwane and
goltwane, if &n A g a disability or imparment 1o use 3 mpuier, 11 15 Known as
ASSIgnme TF-..I'Il'Iﬂ-..I-.'.'l_, I thutg. segsi0n, you will leam aboud the basss accessiility ophons available
O yOoRer Computer.

There are numerous types of impaiment that impact computer usage. These indude:
Cognitheg impairments and leaming desabiblies, such as dysleda, attention defcil-hyparactiity
dizordes (ALDHLDY) or aubism
Visual impairment such as low-vision, complede or partial bindness, and color blindness.
Hearing imparment escluding dealmess

Motor or dexterity impaiment such as paralysis, cerebral palsy, or carpal tunnel syndrome
and repeditive slrain injury,

Accessibllity Options In Control Panel are used

to customize the way your keyboard, display, of et | S| D] M| Geesl|

mouse fumction. Many of these features are useful ks

for people with d'“ﬂhlll"f'“ A% ssed earle Lt Sichlnen | o womst 8 st ST _CTPL LT o

il |n|". B e L ] "o logo bey B prevery e ey F b el

options in |||I'I|:If.‘.|'d'.'=. e I e ity e |

¥ il mp

Lpar T it s f oy segnd aomiewmy bs grers bl o pep ot
S R e ]

Launching accessihility options

*  Tolawnch accessibility options in Windows XP ’ -
Click Start > Control Panel > A:v:nsslhlll'ry P R S|

Options. The Af inility Dphe T s ievs

=Tl [ el T B o e et W Pl Wb i [l
PP CAP LOICY. MGl LOCE et SCRCLL LDLK

Keyboard Tab ™ Uss [t _ Semgn |

Eltkyuﬂrt 7 Ehum g bl By i iy i

Stickyleys s an accessibility feature o help (o ] cmes | [

computer usérs with physical disabilities, but

it i5 also used by off & means 1o eeduce Flgure 1

repetite strain. Shckyieys allows the user o

press and release a modifier key, such as Shifi, Cirl, Alt, or the Windows key, and have it remain
active uniil any other key is pressed,
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= Toenable Shokykeys, select UIse StickyReys.

«  Click Apply

= Click QK.

The Stickykeys icon appears in the system tray (figure 2}

Byea B0 nom

Figuwre 2

After having enabled StickyHeys, you Wl now practice and see its effect.

Start Motepad. To do 50, click Start = All Programs > Accessories > Notepad.

Type some bext (3 - 4 hnes ai keast) and place the cursor at the t:l-ﬂ-;:]ll'lr'lir'lg of the text

Press CTRL kiy on youl kiyboard

Press letter A on your keyboard,
Motice the entire fext gets selected. This aclion is eguivalent b pressing CTRL+A
simuBaneousiyt
To disabbe StickyKeys, uncheck Use Sticky®eys and then cick on Apply = OK,
Filtarheys
FilterHays is a fepture of Microsol Windows, 11 © an accegsibiimy functpn that tells the keyboard
to ignore brief or repeated keystrokes, making typing easier for peophe with hand tremaors.
= To enable Fiterkeys, check Use FiterKoys.
= Click Sgttings under Filterleys and check “lgnore Repeated Keystrokes".

= Click Apply.
= Click O

The Filterkeys i0on appears in (e sysiem bray (hgure 3)

alfull 7um
Figure 3
Afer having enabbsd Filterkeys, you will now practics and see s afect

= Start Notepad and type some repeated characters,

Motice that the repeabted characters ane ignored




To dsable Filterkeys, uncheck Use Fiterkeys and then click on Apaly > O,
ToggleKey

ToggleKeys is also a feature of Microsoft Windows. 1 is an accessibility function which is designed
for peopbe who hawve vision impairmend or cognilive disabdiies. When Toggleleys is turned on,
compuler emits sound cues when the bocking keys (Caps Lock, Num Lock, or Scroll Lock) ang
pressed, A high sound 5 emitted when the keys are seniched on and a low sound s emsfied when
they are swilched off.

. To enable ToggleKeys, Check Use ToggleKoys.
= Click Seftipgs under Togglaieys.

3 Click APF’F' Vg '|--=HI:--IH--!L-—I;I

= Click QK. :'::-:ﬁlpunﬂ'm*nhp'-ﬂ =
g e A v a8 o]
Having enabled ToggleKeys, you car P e sty
by any one of the following keys NUM L, CAPS
LOCK or SCROLL LOCK. Motice that on doing 50
you Fear & Besp.

Ul m el

I hwerlinesh il e prrsd e b degiay ayders
L B

To disable ToggleMeys, uncheck Use ToggleMeys ™ L mtinrele
and thin click on Apply = OK.

Sound Tab

Select the Sound Tab, A window with oplions to
configure accessibility opbions for sound is displayed

[figure 4). Figure 4

Soundsentry

Soundsentry is :j{ri:lgl:'l{ﬂ,‘] o help users with auditory impamments, SoundSentry gf:r‘u:ﬂ';:ll&f,: wisual
wamings, such as a blinking title bar or a flashing border, whenever the computer generates a
SN,

= To enable SoundSentry, Chatk Use SoundSentry under Sound Tab. Doing so activales a
drog down list wherafnom you can choose the fype of visual warming desired

Chick Apply.
Click O,

For understanding El.'u.ml:l'?'_:.-l_!'l'lr!'g.r_ wou nesed 10 create an emmor

= (lick Start> Run. Type note instead of notepad and press Enter.

Imlonmatan Technmogy




Type some repealed characiers in the notepad, Nobce thal the deskiop will flash for a fraction
of second E|||:H'Il; with wisgesl enror sound code

To disabke SoundSentry, uncheck Use SoundSentry and then click on Apply > OK.
show3sounds

ShowSounds instrects applications thal convey information by sound, to also provide infermation
visually, through text caplions of informativg icons.

- To enable ShowSounds, Check Use ShowSounds under Sound Tab
= Click Apply.

Click OK. Ko | Dol Dispiiy | bomnsy || G |
P g
Display Tab i R
gL L Lo |
Select the Display Tab. A window with oplions e

to confgune accessibility oplions for display is i sl - e e P e st il
Ij"ipli-"r'-li_lj el Bled bl vl P el O T Cadoed

Wi Fowew
s AFESPREIEEIEE ] B—

High Contrast |
]
High Contrast is an accessibility feature {0 assis |
paople with wvision impairment. You can change the
ol codor of fonls and the backgrownd fiod

To enable HighConirast, Check Use - =] e
HighContrast Under Display Tab (figure 5) Figure 5
Click 4ppiy.
= Click OK,
Molice the difference on your monilor a5 the High Conlrast opton 5 enabled
To desabie ngh Tiras. uncheck Liss High Cantrast > Apply > K.
Cursor Options
Cursor Oplions is also an accessability feature thal assists people with vision impairment by
cnanging the blink rale and wsdth of the curgor

*  Tochange the speed of the cursor blink, move the Blink Rate slider back and forth. Mobice tha
cursor béinking at vanous speads.
To change the width of the cursor, mowe the Width slider back and forth. Motice the with of
thve cursor changing




Mousa Tab
MousakKays

MouseKEys i5 an Sec ity feature that assists people who have dabiculty LSRG @ Frcuse Thig
opbion uses the keyboand (especially numenc keypad) as a pointing device insbead of @ mogse

=elect the Mouse Tab, 8 window 10 configune accessimity options for mouse will be displayed
{Figure &)
= Toenable MouseKeys, Check Use MouseMeys.
= Lok Apply.
. Click O
LT
Lo Monmellase @y il b cowbicl e posnibest vaith e
rurme boesanad on o heybosd

R WUse Mounek.eys fongs |
Figiera &
Motice the Mousakey kcon in the System Tray (figune 7).

———
ol wild re9m

Flgura T

Use number pad keys for moving mouse pointer instead of using mouse after enabding “Use
Mouseleys™. Use number key 4 to move laft, § 1o move right, 2 to move down and 8 1o move
LI

To disable Mousekeys, uncheck Use MouseKeys and then click on dpply > OK.
General Tab

Thig tab enables you o configure Sibility options 1or all users,

Select the General Tab, a window 1o configure additional accessibility options will be displayed
(figure B)

“Turn off accassibiity fealures affer idle for”, “Give warming message when tuming & fealurs on”
and “Mare & Sound when fuming 8 feature o or o,

Mow check these features one by one and see whal happens.
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sanalkeys

Serialkeys is an accessibility featurs that assists people that have difficulty using a keyboard or a
muse (of both). Thay can use special devices such as Sip, Puff and Breath Switches 1o provide
inpud 10 e compuier 1hrt::-ug;|h =Enal Pors

For exampbe, sipping on the wbe activates one device, while puffing on the same tube activales
anather.

Figisra 9
B ST l;':r_'rr'lzl'ljlllr'lg:; 8 e LSING & Sip and putf swach

Apply all seftings o logon deskiop can be used to apply configured accessibility options to
this user at logon.

Apply a¥ seftngs fo defaulls for néw wsers can be wused 1o apply configured accpssibility
options 1o all users usang & partcular computber




Perform the following activities till you are confident

| 8.No. |Activitios
Use Stickykeys oplion
Use SoundSentry oplion

[WEF] ngh Conlrast atali ety |

| Use SerialKeys option

ASSESSMENT

Fill in the blanks

1.  The option in Microsoft Windows XP used for helping users with physical disabilities and to
reduce repetitive strain is

Sound Sentry is designed to help users with impairments.

The High Conbrast option in Mecrosofl Windows XP is designed 1o assist paople with
IMPAaIRmEnts

is designed to assisi people that have difficulty using a keyboard or

SESSION 2: NETWORKING FUNDAMENTALS

Relevant Knowledge

A computer network is a collection of computers and other hardware components interconnected
by communscation channals (cables or sabellibes) that allow sharing of resources and information
Thas Sesson niroduces I 1o the basic fundamental concepls of r'H}l'ﬁ"I_"ll'li.Ir'Ig and Inbermiel and
usging differant types of intermnet connection

Networks are designed using the following architecture:

Paar-to-pear (P2P) Architecture:

MNetworks in which all computers have an equal status are called peer to peer nebworks, Generally
in such a network each términal has an equally compatent CPLU.
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Glient-Server Architectura:

MNebwarks in which certain compulers have 5 ol dedicated lasks, |;|r|;,||.'r|“||r|- s 1o ofher

comparbers (in ihe network) are calied chenl server nedworks. The compulens) which prowvide
sarvices are called sersers and the ones that use these sendces are calleg chenls.

Types of natworks

There are two majr types of network Local Area Mebtwork (LAN) and Wide Area Metwork
(WAN]

Local Arga Nobwork

A ocal area network (LAN) 15 one wihich connects compubers and dewices ina hmsed g&-:_‘.rgr:ﬁ[m:-:;ﬂl
area such as home, school, computer laboratory, office busiding, or closely positioned group of
buildings.

|J‘5|JE-=|3.' hxcal area nefworks offer very nigh speeds and are used fioar connecting compuiers and
periphserals such as prinfars, scanners, alc

Wide Area Network

A owide area nebwork (WAN) s one which covers a broad area [ie any mebwsrk al inks across
meiropolitan, regional, or natonal boundanes) The Intermnet is e mosd poputar WAN, and 5 used
by businesses, governments, non-profit organizations, individual consumers, arlists, entertainers,
and many others.

Internet

The Infemet is a global system of interconnected compuier networks that use the standard Intermet
profocol suite 1o serve billions of users worldwide. It is a network of networks thal consists of
millians of private, public, academic, busingss, and QoM Fihworks

Intermet is one of the most useful technologies of madern times which help wes in our daily. personal
and prolessional e, Intermed is 'm-:EI!, 4 by shedents. adu onal nskibules:
professionals to gather information for research and general informaton, Businesses use the
Intermet ko access complex databases such as financial database. The Internet is the largest
encyclopaedia for all age groups. The Intermet helps in maintaining contad with freends and

s who e across deffenent IDCatons via Indermne] r_'iull_‘llr‘l-:h mis and emal Sofhwa
Inemet 18 also becomang a major source of enbertanment for the genedal public,

Woaorld Wide Web

Workd Wide Web (abbreviafed as WIWW or W3, commonty known as the Web), i a system of
interlinked hyperact documents actassed via the Inbemet. With a web browser, o Cn wiew wab
pages Ihat may conlam bexl iMdges, videos, ang e mulimedia. and navigale bebwden nem
Vi hyperknks




Inormation 15 stored on oweab seners refemed 0 as web pages ane retmeved by usIng a wah
browser such as Firefoo on the local computer. A Web Browser is a software used o view Web
sites and acls as an interface between the user and the World Wide Web. A Web server is a
compuler that stones web sites and thair related files for viawing on the Intenmaat,

Some of the advantages associated with networking are:

Data Sharing: One of the mosi mpoedant uses of nebworking is to allow the sharing of data
Uisers can send texi files, spread sheets, documents, presentations, audio files, video files,
atc. 1o other users

Hardware Sharing: Hardware components such as panters, scanners, eic. can also be
shared. For example, instead of purchasing 10 printers for each user, one printer can be
purchased and shared among malipse users thus saving oost

Intérnat Access Sharing: You can purchase a single Intemiel connection and shi
among cdher compulers in a nefwork imsiead of purchasing mulliple Intermel connecinpn for
each computer. This i weny commonly found in Internet café (browsing centres), schools,
collegeas, companias, afc.

Usage of natwork based applications: Such as webbrowsers_ email clients, chal apphocation,
audiy & video calling, eic |5 another pdvaniage,

Gatting access to the Internet

To use the Internat, you need an Intemat connection. Intermet connactons are provided by ntemet
Service Providers such as Bharat Sanchar Migam Lirmibed (BSML). Airtel, MTS, Viodafons, Tata

Intérnet Service Provider

An Intennet senice provider (ISP B an ongan zaton wisch pronades you with 3CCess 10 the [nlenmet
vid 8 diak-up {using miodem) or direct (hard wired ) or wireless connechon

Choosing connectivity depends on the availability of a particular technobogy, speed and connection
type in youwr anea. Uswally small and médium business users, home usens use conneclivity hpes
such as sl cable modem, dial-up, broadband wireless, WINAX or 3G, Medium 1o & BUSINess
USErs or customens with more demanding requerements may use high speed connectiily sich as
DEL (High Speed), ISON, stc.

Modam

A modem 5 a device thal comvens digital compuler signals inbo a fonm (anakdg signails) thal can
travel over phone lines, It also re-converts the anakog signals back into digital signats. The word
modem s derved from its function MOdulator/DEModulatos.
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Types of Common Intermat Connectivity

reily dvailable today; it can be widely categorized mio
wired and wireless actess, Following table = a summary o different types of Internel connecinly
IZE.‘IEI;I'!'JTI.E'E‘-H o wared and winelass

 Technology | Type of Connectivity
| Diak-Up
| DSL

| Cabse Intermel Accnss Wined

Werelass
Wireless

Wereless

Some of the commonly usad Internet connectivity are:

Dial-up: Dial-up Interned access is a form of Intemel access that uses the facilties of the pubdic
switched telephong network (PSTH) eslablish a connettion o an Inbémel service provides
[IE-P] Vi@ telephone lmes using a device called KMODEM. Usars deal A pamicular number provided
by the ISP and gain access to the Internet.

Dial-up connections are exiremely siow and in most cases, it s replaced by ahigh speed connection
such as DSL or Cable Modem

DsL: ﬂlglz' | subscriber ling{QSL) provade Intemel aco by transem kg ':hglr_{ll data ovier

of a local telephone network. DEL sendce s dels kg with wi telephone Seni

the same telephone line. On the customer premises, @ DSL filer remowes the high frequency
interference, enabling simultaneous use of the telephone and data transmission. For using a DSL
connecton, you need a DSL madem and a subscriplion

Cable Internet Access: Cable Internel Access s a form of broadband Inbermel access that uses
I cable Ielsvision svlrastiructiung, Cable Inbermel J 15 provded Ihl:-:::ru[.]h i IR cable TV
networks: thiz 15 similar 1o DSL that = provided over exisbng ielephone ines.

3G: 3G, short for 3rd Genaration is a set of standards used for mobile devices and mobibe
P ECoMmUMICALOnN SErices and nebworks ng_]h-‘q peed Downlink Packet Acoess (HSDPA) is 36
mgbile fedephony Communicabons p that a migher data fransier 5 205 and capacity.
If support for 3G is available on your mobile phone, you can subscribe bo the 3G connectivi

your ISP in arder to get high speed Internet connection on your phone.

WiMAX: WiMAX (Waorldwide Interoperability for Microwave Access) is a wireless communicationg
slandard designed to provide mobéde broadband connectivity acress cities and cowntries through




a vanety of devices. WiMAX 5 8 long range sysiem, COVETING Mmany kilormetres and 5 fypically
used where DEL or Cable iMemet Access cannod be used; this could be difficulty in laying oul
cables for home or offices located in remote locations but need access io the Interna.

WI-Fi; Wi-Fi is a popular techinology thal allows an elecironis device such as computers or mobile
phomnes o exchange data wirelessly over a network, includeng high-spesd Inlermel conmnec
Wi-Fi devices such as personal computer, smartphones, video game console, elc. can connect to
a netwark resowrce such as Intémet throwgh a dévice called the Wirelass Access Poind (WAP). Wi
Fi i usid wihene cabdes cannod be run (Such as old busldings, ouldoos
and Inlemel acoiss, Wi-Fi can algo be used whene ugeds requEng mioDds
s i PO & ol

Shopping malls, coffee 5

for their cusiomers.

Data transfer on the Intermeat

Having talked of data transfer and the Intemed, have you ever wondangd how sitting in one comaer
ol the wodd, you _;';I irbarmmaiaon from arnolier ¢ | area m a lew sechnds?

I witry simpde language, el's See whal happens o a plece of data, say a Web page, when it is
iransierred over the Interneat;
= The data is broken up inlo bits of same sized pieces called packets.

= Aheader is added to each packel explaining where the dala has come from, whene it should
end up and where it s in with the rest of the packals.

Each packed is sent from computer (o computer until it finds its destination. Each compuler
on the way decides where next o send the packel Al packets may nod take the same
rouie

At the destination, the packets are examined. If any packels are missing o damaged, a
age is sent asking for them (o be re-sent. This continues until all packets have been
recened intact

The packets are now reassembled into their orginal form. All this done in seconds!
To access the Intemet, you need an aciise intemet connection. You need to gather and undersiand
your regquirement carefully before subscribing to an intermet connection plan. In this exercise, you
willl e beinw b0 Choose an Infermet Connection
Soma of the common questions that help youw in your decision are:

What % the pur & ol |_!:|1':1|:||‘|[.] |Fes mechon?

Will you use the connection regulary?

How much data will be downboaded on an average per month?
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How much speed do you need?
What r_|'_-.i:'J'||'||‘_1I|:r!;_|'!.' 1% availabhe in yilieLaf pearBCukar anen 7
What are the difereni plans available from the ISP?

I5 there any limitation or catch for the selected plan?

Use the following table to compare different subscription plans to get an estimate and

analysa if that would suit your requiremant.

[ G
ISP Flan Name Download Spaed | Droemiload Limid

Plan Name : Download Spead | Download Limit

Euhl_ﬂ In_lur_r_hgni A_.ﬂ:.:&u
| Plan Name ; Download Speed

WiMAX

[ PlanName |Download Sy |-_-1:| Dosmboad Limni ]
pe

Dowmioad Limit .

Free Modem

Frea Modem

Frea Modem

Free Modem

“Fi. o nddd an ACoESS point with an active Intemel connection U.‘_'-il_.l;_'l"'!.' witEn YO
e boan Intemsel connechion, the |SP provides opbons o purchase or rent & Wi-Fi router thal
can act as both an intemet connectivity device and an access point for Wi-Fi connectivity. Setting
up a WikFi network requiras technical expertise; however, you can access the Wi-Fi netwark by
g 10 an accss point that 5 already setup for use. On compubers that fun Windows XP,

5 avadable by using finee Ballownng procedung

Right-Ceck on the Wireless lcon in the system tray and Chck View Available Wiroless

Networks (figure 10)

Figuro 10




Windows XF will display the kst of avadlable Wi-FI networks: you can choose any of the connection
from the list. Select by Double-clicking on the name displayed in the list,
[ maimamm—
L Iwnt & pirikeia, P
e ey i = ] e b = g = —

S o]

J . |

|
1 il

Figure 11

Note: You may be prompled to enter a password if the seleched natwork is securs. Yow will
récene & confirmation al pou & Connecied 1o & wirgless nehwork. NMow the Syslem i réady fo
be used for network relaled applications such as Firefox, Chvome, Skype, elc

Parform the following activity till you are confident:

[SMNo. | Activities _ - _
|4 List any 3 15P's available in your city, Afler collecting information such as connectivity
| type, speed and charges, compare them and state which is the best ISP and why?

ASSESSMENT

I.  Fill in the blanks:

1.  The acromm for LAM is
Three types of Wired Inlermet Connectivity are

Thres types of Wireless intemmet Connactivity ang

Answar the following:

What is the definition of netwaorking ?
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Whal ane the advantages of rh:l'.r.':'rrllilr'lf.]':'
YWhat are the different types of netwarking?

Explain LAMN and WAN,

SESSION 3: INTRODUCTION TO INSTANT MESSAGING

Relevant Knowledge

|nesiant messagqing (I8N} i% a Torm of commemicaton over (e Inbernet that ofers an inslantaneous
trangmizsion of lexi-based messages from sender 1o receiver. Most instant messaging softwanes
include the optien for pardorming file fransfers, awdio chat, video calling and conferencing. sharing
deskiops, efc. apart from standard text chat. Instant messaging software is widely used for personal
and commencial use. N this Sesgion, you will be nrodecsd 1o the concepl of instant massaging. the
sieps (o creabe an inskan MESSagung HC00Unt d alsd work with instant mess NG R L]

ke amad, o Ll g nAppens in neal-time J AMlS can be
spontanecus. Some instant messaging software allows users (o view messages received when
thery are not kogged on. These are called “Offline Messages®

Faf ulihzing audio and wdeo chal of conferending. you nidd 1o i MEChophonas and heddsets
oF Speakers and web Cameras S0 that users can talk o See aal f
Koy Features of an instant messaging are as follows:

Text Messages can be Sent b0 one o more person (Similar [ SMS)

Audio calling and conferancing

Video calling and conferencing.

File fransfers (Mot limited to documents. spread sheets, audio fles, video files, eic.)

5

Message history (Save messages for future referencea),
Instant Messaging Account

Participants messaging o each other need to be signed in to the same instant messaging software.
To usa instant messaging software, a user must have a vakd instant messaging accound

Instant messaging accounts differ in formats; some mstant messaging software such as Yahoo!
Mi}"'""l“'f'l!:_]{"l'_ Windows Live Nes WEC USE email addresses for Frdnageng I Socount and
goftwane such as :':ihﬂ‘.-ﬂ Se slamdand names




Instant Messaging Servicas
There are two kinds of instant messaging softeare — application based and Web based

=  Application based instanl messaging software is downloaded and installed on wser's
computer. Some of the popular instant messaging software are:

] G-;'J-::;lglr_': Tak

Yahoo! Massenger

Skype

Windows Live Messanger
* Radiff Bol, elc

Weh basad snslant mes aging sofbwane 15 3 : 5ing DORNS RIS g a5 Intermed Explorer,
Mozila Firefox, Gopgle Chrome, eic, Some of the popular web based instani! messaging
software are:

+ Meaha

= Yahoo! Messenger for the Web

= MSH Web Messanger

= IMOD, e
Creating an instant messaging account
In this exercise, you will learn bo creale an instan! messaging account for using Googhe Talk
Googhe Talk is an mstant messaging service that provides both ted and voice communication
deseloped I]:,-' I:il}ljﬂhf:' 1 ﬁﬂl:rglir Talk can also be used lof n g vichesn Calls ard b
updales from GhAIL madibox,
Googhe Talk is free and s avaiable as application based (usars nead to downboad and install
Googhe Talk application 1o their deskiops, mobiles or lapbops) and web based (uSers can ese

|:1'|;|.|:|-:.]'I-|_! Talk thrﬂu!.]h a3 browser aiter SUAING nbd Eheir Gmail Socound)

Betore you stan LEing 1.34}1}9“} Talk mail account is equired. You have leamed how (o creale
a Gmail account earlier, In this exercise, you will leam how 1o use Google Talk

Note: You nesd io downioad and install Google Talk application from wiww. googhe. comTalk prior
o this Sxercse

Launching Google Talk
- To launch Google Talk, Click Start > Programs >Google Talk>Google Talk,
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You can a0 gouble-chick on the Googie Talk 1oon on

< Troiple Tl
the deskiop if available

| 1
You need o have a list of contacts that are availabe for ta I( &
chal. If you don’l have any confacts, you can add their Gmail
account 1o your contact kst by sending an imnie

@ Diemo Léam

11y 't have @ Gl acoouni already you can creale a
new Lzmasl acoount.

Signing In into your Google Talk Account

To use Google Talk, you nead 1o Sign in with youwr account

. Figura 12
diatails, ]

After signing in info youwr Googla Talk account, you should see a window similar to the one displayed
Belowr, MNowy e G-:::-ﬂglr:! Talk application 15 ready Tor use

Gnwiaghs Bl

talk>’

& Darmno L

& lmien Sgma )

Figura 13

Perform the following activity till vou are confident

| 1. You have leami to sign-in info Google Talk. Mow try Signing Cut and Signing back in
using Google Talk

ASSESSMENT

L. Fill in the blanks:

1. is a form of commumnication over the Internet that offers an instantaneous
transmission of text-based messages from sender 1o recaheer




& Web Camera are required for audio

and wigeo :-}nfﬁenl:rng.

Answar tha following:
List any five applicabon based instant messaging softwane,

What do you mean Dy instani m&f:rj:;agf:f:"'

SESSION 4: CHATTING WITH A CONTACT - GOOGLE TALK

Relevant Knowledge

Im thiz sesson, you will leam o chal with a contact (hal 3 already added o your contact lisi

*  Whenever your friend in the contact list is online you can see the person along with a green
dot as in the figura 14

et T,

tak>

& Dwrno Lasm

w

L

@ lEn dema)

i ¥

F i|:_'|ur{| 14

You can start sending texi chat message insiantly by double-clicking on a contack. A window
will pop up as digplayed in the figure balow. You can type the text in the texd box and press
Enber e ol person will S he 1exl Message and Mespond 1o your Messhge

Go ahead and get the contacis of a COupse of your classmates and chal with them

Infcrmakegn Tachingd ooy




& B s o bewriss ol g o

T, Somsell o wreall Coll

Do | @ frvm, Thupnc yoi Hipew Bino
PO T

I T ddiiRa 7 | 6T (30
WAl Berrel £ W D0 Post BERC T
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F igurn 15

Thene ange some general rubes and ebgueties o be followed while chatiing, They are alimost the
same 35 those that apply for emails,

Messages should be shart and to the point.
Always introduce youwrself by name if your screen name doesn't reflect it.

Al

Give people time to respond - Multiple guestions sent to a recipient before they've had a
chance (0 answer can séem more like an infterrogation rather than a conversation

Wharevar possible, give the person you are communicating with your undivided attention. It's

nof just @ sign of respect, but if you have mulliphe comersalions happening oF ang allowing

other 1551 0 dISIFact wou, wou may mass an imporiant point in the olier person’s messages
gist of the conversation

It's important to propedy end an IM conversation - you may think the chat is over, bul the
othEr pirson Fridy rod Whale wou'ne olf do ] oiher 1r'||¢'|.-:l;:;_ thiy Fridy (o} Siftneg R ETe staning at
e screen waring for further communscation from woull

Chaiting on Gmail

In this exercise, you will leam to chat with a comndact using the Gmail account through a web
browser




Yol SR 850 e he |}i‘n.':l|1|f||_.'|| SEMVIDES :
will be followed while Tﬂﬂh:ll'lg voice chats, text chals et using the Gmail Accownt

Onece YOu SN ik your Gmail aocount, a contac] window will be diaplanred edhar on the laft side
or the right side within the browser as displayed below

(1o 141t i
De U8 = ey feasen fos pu

[ T T T e mem—p—————— Y
=P & Fam s |

BE i ]

[
il Tuam
ot il Do wim

TURTY Py

If you would like to chal with a confact, double click on the contact’s namse. You will 5ee a pop-up
similar to the oni displayed below

¥ o L 5] L] . = I+ ¥

Fricks Endiy B0 bR oLl FuiSiagh

b ol g :

Fll;iLirl.' 1T i Gl i owl

Figura 18

MNow you can start typing the message you want to send and the ofher contact shoukd be able 1o
respond 1o your chal message

Chatting on Yahoo

Having leamt io use one IM software, you will experiment with another. In this exercise, you will
create an instant messaging account for using Yahoo! Messanger.
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Mole: You may nésd o downioad and mstall Yahoo! Messenger applicabon from Rifps
1T, MESS8Nger yanoo. com/aowmaad’ prnov fo this exercise

Befora you starl using Yahoo! Messenger, a Yahoo Mail accownt is requined. If you don't have
a Yahoo! Mail Actount ﬁlrg}.i]:-;jy wou can use the baall in oplontfor creating a niw Yahoo! Mad
Accoqsn

You should a list of contacts thal are avadable for chat. i you dom'l have any conlacts, Yo Gan
add ther Yahoo Maill accound 1o your comlact list D',.' E:r-.-nn:l:ng an mike.

MNote: If you would ke lo import your conlacts from other sowrces such as Microsolt Owlfook,
Gmaid, Holmad, elc., you can use the impon aplicn

Having used Yahoo! Messenger, now 9o ahead and chat with your classmales using a Yahoo mail
Accoaant I_J'llq:u_Jgh a welh be

You can also try using other chat senices such as M3SN, Rediff, Sify, etc. Refer to respectnng
webhsies for further nstructions (o downlomsd and u ging the softeang

EXERCISE

Parform the following activities till you are confident:

Daowmilcad, install and use Windows Live Messenger, Rediff, Sify messangers. Create
respesclivie acoounts to practics

ASSESSMENT

Answer the following:
1 State any 03 niles and ehquettes io be lollowed while chalting on fhe intenmnet

2. 'What are the basic needs to use inslant messaging (chat) softwares.

SESSION 5: CREATING AND PUBLISHING WEB PAGES - BLOG

Relevant Knowledge

A blog is a discussion shyle site uvsed by non-lechnical (or technical users) users for creating
personal web pages. Blogs are similas bo an onding personal diary and simple 1o use




You can use a blog to convey messages aboul evenis, announcements, news, reviews, eic, Biogs
are usually managed using a web browser and this requires active interned connection. You can
alzo use offiine blog software o create content first and laber publish the contenl when an active
intermet connaction is available.

Thera are hundreds of websites that offer blog service for free. Some of the popular Blogs
inciude
= www WordPress.com
= e blogger.com
ww. blog . com
W ey Com

Wy, bl RSN, L
Creating a Blog Account
I this session, you will leam how to creale a blog acoount in WeedPress.

WaordPress is free web senvice that you can use to create 8 beauliful website or blog. WordPress
has suppart for “themes” for customizing the design of a blog. Themes can maks the blog or tha
wibpage ook attracte

= Heiora you san using a biog. a blog accoun s required. 1o create one. you need a web
browrser and an vbermel connecon.

|:][i-'.‘::ﬂ the Web Browser

On the address bar type hifps:dsignup WordPress com/signup’. You should now gef to a
page with the fields Blog address. Username, Passwaord, Email Address and Language

Hiag Address: You musi provede a unigue address (o your WordFress F.Ir_;lg Thas 5 the
address whath others will uge Lo view WOLr le,l-g.

Usamame’ You should choose & usermame hor ManEging {ihas blog

Password: Securing your WordPress blog accoun! with a strong password ks imporiant. A combination
of uppercase and Kneercase lethers with Some dagsls along with symbols would be a r_‘.1|'|:|r1-l_!:|' encugh
PASSNON d. You nead o enter the s Lot T B TR TT R

Eman Addrass” You masd provade your Email Addrass hane, An activation link sl be 2end to
you from WordPress after you click “‘Creale Biog”

Language. You can choosa your own langusge for blogging from the list given

Click Create Blog.

n -:_‘.I-:]lng o, Sou will eS80t an email fo {ll:llla'{llu:'l.-;; WOUr L'-.h}g; account. Dpen yier ernail and click
on the activation ink. Once you clck Activate Blog, you will be redirected o your WordPress Blog
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Accoun and you should see a web page similar 1o the one displayed Delow,

"E, WD RS O

Your account is now active!

Figuro 19

Mo 1 BlO 15 read 1 i S bd wath the addr of your Diog as -:jls;':-l;_'lp;-:j I
the welh page above. you can E_:|1I'|E.=|" I':I-I:!-l_Jhll': n the Unk of iype he address maneally o the
web browser. Either action takes you 1o the homepage of your blog

Once you have crealed & blog, you need o sulbmil confent thal you wani olivers to view. This
process ids called posting contend

To creale a post, dick Naw Post A Window similar 1o the one displayed bilow appears

ﬁ T [ e

Ml T s

B o i
e

o i

Figura 20

Titha: You must provide a litle for your post; choose a tile that this post will focus on. For
axample, “School Annual Day Function 2012°

Wsing the nch text box, you can type content that you want others (o read.

Once you hdve insshed typing 1 Coarileand. Yo nesd 1o publsh the post far ofhers 1o s
Click Publigh Posiio pubhsh your contant T view Ehia past, you can bype the Bog address in




e address bar of the web browser, you shoukd See your I'Jh.rq :_'1I|:|r15]. wilh thee post (displayed
e

learningdemo

5 —_—E

L8

_:'.‘. i
v ke

b - 5

- -

o A

"ﬂ'!’ 1"3;"!" - nga

M d ek b o= by el Tt g e Aree s

Ui ol e Thoaa e 1 Bl o iown b braimsing mbeoa? Gdege

Figure 21

You can also add pholos, nodeos, eic. 10 the |'_'|||;'r£| LR e oplEons avadable in WordPress. You
can comment on posts publshed by others. Usually, the commen] opbon = avadable owands
the and of the post. Look for options such as Leave a comment. Leave a reply, etc. in the blog 1o
commant. For axampla, in WordPress the command oo is located balow the post and labelled as
Linavig & replyt

Leawvs & Repdy

Fres winar ; orsmaey rees

. e e — . R B .

—————

[ s~ = e T

F iguinn T3

In the Enter your cormment here. .. lexd box, type your comments about the post.
Im the Email (reguived) Held, type your email address

I the Name [reguired) field, type your mame,

I fhe Webste filed, yvou may Type your I:]I:::-_:_; address (Oplional)

Once you have typed the content in the comment area, review carefully and Click Post
Cormnmant.
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Once you click the Fost Comment, you will see the I:::-l:_‘.ng ;ﬂ'l-.’_m!_:j with your commend. (dsplayed
below)
Lradndrmed sope

FimgP porrytoriel i Sl Suiin B

i
M

| ey b Vot 0 oo Plmiien Posiins s 1) oo s ihaeg® bl
Thairsl Timi

Figuro 23

Porform the following activities till you are confident.

| 8.No. | Activities i

|4 | You have leami o create and work with blogs us.:ng"-.ﬂ.-'afdﬁress MNow create and waork
with other blog websites such as blogger, weebly,
| 2. Create blogs for;
= Announcing School Annual Day Function
|+ Blood Donation Camp

ASSESSMENT

Answar the following:
1. Explain the purpose of a blog.
List any 5 websibes that provide blog sensce

Difference betseen web page and website

SESSION 6: USING OFFLINE BLOG EDITORS

Ralevant Knowladge

I you do not have an actihvie inbemet connection, you can create blogs using a blog applicaton and
pubdesh the Bhog whenever iInfernel connecivity is avalabhe

ThEre are sevedal Ined olflne I,:H:g editors avadable that can be downloaded and instaled on (he
local EIZH'TIFIIJ!E[ ousch ag:




Jumana
Whindows Live Wisled
Blogdesk
In this exercise, you will learn 10 use an offline bleg editor Qumana. Qumana is a free

Ijlr.':-g; application thal s simplé and o o usdE, In s exercise, you will learn about wSing
Clumana

Male: You nead o downdoad and instal Qumana, Jumana can be dowmoaded fram WAW. GUIMmaRa
com. Once fnstalfed, you can use the program fo manage biogs.

Launching Qumana

- To launch Qumana, Click Start > Programs > Qumana > Qumana,

Yo can alsd Double an the Qumana oon on e deskiop o avadlable

x

Ao Canfigure

Enten o bilog’s LFL ard ther clich. THet ™,

Caumara wall Ery $o find cut Bhe required oorfiguestion informaton.
i btk quinnars. com

| Pt ! |

Figurg 24

You need an existing blog account to use with Qumana, In this exercige, you will leamn to

use your existing WordPress account with Qumana. Enter your WordPrass blog address and

Click Maxt

= A lagin wandow appears. You need 0 provide details af your WordFness acoounl, However,
if you wish to use it for other blog sendces, you need o enfer appropriate details. Give the
WordPress blog address in the Web address field. Enter the Username and passward of the
WaordPrass account

Click Next = Finish.

A window similar to the one below appears
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Figura 25

If posts are already available in your blog, Gumana will download and display the existing blogs
as wall

To creale a post,

. Click New Post.

*  Awindow similar to the one below will be displayed (figure below)

Tl
Figura 28
Note: Enfer the Itle for the post i fhe T haid and tha pogl conianl in the ared gven balow
the page litle.

Click Publish Post.

Once you click Publish Posi, the post will get automatically updated to your WiordPress blog.




To wiew the publsshed content, open the web browser and ype your biog address

You can inchede phobas oF pIciungs in your B o make it atracinege. To inser 8 pichane,

= (Click on the image icon on the right hand side of the appication.

Figure 27
Once you click the imags icon, the follonwrng window will be displayed

T al

e e =] ——
# g madd
g

LTS L

Figung 28

Click Browse (o locate the image thal you want to publish in the blog.

Once you click “Browse”, the OS5 browss windsw appears, enabling you b Iocate the image
o e lpded. YWhen you have chosen the image chck Upload & Inserd

Click Publish Post.

To view the published conlent along with the piclure, open the web browser and type in your blog
address,

Mow try using other blog applications such as Windows Live Wiiter, Blogdesk, efc. using different
blag accownts.

EXERCISE

Perform the following activity till you are confldent:

|8.No. | Activity

1. Download and wse different offline blog editors

Irfomiadegn '|i_'||:l'|r|ﬂ|:r!;!|'




Answor the following:
1. Explain the purpose of an offline blog editos.

2. List any five offling blog editors,

SESSION 7: ONLINE TRANSACTIONS

Relevant Knowlaedge

the Internet, Customers nesd to have an active intemnet connection for VIEWING QOOOS O S8y
offered by a seller, customers Can pay ornine using a credit, debit card or by infermet banking

Ll :i:r'l-:_‘.||_‘.||:||r'|!!_'| i & forrm of elecinonec COMmMEncE wining Cusiomears can buy or sell £

Online shopping could be useful in situations when:
¢ A customer does not have suffickent time to visit slones
Visiling a store is mane expensive than purchasing a product onlina
i product or service thatl 5 nol available i the local market 5 avadable onling
Some of the popular onling transaction websites ars:
= |RCTC, an online portal for booking feght and train lickels
Flipkart, an online shopping portal for buying consumer products.
EBay, an cnline portal for buying and selling goods

Redbus, an onling portal for booking bus tckats.
To perform an anline ransacton, all you need is a web browsear and an active internet connection
In some cases whene purchasing s imvohved, you will need a valid credit cand, debit cand or onling
banking swupport efemed (o as Nel Banking Subscnplon, Some w ng g allow COD |_[:3'.=,:h
on delivery) wherne the users can pay once they receive the product or sendce

Online Transaction Using Flipkart

I Emig secton, you will kearm 1o penorm an onling trarnsaciion uging FI|{!-.1:.H|"|

Flpkad is an oning Sione whers you can purchase & vanety of 1':||31:Ir{b:‘¢:-::1]1){u:|$_ BOOKS, ACCESSOMNES,
IﬂlgltEﬂ CAMETaS, Mmoise p!'lr'_"rll'-_'i and F-E'rlFlrll'-_'l"E'L‘_: such as r.'f!f'l'lﬂfﬂ (5[]




Filpk.ﬂﬂ offers mulisple payment methods ke credit cand, deist card, net ban klr'lf.j'_ =gt voucher,
and Cash on Delwery,

T weork with Flipkart, you need 10 usa a wab browser and an actie inlamet connection.

Cpen iy Browdsd such ag Frelox Chrome of lerme B aplores

Type wanw flipkan com in the address bar and Press Enter.

Aweb page similar to the one balow will be displayed.

P o Plipiewrt

FEX TR KOS CORMER BEST SELLERS @
DALY

[T R - = =_1:‘E:I r iz
il Wi el - — = .- L

By B EE b
R | R e ] P g iy
P By

R T il s Sl

Drds N B L wwpnm T mre LR

S5l G
L

e i Baaki i aw ETF -
— el [y
[P et |

- - W 5 B S

Figuro 28
To perfiorm ransections using Flipkart, you nised (o sign up for a Flipkart acoouni

Locate and clhok on thae Elgr'l Up knk af the top of the wals pape, 8 window similar to the one

below will be displayed for signing up with Flipkart.

Sy Lanr T S0 Lip

(R

L LY

Figurg 39

Email Address: You musi provide your Email Address. The Email Address is also used for
r}q}l"u:hr'lg ofter mails, promobonal mals 1o yow, The Email Address will be used a
name for your Flipkan Account,

2 [ Irjglr'l
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Click Sign Up Now!

Once you have signed up successfully, a window similar to the one below will be displayed.

Sy T Fllipdoari

TEXTE
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Figura 31

Fn'.:pH.HI'I has a vanety of products organized as calegones. You can adner ok for respecive
produsct in appropriate caleqody or you can use the search featura o locate a particular item. For
axampde, if you waould like to "-ul.- a digital camara, you can Digital Camera in the search bow and
choose a model Trom th i Ul window. You can sadect a model of yiour EhoicE I:ll,' r'Ilr.I-rlr'lq
on the product A Yo 3 o _{'lk}g of products available mn F'.':[!lh{il'l once you have
gdecided o pu rq..ml.’.-ﬂ- B product, l.'l...iJ can use purchase the product by using the opticn Buy this
now. You can select one or more products before you proceed to payment. Products added to
your shopping can will be available for review prios O panaments.
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Fhpkan aliows a vanely of methods Ior onling payment, You can use credd card, debil cand,
Met Banking, Cash on Delivery or e-gift voucher o complete the payment; you need to enler
appropriate details as required in the mentioned fields and Click Pay to initiabe the payment.
Derpanding on the method select, additional windows may be displayed and procedures will vary
1o complabe (he onling ransachon

SOme wendors (we %) a0 offer paryTnan o be made n nstallments hus ﬁ':i:tkl';:] it a
comvenient option for the customers. Refer to the website payment terms for information on
payment procedures and practices.

Online Transaction for Booking Rail Tickets

Ini this section you will leam how b pediorm onling transadtions for booking brain tickets using
IRCTC

Indian Raibaaay Caber ifg and Tounsm Corporation (|IBRCTLC) & an onlme poarial thal can b used for
booking traved Bokets
To work with IRCTC, you need 1o use a web browser and an active intermel conneclion

gt Aty Browser such as Ferelox, Chrome o Infemed Explorer

Type waw irctc.colin in the address bar and Press Enber

Aoweb page samilar o the one below will be desplayed

;;' Indian Failway Catering and Tourisem Corporation Limited
t o~ = da £ rowpras

L A
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iLw s e e & e ahs wtl lay e
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ik ) i e b

Bl= o prorpt el o mlewi BT ihdech ok Melds

Foparmd werwl 21 lwis 1=sen nfsdhe = 2
i el s shiineg

T Suppaar

-

To perorm transactions using IRCTC, you need o sign up for an IRCTC account
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Locate and Click Sgnaap link at the top al the weh page. a window samilar 1o the one Dedow
will e displayed for signing wp with IRCTC,

You will be redirected to a web page for signing up with IRCTC simiar o the one below,
Faoliow the onscreen proceduras for filling up the details to complets the registration

-
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Figure 34
Once you kegon o IRCTC, you can use the websie for booking tickets. By now, you am quile
faumilaar with what each field represents. Go anead and &8l in the details. The ones marked with an
siar (*) are mandatory ek
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Figurg 35

Once you clack “Find Trains®, list of available trains with ticket availabslity will be displayed (Figure
below)

Jaru T
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e il

Figuro 35

You can view the states of available tickels sorted by day (displayed above). once you hawve
fiked a dabe that is convenien! for i, you can proceéed 1o book the Bokets by following the
instnections provided m the websae

Once you book the ticket, an electronic copy of the ticket will be displayed on the screen,
Additionally, the ticket will ba mailed 1o the emad addness specifiad during negistration
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Perform the following activity till you are confident:

| S.Mo. | Activity i
| wath J 'rglEe{r {"wnany E;I_JI"II!;|E!& oom), Yaira {wans, valra oom) and pra Ol |
ransachons

ASSESSMENT

Answer the following:
1. Explain the purpose of Onling ransactions
2 List any fiwe wabsiles that allow onhne fransactons

List any thnge payrnent ools 1o use onhne iransactions

SESSION B: INTERNET SECURITY

Relavant Knowledge

i secunmly 5 a branch of computer E:LH:IJI'".':'I E[::-l'_'.tJr-::;{Iﬂ!r' relabed o the Intemel. oflen
Invoiving browser securily bul also mebwork security. Hs objective i 1o establish rules and
measures (o use EgEliﬂﬂl attacks over the Internet. The Intermeat represents an iIngecure channai
for exchanging information leading to a high risk of intrusion or frawd, sech as phishing. This

[Fransachons

Thl}ugh Internel provedes valuable informaton and enterfamment, | may leave YT COMmpLRer
unsecure due to many ondine threats, You need (0 ensure thal your usernames, passwornds,
credit card or online banking information secure as they are prone io be tracked and used by
unauthonzed users. Some weabsiles can also install Malware on the computer without usar
consent Meraby leavng e computer damaged of InSecung

Online threats such as Phishing, email spoofing, chat spoofing, efc. can increase the chances of
COMmpromised




A 85 using Antninus Soibwane, Antispywang
Software, Firewalls, strong passwords, etc. in addition to spreading awareness of the best
practices.

Best Practices for Security

Use strong passwords, a combination of alphanumenc and specal characters could be used
fiur t::r&ﬂlln!_:j & password that is not 50 easy 1o crack or -_’._]l,JEe::ﬁ.Ed by ofther users. Do nol keep
passwords such as your favorite color, fiends or relatives name, bike number, mobile number
either as single or combined option. These passwords are easy o guess if a user knows
you persanally. Change your password frequantly at least 2 of 3 weeks 0 that your actournt
inlorMmalon fEMains Seouns

U:ﬁlr‘l{f Strong passwords can lower the nsk of a SECLURtY preach; effectivéness of a password
depends on the secunty mechanesm of the software and users invobsement in generating a sirong
FIEE.S-'#I:IFIIS

Maost websites check for password effectiveness when a user attempts to register for the first
time or when they change password. For example, when you ragister with Gmail, you may
notice a password mater displaying the strength of your password similar to the ong displayed
2T

Chirree » passanrd .-.....-. | LMD

e mnime g s o

1 hapse & pewarsd

Chones & pawveard:

Lhposs & pessaard r-:..--.,-- AREATLA,
Figure 37

Fallowing i$ a genoeral guideling for managing strong passwords,
= Keep the I-|'_-.r'|gl:l'| of the password al least 12-14 characters if permathed

Avold keeping passwonds based on repetion, chionany words, lefter or niember saquences,
usemames, relalive or pel names, etc

InClwding numbers, and symbols i passwords if allwed,
Use capital and bower-case letiers

Awaid using the same passwond for multiphe sites or purposas.
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Avong UsEg something that the pubdic of workmaies know you sirongly ke of dshike
il erators i possible
Example of a strong passward: ulivi: 4Hd{}§

You may also usa websies such as www.strongpasswordgenerator.com that can generate

random sirong passwords. To generalz a sirong passwond using wiww. sirongpasswordgeneralor

cpm o e following

= Dipny any WiED BrosET T':.'[;ui! WA $|_I'|:::|I'I1:]:I '.'.'{u".;!!;er'l{!ri'ilm coen in (he address bar and
press Ender,

" Click Generata Sirong passwiong. Motice the passSword Aisplayed Lnoer your ew password.

Backup your data: Always keep copies of personal data in additional media such as compact
dizcs, pen drves, abe. This could ba helpful in situation whan there is a loss of data. Keep the data
away from unaulihonaed usens

Use encryption software: (Usually available wilhin the operating system) to protect your data
from unaulhonzed users. If encryplion software 15 nod available within fhe |".,'1|||'|[.] Sy
a 3rd parly software,

Keeping your username and password private; Never save your usemame of password on
computers that are used in shared environments such as internet café. Browsers may save
your parsonal data on the kocal computer that can be used by anciher user using the same
compubar

Registering with websites: Read the privacy statement or policy whenewer you register wilh
A websibe, 1he stabemend or prodicy will include information about how the wabsile use personal

Do not share personal information: We pS reguene you to Hill oul forms 1:-::.1|‘||_{I||'||r'|-5;| fiehds
such as name, gender, age, email address, school, elc. Be cautious when filling out such
farms: research and verify if it's a frustable website . Your email addressed could be used by
unauthorized users to send you fake or unwanbed emails: think twice or thnce before providing
intormation o any witbsibe and decide of it 5 really necessary,

Secure transactions: If you aré using onling shopping or ransaclions, websites even storg
your credsl card or onling banking personal information such as wyour credif cand numiser, acooyem|
details, etc. This information can be fracked and used by un-authorzed users often known as
hackers 1o misuse this information. Again, ensuwre the website is legitimate and uses secura
practices for perorming and mainlaifing anling ransachons, Sinde mformation such as cradsl
card detmls or pe S5l g WS mimended o
use only secure websites for such ransactions, Verily if the website uses secure ransaction,
usually it is indicated through a digial certificate represented as a golden lock in the web
browsar's address bar




Use antivirus and antispyware software: Computers are prone (o altacks from software known
as Makware that could harm your compuier. Malkware irack browsing behavior or transmit personal
data from your computer; programs such as keyloggers could be installed on your computer
irack and fransmitl ewery key that is pressed on a keyboard (keystrokes) to unauthoniped users,

s and Anlispywanre PrOGranTS &g i il pialechion m 10N your Computer fof
any changes by malware software. Keep your Antivirus and Antispyware software always up 1o
date, this can help in profecting your computer from recent threats.

Do not immediately respond to malls from unknown users: It may be a fake mail trying to
gather paersonal information such as your bank account details, home address, etc. Some mails
could promise you jobs or annouwnce lotlery results which o turn could compromise the user
And in Some . , Wirug or scripls that are dangerous could be attached to the mall; NEVER
open the attachment from an unknown source,

Clear browser cookies frequently: Cookies are programs that are created on your local
computer whén you visil websies TI'||'_1|_|E|n CO0K) AreE meant for 8 based on our
actnily perionmed dunng your earlier visil such as ogon detalls, details of a Shoppeng cart
visiled pages in a websie, eic. they could also e fracked by unauthonzed users and possibhy
gain access 1o your personal information

Keep the |:|;':-|:+r.-_1||r1-;; lem and soffware applicalions up o dabe, H'II:II.IEI!'! operating systems and
EFIFHHEHIIH:II'IE. alg ﬁE!-:gHF_'I:I lasted and distinbited, somatimes the:,'ma',' hgve F.-l'-_'ﬂurll'!.' higdeg thrq:uugh
which a hacker can take advantage; they may frack and gather information or even damage the
whaole compater. In ganeral, most wendors notify the usars whenaver a security hols is identified
and an update & fvaalable (o address thal parkculas iSsue, You can aiso visd respectvie vendor's
websile lo check if there ane any updates available, download and keep wour operaling system
and software applications up to date, free from security holes.

instail firewails: Firewalls could be software or hardware and can assist in keeping a8 computer
and a network secure. Firewalls analyze the network traffic and determing if the iraffic should be
allowed or nol. In most cases, operating systems such as Linux, Windows or Mac inclede firewall
software as a part of opers ] 5:,-'§:t13|‘.|'| s efping the compasier e, In rare Cases, you meay
need to configure your firewall for pdditional security,

Mewver install soffware from unknown sources: As hey maght not be trustworthy; download
only from well-known or reputed websites. Verify the source if it is legitimate by searching the
intemet or réferring o comments from other users before downloading them; understand the
nature and the purpose of ihe sofhwane befone attemplang 1o download and install them

Remowe unwanted or unknown software applications: These might have got installed withoas
your knowdedge when you havea visited some websites. Unwanied softwane could get installed as
thiry might hanve bisen bundbed along with niscessarny software. Some programs such as loolbars
.E]Eet instalked usually thig |_Jg|'| basndled softwane and are p |'1:;|g|".:1r'r'n'|'u31_'.| o send personal data wilhout
YOLT CONSEn!
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Clearing Data Stored In Browsers

Web browsers have buili-in passwond management designed to sione passwords used in forms
on websites. Browsers often prompl 10 save usemames and passwonds when users attempl o
logon b0 websites

This facility is offered to users, so that they can logon to thelr frequently used websites withoul
having io type the usernames or passwords. However it is not advisable to leave the web browser
stone this data particutarty on pulblic or shaned computars.

To clear parsonal daka from a web browser such as Mozilla Firefox, launch the browser,
= Click Tools Menu, click Options.
= Click Securify Tab. The following window will be displayed:
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Figung 38

Motice that under Passwords section, Remember password for sites is cheched. This means
the browser is configured 1o save passwords for websides automatically. You can uncheck
Remamber password for ites oplion, if you préder NOT o Sloné passwonds

Maozilla Firefox can also store data swch as cookies, visied websiies or webpages dala, beowsing
history, etc. To clear this stored data, click General tab = Opiion. The following window will be
displayed
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Flgure 40

Uinder History sechon, click the drop down menu ned o Firefox will;,
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Figura 41

Select Use custom settings for histary from the drop down list. The following window will
be displayed

Figurg 42
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Molice the preferences; Finglox is {:L‘.lr'ﬂl!_:jl.lrlih’_:l 1o nemember hrﬂ-.-r.-_‘.lr'h_’._i and downioading hisbony
search and form history and cookies, if you do not wish siore the above mentioned data, select
Never remember history from the drop down lisi. If you are in @ public environment such as a
cybes cafié, you may select the option Clear all current history. On selecting this oplion, the
o will e desplayed
o= sy =i
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Click Clear Now and then click QK. From now on, Mozilla Firefox will nol remember any
hislory as you have confiqurned § thal way
There are several online threals such as Phishing, email spoofing, chat spoofing, ate.

You can reduce the risks by using bast prachices such as using Antivines Software, Antispywane
Softwane, Firngwalls, g ards. &bc in addibon o .~1|:||'|3'._'1|:||r'|-_::; awarensss of he bast
prachces

Parform the following activities till you are confident:

| 8. Mo. | Activities |

|4 You have learmi to work with Mozilla Firefox. Now perform tasks outlined earfier using
Mozilla Firefox with other browsers such as Intermet Explorer, Google Chrome. Use the
hislp fibes o onlivse help 1o find procedenes

ASSESSMENT

Anawer the following:
1 Explain the purpose of Inlemet Securnty.

2. Explain different kinds of online threats.
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SESSION 1: MODIFYING LAYOUT OF A PARAGRAPH

Relevant Knowledge

You have already learnt the basics of word processing. Now consider a situation when
you write a lengthy article that $§pans several pages, and you naed to maka it easier for tha
risddors 1o read it7? Look at the following exampla:

What is Culture and Gender Sensitization? Culture in simple {erms refers to our values, the
way wi speak, bahave, think, dress, refigious belefs, the music we like, our interactions,
and the food ¥ I. Dnvarsity is & commitrment 1o PECOGRIZInG and apprec g the vanedy of
charactenshcs that make sndivsdie migue in an atmosphere that promoles and celebrales
individual and collective achievement. Many people mistakenly use such phrases as “Indian
culiure,” “white/bdack culture,” or “WestemiEasiam culure,” ko describe a particular cultura
bt these people Tad o a ':I-:l"r:j;lu.h‘:-::lglfz the presence of cultural 1_'1|'-'1'_'-|'5|1:,'_ oF (he presence of
multiple cutiures and culiural differs within a spoely. In reality, many cleffenent coultural
groups exist today in India and most developing and developed countries, Diversity i the
wirkforce means employing people without discrimination on the basis of gender, age and
glhres o racial backaround E:inm:glnh;]l:.:;_'ll:u:lr'l i% thié currén owe '||'_-I|‘|':||1g I in Business
anversity in the workplace 15 a belle ¥l applied concepl noww more than ever
There are diferent kinds of diversilty that one encouniers al the workplace. These include
diversity of gender, age,. psychology, education, language and culture

Is the contont presented above easy 1o read? Mow, look at the formatted sample below:

What is Culture and Gender Sensitization?

Culture in simple i2ms rehers 10 owr valoes, the w i pak e hank. dress, rekigious
mediats the music we lke our inberaciio And thi food sl Deve sily 8 & commatment 1o
reCOQMENg and EFIFITE-EIE‘IIHQ iy 'i'-ﬂl'lE'l'!.l' of charactensiics thal make indniduals LIrICLee: I Bin
atmospheare that promoles and celebrates individual and collective achievemeant

Many people mislakenly use such phrases as “Indian cullure,” “white/black culture,” or
“Wastem/Eastem culture,” to describe a particular culture but these people fail io acknowledge
the presence of cullural diversihy, or the pha oo of rmulisple cultures and culfural diferences
within a society. In realify, many different cullural groups exsi ioday i india and maos]
devedoping and developed countries

Divarsity in the workforce means amploying paope without descrimination an the basis of
.;:;}lﬁljlier_ age and ethnic or raciad background. Since 1_:;|I|:|r_'| AlFation s e cuiment o ]
trend in business, diversity in the workplace is a betber accepled and applied concepl now
more than ever. There are differant kinds of diversity that one encounters al the workplace
Thase include diversity of gender, age, psychology, education, language and cultune,
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L.If_:lﬂg F]{Ir’.i_i-gl':_irlr'lfi you can break continuous text o one of more senlences. This way, it 5 kol
easier for the readers to understand and EnNpoy the conbendl. In this exerncise, o will leam 1o Work
with paragraphs and layouts.

Hawve you tried to make a professional locking resume? One important part of working with 2
resume involves alignment. For the sake of both professional appearance and accessibility, it is
LTy | Bar sirmalar pans of a néseme 1o all e up ;]Ir_mg e Same verlica =0 that all the
bullel points ane algned, and 50 are the headers, and Seclins. You may come across situathons
where some bullet points don't line up, o where there are many empty spaces that complicate
editing and revising. So now whal do you do?

1 Cpen & new Socuement in word po Gtk on the Plgﬁ La o tak on e Ribdon

2. Click on the = con under Paragraph group, as shown below

O

-

9

Figure 1

The Paragraph dialog box appears, You can sea the opbons for automatic agnment, Spacn
efc. that you can sgup while composing the documeant fzell metead of doing [he alsgpnimeent
loweands the and,

Click on Tabs... button, Tabs dialog box appaars

You can specily the fab siop positicn by Frentioning (4§75 PPIng PO lign in the Tab stop
position b, After specifying the tab stop position click on Set bution and the Tabs window
Bppears

Mote: You can also the 381 the initial tab stop positon valpe from the defaull valkse (0.5%) by
specifying the new value under Defawll tab stops. You may specify the value ail which the
tab stops by ghving the value specified along with e wnit (like Tom, eic.)

Chick 0K, The rules of the dooumen! will be marked wilth a L shaped Eyim ol a8l 2. PibEaning
it thie tak 5-1|:I-F- FIIEIE.ITI!:'FI nas baen set at thak PaOSIton Mow when YOU press e £ab HE"{.‘_ tha
CUrsodr wall EU!DITIEIIIEE".'&' LR from is initial FIJEItIEII'I fo the nexd tab stop FIEI-E.I[H:II'I. And this
sohvees your problam ool
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Mota: You can also sel the @ab stop posdion by clicking al the required point on the ruler
Mow open a new document, type some texl and press Enter. Mokice that the continuous text is

automatcally formaiied as p s, weih the sire that you have specified in the Tabs Dialog
box.

EXERCISE
Perform the following activithes il you are confident
| 5.No. | Activities
1. | Creale the details given below (the tab descriptons are provided as a hint for you)
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2 | Create the one page of Table of Contents of this book using a word processor. Save this
| decument with the name TOC_[your name). You will use i in the next exercise

ASSESSMENT

Fill im the blanks:
i can be used to beeak coninuous ext (o one or more Senbencs
Paragraph group is available undér

| Drafault tabh siop position 1S

SESSION 2: MANAGING HEADERS

Headers are text or images included at the top of the page. They usually coniain important
information such as company or department name, logo, page numbers, name of the author, elc.
separabed from the work o actual document area

Look al the following example

First Mame;

Lot N ame:

L e L

Pepe: | ol ] J 3 L L0
Figuwra 3

Maotice the header in the above document; the title “Application From, June 2012" will be induded
on all pages of this documinl

I Ehis axercise, you will leam to include a header 1o a document

To undersiand and work with headers, open 3 new Socumeant in word processor




Ghek an the Inser? [ah on the Kibbon.,
Click an the option Header in thé Header & Foaler group, &s shown Dilow

Figuere 4

A drop down list appears which lksts predefined hesdar options (Figune babow)
|

L T

]
B Ty

|

Figure 5

MNow try inserting any of the predefined oplions from the list and observe the changes at the
header area of the documeant

i withun the header area by ‘u‘:ll‘f‘llr‘rﬂ i alcsrmmen
QpLon under F'Bg& Nerrmbedr. Yo CAn als0 change the number lormat e page nusmbers by clicking
Format Page Numbers... under Page Number options. The Page Number Format dialog box
appears as shown below

Imlonmatsn lechndogy
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You can insert date and time by clicking the Date & Time option available under insert Growp.

You can choose the date and time format from the available formats.

You can also inser & piciure or chpan within (he hepder, This Opin Ccan be usetul in Smeatong
when you need 1o insert company'’s or an event’s logo. Try inserting a piciure or a clipar into the
header using the Picture and Chip Art option under fngert Group; obsanve the changes madea to
el CdeCnmiant

EXERCISE

Perform the following activity till you are confident:
| S.No. | Activities

1 Open (he file saved in the last exercise (saved as TOC [your name}). Give an
appropriabe name in he center of the header 5 + R R o narme on e e
hand side. Downdoad a logo from the Inlemet or use a phchure (Inser>Piciure) on the
righi hand side. Save the file.

ASSESSMENT

Fill in the blanks:

1. can be used for nseding information at the top of each page
automatcaliy.

2. Header option is available under growp in [nsert Tab.

Answer the following:

1 List any five ffems that can be added o the header anea




SESSION 3: MANAGING FOOTERS

Relevant Knowledge

Footers ane lext or image incledad at the bottomn of the page and may repaat in all pages of tha
document. The procedune for credting a foober 5 similar to thal of headers

Far exarmple, if you wanbed (o créale a ted book, you can indude the name of the taxt book using
I Eaders and the g numbBers i) the footer oplion. Thes makes the document ook el
and organized,

To insert footer bo a doecument, opan a new documant in Word procassor
1 Chik an he Insar! ah on the Hidbon

2. Click on the option Foafer n the Headar & Foober group, as shown belhow

[T Errmr
B “ Pyt & ' PR e R ¥ i
&V enreas ! — ol maiaa [ e e ] i
- e

fmim isw P
-] fores s i A e e

F||;| TiL

3 i drop down st appears which [sis collection of predefined Foober oplions

Mow try inserding date and time, page numbers, pictures and clip arts in the fooler area and
obsarva the changas.

Perform the following activities till you are confident:

| 5.Mo. IA:tI-.-ItIu

1. |Create a one page atice on “Influence of Gandhiji on Youth Today”, Insert a plobure -::I"
| Gandhij and the fitle of the article in the header. Inserl your name, class and date in the
| footer. Save as Gandhiji_[your Nama), print and submit this article to your facilitator for
evalualion, You may try the sarme in Google docs too
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ASSESSMENT

Fill in the blanks

1. can be used for inserbing information at the botiom of each page

automabcally

2. The Fooler option is availabbe under groug in the Inser Tab

SESSION 4: MANAGING STYLES

Relevant Knowledge

Styles or Shde seds are pre-defined or cusiomized options uwsed for crealing good looking
g ionagl documents wilh least efons, You can find a numiser of shies availlable within word
procesaos that can be appled to 8 document, In this exercise, you will learm o apply and manage
styles.

To work with .-_'1'[1l,-1 &5, OREN 8 Ndw wond document in word processor,
1. Toview kst of shyles, locate the Style group under Home tab (Figune below)

AABBCCT | AalbicDdi

Fgndaeg J 1 tigrmusl bz g | Heedirg & Fapdimig

Daeagraph Lpaceg

ok wy Cipfaui®

Figure B

2 If you would like to view the list of style seis available, point to Style Sei under Change
Siyles option. A drop-down with different styles will be displayed (Figure bealow].




o AAH

. Lpemia

o (i B
e

Flgura 3

Select any of the shyles sbed by chicking if. The enfing documient will |:f';3|‘|[.]£: 1o the speicetind Tont
OF Solor H.1.I1|:|\"|"|Etll_'ﬂ||:|r.

EXERCISE

Perform the following activity till you are confldent:

| S.No. |Activities

1 f:l|'.'|i.=_:r1. e a:l'llr,':il'-_' on -|F.IF.|IJF_'FH2E r.-f Gandia ]-I.Clrl .‘:'-jur.h .1:-::1;1-:3].'-' created in the |:||'E'-'.|nu'_-'..
session and try wsing elegant, formal, fancy and manuscripd style sets on different
sections of the dotument and obsene the changes.

ASSESSMENT

Fill im the blanks:

1 ame cusiomized oplons fior creating |:H'I':-1EE.H|I'_'II'|F.|I looking oocuments with the
Fimimium afons

You can change styles by using the group under the Home tab.
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SESSION 5: DOCUMENT TEMPLATE

Relavant Knowladgo

Templates or document lemplates refer to a8 sample fill-in-the-blank document that can help in
saving lirme. Lisually templatés arg cusiomized docurments that may have sample content, thameas,
eic. For example, f you want 1o creabe & nesume wou ¢an u A nesaame emp s and maddiby |;':-|"||!|r
the sections that requine chamnges

Im this exercise, you will learn bo work with document templates.
Ta view sample templates avaiable with youwr word procassor,

1 Go o Ske > New., You will be displayed wilh dtferent tvpes of lemplates (Figure balow)
Far E#EEI"INE_ if wou wioiild ERe o creale o etter, i Can galan! the Leffers CIFI[I:.’.'IFI under

Office.com Tampilates section.

for @ recently held competition. you can sslect the
1th & st of Cemificalte templates

—

it By P mbe g ot i [
e, mag ¢ —

T | #
i El ¢
| E

o St 1 g e
Lol . ] S
-

Figuro 10

Mow select any of the templates by double-clicking on it.

A sample cerificabe window simélar to the one below appears. Mow you can use this template and
customioe the contents by replacing the school name, stuedent name, #lc.




Figure 11
You can also downbodd other types of templates from websites. Some of the websites that offer
free lemplates ang
= pffice.microsoft. comftemplates
= waww thepapermilisiore com
= openoffice bogs comfopenofficattemplates!
= W dOCEI0E. oM

You can visit the above mentioned websiles b search, download and wse a template that suits
VOur mieds

Creating & new document based on & templale can save you time and effort because all the
work it takes to design the docwment has already been done. You may use the templates that
COme with word process oftware, of downloading templates credlad by ofher people, of you
can also create and $ave r own templates for future use. Firgl of all you need o oreate a
document that will serve as the template

Mote: You create the templabe as a nommal docwment, but the magic step is where you save i,
Click on File >Save As, and give the template a name. Select Word Templats from the Save as
typa: drop down Est,

Motice that there is a Termplates folder within Microsoif Word. If you save your template there, then
witll b albde §0 See the template in the My templates category, So Select thal and cick Save.

Mo 1o use the lemplate, click on the File > Mew. Go to My lamplales, and as you scroll down, you
will find the fila {your name}_Invoice |, the templaie you just created. Select that and click QK.

Maotice that this ks 8 new document and it's nol the template. So, we've just created a new documsent
based on one of your own templates. Mow when you save this document, it gels saved as a
nofmal .Jdocx hile
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Perform the following activities till you are confident:

| S.No. |Activities

1 Downdoad and use tiemplates from the Internet

k a4

2 "ou will now creale a 1empi.11e of an invvoice. An involce ks just the kind of documen
that needs o hawve a sei format and one that will be created over and over again,
Sawve the file with the namea — [your name}_|Invoics

Hint on how to create an invoice: You can divide the invoice into 3 main pars: The Header,
Body and Fooler

The invoice header may contain Your letharhead © (Your busingss name, address, lebephong
& email and web addnress i avaslable); the word “Invoice” oF "Bl clearly writlen iowards the 1op
of the page. an invoice number (this a running senial numbes thal you maintain and should be
unigae for e j:an invoice date: Your payment Lerms of now $000 you expect 1o ba
paid e.qg. "CO0°, "Cash®, "30 daya” efc.; your customes or cliant name and address; “Our Refs"
or “Chur Heference (héng you can enfer your quotabion number il you isued a qualation pnor o
the involca) ;| “Your Refd" or “Customer Rel” (if you were given a Furchase order or Work Order
by your customer, hera you should enler the PO or WO number 5o the customer can maich your
irmvaice with heir own paper work)

The wvoice body could have a description of the goods you ané Supplying, quantity, unit af
measure, price per unit and fotal amount for individual fems. In the case of sendces, your brief
scope of work and amouni for indihvidual items. You may specify information in a tabular form
Your are creating a template, 50 you nésd 10 jusl create

when you use the template and make multiphe o a Total
Amount of all indriidudd fems: F'Irl'ﬂﬂ-l‘l“ ingtructions ||:|r'|l',' if NeCES % lells recpients
how 1o make thelr cheque payment, whom o address it o elc. H you expect paymenis by bank
transfer, you should provide your bank accouni number and details here.); Other commenis
{delivery instructions, goods retumn policy, overdue paymen] policy etc)

ASSESSMENT

Fill im the blanks:;
1. Templates or document templates refer fo a document.

Creating a new documentbasedona_____ cansaveyou __ because




SESSION 6: WORKING WITH PAGE AND SECTION BREAKS

Realavant Knowladge
Page and Section breaks can be used to separate a document info sections
If you would like to Start & new page in a documeant. you can use a page break

o separate a secton in a dooument, you can use the sechion break, For example, you can kay oul
part of & single-column page as two columns. You can separate the chaplers ag separale sectiong
in your document so that the page numbering for each chapler begins at 1. You can also create
a different hieader or foobter for a seclion of your document. For examphe, if you are creating a
textbook and you can créeate diflene W0ons lor l:llg'_.||1'.3l Eleracy. wond proc Zing spread sheels
et

To work with breaks, open a new document in the word processor and type some contents. If you
nesd anclhes fresh page, choose the page break oplion in the Page Layoid tab,

a) Click on the Page Layout tab on the Ribbon
B Click on the ophion Broaks in the F'i!gr_‘: Sefup group [Flgurl} Bl )

W aF
L
sap==—a L

¢ Adropdown list wilh oplions for diffenent types of breaks appears. An explanation is green for
each type of O OF geclion break

A paiyE break can be inserhed {ll'l:,r.r.rh S i @ document to force the end ol a pagea il the I::q}-;;u'u 1Y
of a new gne

T cregle a néw page. you can keep pressing enter and the cursor moves trom ling o ine il a
new page starts. But if you add conlent io the previous page, the conleni of the new page will
automatically shift!

To avaid such probdems, theéne iS5 an easier method = use a page break and stan a fresh page!

You may also use a page break when you wanl 1o be sure that a new chapler or sub-heading
automatically starts at the top of its own page.
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Figure 13

paability B0 ﬁ.,ll]!l..,llrll'lg wour docurnent, Ls g ke, YO AR Cf s difTeaenl
I'||:.-||:1H‘-" and foobters, different footnode numbernng, change the layoul of columng, change page
borders for different pages, and even change page layouts in the same document! Using section
breaks is ke having mini-decuments in one large decument

pak comnils e loemal I||-;| af the docurnent confent that precedes i, until it reaches
angther _'.EE"‘II'_'E"I break. For example, if you have a 10 page document, with a section breaks on
page 3 and on page &, the section break on page 3 controds the formatting of pages 1, 2, and 3
while the section bréak on page B controls the formatting for pages 4 to 8

You need to be able lo see whete your section breaks o page breaks are inserted in arder to
s where the formaliing stops and ends or to dedete them. To See a sechonipage break, click
e ShowHide bullon on the Homae Lab m the Faﬂgmph sechion. The :‘.13.'1_‘.1|{rr'|.';'|'._'n_'.]1} rEaks ang
displayed in your document,

1.  Click on the section/page break

2. Press Delete on your keyboard and the sectionipage break ks removed

Anytime you nead bo add a page bordar 10 a single page or have a table in Landscapes onanlation
wallh the rest of the document in Partrait onentabion try using spchon Dieaks i make he sk
easier!




Parform the following activities till you are confident:

| S.No. | Activities

i Create i'*;tge and Section breaks

2 Delete Page and Section breaks

I::'.I[rt{eﬂ a new documend. Divide your page nbo wo codumng, (Fage Layoud > olEmns ]
Pick up an arlicle from a newspaper and key it in. Try using column break and page
break anywhere in the text.

Cipen a new document. Type in the heading of your Local newspaper, Use section break
and divide the nexd section into colwmns and key in an article. Save the documeant file
as Mewspaper_{yvour name} and pring your dacurmiant.

ASSESSMENT

Fill in the blanks

1 & bedaks can bé used 10 separale & documinl inld Sechong
Lising page breaks, you can creale different

A saction break confrols the of the documeni conbent thal o, wrkd it
reachas another sechon break.

To see a sechon/page break, click the butbon

SESSION T: APPLYING CHARACTER FORMATS

Relevant Knowledge

If you are creating a textbook with scientific content, you need to use special formatting for some
characters. Character formatting can be applied fo a singhe charactes or word.

Im this session, you will leam to perform character formatting
Working with Character Formatting

T weork with characier formatting
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a Lpan & new Gocament in wond processor and type the tollosing paragraph

Waler 5 a chemical subshancs wilth e chemical tormila H_ O AWwaber moalecile Conlams one
Qorygen and wo h;.'-nir:rgr-_-n atems conneched h:r' cowalent Dl-:ﬂ-HE- Weater g a I:IIqIJIIZI atl ambent
condibons, Dt if ollen Co-2xesls on Earth wilh i3 solid slate, o, and gaseosus sale (water
vapor of steam), Water also exists in a lsguid crystal siabe near hydrophihc supfaces, The
gdengity of water 15 1,000 kgim®

Mow 10 make changes, you may nead to formal the characters as shown balow. You will nobice
that Some wonds of this paragragh arg in Bobd, Some ane in talics, Someé ang undedingd, Some ang

In crder to apply formatting to the contents in the document you must select the concerned
word of group of words.

Lise the follewing options 1o make changes to a character or word:

Font Faca: Adber :iq}l-rrl;ﬂlﬁﬂ the text you nised 1o click Font Mame in the Fonk group i
particular font shyde from the fonts lsted

Font Size: Aller seleciing the ex you nesd 1o chik Foni Sire in the Font group 1o sekecy the
particular font size from the values given,

WATER is a chemical substance with the chemical formula H,0. A water molecule contains one

voygen and two hydrogen atoms connected by covalent bonds. Waler is a liquid at ambient
conditions, but it often co-exists on Earth with its solid sfate, ice, and gaseous skebs (water
vapor of steam). WATER also exists in a liquid crystal state near hydrophilic surfaces. Tha
density of water is 1,000 kgfm®

Grow Font: After selecting the text you need to click the (& icon in the Font group 1o make the
[t gipm larger than the current font size by the specified poind

Shrink Font: After selecting the text you need to click the (& icon in the Font group to make the
font size smaller than the curment font size by the speciiiid poant

Strikethrough: After selecting the lext yvou need to click the ¥ jcon in the Font group to make a
sirike through the middle of the selecied bext

Subscript: Afler selecling the texd you need to clck the (%5 icon in the Fond group o make the
selected text bower than the normal texd position.

Superscript: After selecting the text you need lo click the '™ jcon in the Font group o make the
salecied text higher than the normal text position
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Clear Formatting: Clear Formatting is used to clear the character formatting (such as Bodd,
ltahes Undeding, font face & size, superscnpl & subscripl aic.) of the seleched text. To rémove (he
characher F{.‘irl‘l‘-:ill-.ulg_ galact the ext and chok on ""'l..-"l i=on in the Fonl o [T

Taxt Highlight Collour: Use this option 1o change the background colour. To do 50, select the
text and click on ®5 icon in the Font group. You can choose the background colour by chicking
an e dosm armony on The Ioon

Font Colour: Lisa this oplion o cha Moy e coloaer Of the (ext, To 30 S0, salecd e lexl and click
on A= icon in the Font group, You can choose the text colour by clicking on the down amow on
e k20N

Change Case: Word processor helps us to change ihe texd case o capital ketiers or small letiers,
You can also capitalize each word in the sentence and capitalize the starting word of the sentenca
uging Change Case under Font Group. To do so, afler selecting the tesd you nised 1o click the s
10w Ehe = oad group

Sentence Case: On selecling this oplion from the dropdown list, the first characier in the first
wird of the seleched sentence will be converled to Capital Letter (Uppencasea)

Lowercase: On selecting this option from the dropdown list, the selected text will be converled io
Small Latiers (lowercagi)

UPPERCASE: On selecting this option from the dropdown list, the salecied text will be converled
to Capital Letters (UPPERCASE).

Capitalize Each Word: On selecting this option from the dropdown list, the first character in all
the words of the selected seniance will be converbed fo Capital Letber (Uppercase).
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IOGGLE cASE: On selecting this option from the dropdown list, the small letters in the
selected text will be converted into capital letters and capital letters will be converted into

small letiers.

EXERCISE

Perform the following activities till you are confident:

5.No, {Mﬂvnlm

Change foni face
Change fon] siee
Changs fonl cobor

| Highlight test

Change lext cass

| Reopen the document created in the previous exercise Mewspaper_{your name}.
Decorate the sl page of your adicke using each ong of the character formals you

e leamit in this

ercise, Take a poniout of page 1 af the document and compang il

with the pnmniow! aken in the previowus 585510n

ASSESSMENT

Fill im the blanks:

Afar th:{:‘llr'l-_:_] th fext you need o click the i the Fong group o ke e fonl saee

larges than the Currind fond Size

To remowve the characher formatiing, sehect the bext and cick on in the Font group:

On sedecting

. the first character in the first word of the selected

sentence will be converied to Capital Letier.

2 sedecdin g

thée fost charachier i all he words of e selected

sentence will be convarted to Capital Letier,




SESSION 8: INSERT GRAPHICAL OBJECTS AND ILLUSTRATIONS

Relevant Knowledge

Ofen when wou winibe & lechnical repor, oF a newsletier of even letber 1o fnends, Iﬁ::h._lﬂi]"ﬂ:.] AT
form of graphics makes the document more inleresting!

In @ technical repo, you may want to incorporate a grapgh of corporate performance o & techmcal
illustration. While in a newsletter or letter to family and frisnds, you enjoy sharing memaorable
events that ane reprasanted by photas or maybe even canoons. The facility to blend these graphics
inka the docurment is part of the charmm and power of every a0 word proces SSiNG program

Bt nod only can we blend graphic images inbo our messags, but Word, Word Pérdect and DpenOifics
also allow us o blend in olbwer special fealures. These feajunes ane I'.'p}l‘n‘r'ﬂll'n. k

These ohiecis can be almost any form that can begenerated as a computer file. Sounds, My
drawings, documents spreadshests, etc. are all examples of possible objects that you can |n-.|u-:|i=
in a document, or link 1o a document

Mote: Embedding an object makes it part of the document while linking an object does not include
file into the document files. Readers trying (o a the Imked objec must also have
853 [0 the separate ke that forms thal obpect. Thal may mean they have (o have access

to 5.uur hard drive in crder 1o see the linked objec

Most Word processors has support for inserting llustrations i the form of Clip Arts, Shapes,
pictures, charis, alc

Clip Art can help in making a document ook colowrful and presentable. Clip arts ane pre-defined
images available for use in documents. For example, if you would ke (o create a greeting card for
your frignd, you can use clip arts such as balloon, flowers, atc. along with text message.

You can use the clip ant gallery busit-in within the word processor;, you can akso download clipart
frgam whsibes, Some of the siles thal have free clip ans ang

= ww.openciipart.org
= www pdclipartorg
Wiy, Clkes com
www. freaclipartnow.com
whw wpchipart. oom
I Ehis BXErcidE, ¥ will learn (o use Chp Arts
a) Toinsertaclip art in a document,

1. Open a naw document in word processor
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Figure 18

The Clip Ar Task Pane appears. Enber the clipart I:::_'!tE.‘!:.]I:II"'!.' e in the seanch box angd Chick
Go. For example, if you want io nsert a bpgo, type logo in the search box and Click "Go”,

Once you click Go (Figure 17), a window appears along with list of clip arts matching the
search keywaond (Figure 18).
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Figura 17
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Select the clpart that you want fo use, double-click on it and it will be inserted into your document
Sometimes, you may need cip arts that may not be available within the word processor application

%, you can vesil websites that offer chip ans such as OpenCiEpart.ong
MNow, you will leam o download a clip art from a websile and use it in your document

b} To download a clp art from www.opanclipart.org,
1.  Open the web browser, Type www.opencliparn.ong in the address bar and press Enter

You can use the search box available on the websie for viewing the st of clip ans to swit your

You will be displayed with list of clip ams maltching the keyword School bag, sirmlar 1o he one
Doy,

Figure 19
Mowe you can select the clip art you like, download it to your computer and insert it using the photo
option in the word processor,
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Porform the following activities till you are confident:

.'_-:'F.Hl:r. J_Atlhl'ttl“

| 1. Insert pichures and |:-|IFI art in a cocument

| Open a new document. Search for “Bithday Ballbons®™ in Chp A, Select one from |
| what is made available and make a one page birthday card for a tamily member _
| Diodamiload & bey g (rodm e il A o n & poster on Earth Day. Inthis exencise,

only insert the appropeiate pichures. You will inserl relevant btext in the next
| exercise.

ASSESSMENT

Fill im the blanks:

| 2.

1. Embedding an object the document while linking an object does
nto the document files.

Headers ryng 10 access e inked object must also have fle that forms Tt
object,

|.-:-|I|:l Af can help in makng a documeant ok and

Clip Al 5 avalable under — Nlustratesns =L T el Inggr Tab
Answer the following:
1. List any two websites that offers free clip arts

2 What ane Clmecis in a Word processang Sodbvwane

SESSION 9: TEXT WRAPPING

Relevant Knowledge

You have leami to insart graphics and Bustrations in the last axercise. How do you want the taxt
ta il 1o the piclure’? Db you wanl & graphics to stand abome with abarve it and below it? Do you
Wil e bl o D '._'1||:r:|:;_;| ofe e of the Qrap ¥ D30 you want 1D have the fext m

that part of the text s on the left side and then continue on the nght side of the graphica? Do you
want the text to run nght across the graphics? All these options are possible depanding on tha
texd wrap oplions you choosa.




Winat of the graphic Image i oo large., of b0 smally This 1S5 a problem you may face when placing
graphic images inio a8 document. in all word processing software, if you select the image (lefi
mouse click on it) controd handles will appear on the sides and on the comers of the graphics,
Wihen you place your mouse on these handlas, thi cuersar changas to a double hisaded arrow and
Wil A chiek and -:_‘.Il'i’.lg {ihee haarsgdle in oF oud 19 deCrease or ncrease the size of the piciure, |nthis
exercise, you will learn to use lext wiapping.

Open a now word document and type the following:

Apache OpenOifice Wiiler i the word processor component of the OpenOfice package. tis
free and is available for a variety of Operating Systems including Windows, Linux, FreeB5D
and Solars. it ig capable ol opening and saving documents n a vanely of formats

You can either inchude a screenshot of the OpenOffice Writer or search for a picture in your

shot, simultanecusly press <Shift> and <Prind Screen> keys, Place (he cursor
o e nf_.;m ol the (ext and sim ullaneously press Sr> ang <> keys

To seanch for a piciure, place he cursor Befong the lext, chok Ingert Tab, and click Picture under
lbustrations, Browse for the picture and click Insert.
1 e S T . A

- -
W . adds®lf . E-dwc Ees BFESNE W,
W s s cmim e .

- EENFEES RS

Once you hive
under Text secton of the Insert Tab after double-clicking on the piciure (Figune below), H you
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e ::-rhlrl-_:_; on Word, sedec the pichere then select the Text Wr.l'pfr'ng dropdown amow in
the Arramge group under the Format tab,

L= "y Sl i gen Fgerep
In L voh Pl

Tuica

A | il DpiofE

Filguere 21

| pache OpenDifics Wiler s M woid proceiis
cormpaneyd ol B Openlifos package M & Foe and B
Femlatie e b vty Jperatrg Sysiems nchelng
Wndoss, Linus, FreeB S0 and Solars: B s capatie of
Bpenarg I AR Setumments i & ety ol larmats

Figuere 32




Parform the following activities till you are confident:

5 Ho. | | Activities
fivap lext argund a picture

Reopen the document you had created in Exencize 1, Gandhiji_[youwr Name}, Se

for an appropriaie picture of Gandhii and try all the Text wrapping oplions. '--n-_-IEr'r
the one you feal suits the best and lake a printout of your modified article. Sawve your
dacurnint with a different name Gandhiji2_{your Mamse],

ASSESSMENT

Fill im the blanks:

1 To search for a picture, place the curgos the texd, click Insert Tab, and click
under llustrations

2. Afer you have inseried the picture, you can wrap the text by using the option
Answer the following:

1. List any three word wrapping oplions available in a word procassing softwarns.

SESSION 10: INSERTING OBJECTS

Relavant Knowlaedge

In additicn o graphic images, to add a personal fouch 1 a special message o 1o illustrate a
soicinl feptung, you may want o embed sound files of maybe v petual fles from ofher sofbaans
applications in your document. For example, you can insen a PDF file or a spread sheet within
the word processor

In this exercise, you will learn about insertng objects in a document

To inser an objec
= Open anew word documan
= Select Insert Tab

¢ Click Object under Teod section. A dialog oo will be displayed, as shown in figure
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Figung 23

Select Create from File Tab

Click Browse and sebect a file such as a spread sheet or a PDF docwment that is available
on your compuler, Chek Qpen and CECk QK

. Matica the dotument is available embedded within youwr word docurment
Nota: If you would Bke to edid the embedded document, double-click on it It will aviomatically
open if for editing wsing respective application,

Moy try ||'|5.43|1:|‘.1;| differant types of docment using the procedune mentionad a

Mote: 1. The embedded obsects cannod be prinbed

2. Theperson opening youwr document musi have the relevant software loaded on their computer
to operate the embedded file.

If you embed an object, the size of your document increases significantly and this may cause
probdems in emailing the document as an attachment

11 you liril ::t;-r}l;fl_ {iE peErson CHENIrIg et document mus] have 8 direct connechon i the
prigingl file location of the object

Perform the following activities till you are confident:

1% i e lext




ASSESSMENT
Fill im the blanks:
1

Embedded objects __ be printed

When you embed objecis m a document, you may have iroubde emakng i because

SESSION 11: INSERT SHAPES, SYMBOLS AND SPECIAL CHARACTERS

Relavant Knowledge

You can insert objects that have different shapes such as lines, basic geometric shapeas, amows,
equalion shapes, lowchan shapes, slars, banners, and callouts using the shape option

I Emis exercise, ywou will learn o work with shapes in a swond documeni

a) To work with shapes, open a new document i word prog

1. Click on the Inserf tab on the Ribbon.

L]

Click an the oplion Shapes m the INustralions group, as shown in figure 2

] Civitv Papl
) Pk Pagm

o Faga B

F:!:il_lrl'.' 2
Once youl Chek the E;h.ilr.q_!E. opbon a dropdosmn s wilh pre -l shape such ag Do, circle,
elc. appears

You can select the shape from the list of shapes available and draw the shape by dragging
i rmouse with the left bubtion chcked. For example, § would e 1o insert a square, select the
box shaped Bem from the list, click and drag the shape (o draw & squarne
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Mo iy 1|‘|.=_‘.-|3I'I|r'|-_:_; oiver shapes from the st avaldable and work with them by |}i'!..’_-ll‘|!_:_||r'|5_'|= COlOrs ofF
adding content inside them.

In some cases, you may need o inser special characters or symbois In documents such as
currency sign of a different country, copyright or trademark symbols, etc. In this exercise, you will
leamn to insert symbols or spedial characers.

b} To work with symbols or special characters, open a new documen) in word processo

1. Chek on the Inserf tab on the Ribbon

Click on the opfion Symbol in the Symbols group, as shown in figure 25

P L dartyrpmars

S E
aid g
| gl THEITE

Figurng 25

A dropdown ksl appears (higune 26).

Q

Figura 28

Selact a symbol from the st and double-click on to insert the symbal into the document

If you would like to view more symbaols and special characters for inserting into a8 document, click
on the More Symbols... option in the Symbols Dvopdown list




Perform the following activities till you are confident:

5.MHo. i Activities

1 Use different shapes, Symbols and special characiers m a document.

>

Create a two page brochure for Nainital or any other tourist spot near your town. The |
brochure must incluede pictures. Wrap the tead around the péctures. It must also include
| @ places 10 36, ho Stay in and details of how lo reach the place.

Oipen a new document. Creata the basic flowchant diagram as shown below

Figur 27

ASSESSMENT

Fill im the blanks:

You can insér Bnes, basic geomelnc shapes, arows, sguation shapes, flowchart shapes,
slars, banners, and callouts using the il

Symibal opldn & avadable undes 2 _ Erdp i the Insen Lak
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SESSION 1: USE AUTOSUM IN CELLS

Relevant Knowledge

You hawve leamt to navigate in a spreadshaet. populate cells, and perform calculations. As you
ki, @ spread sheed offers vanous mathemalcal funcions o peroam the calculations. Sum is
one of the fTunction able In the spresd sheel 1o perform addaion of selecied numbers in the
gheal In this exercise, you will learn how to use autgswm function 1o perform addition in a spread
sheet

Autosum is used for adding the values given in cells auiomatically without writing the formada o
perform the oparation.

Lpen a new spread shaed and enber the folows ng dalta

i S B N
=l . K .

B
=g

wg L P s R

Figure 1

Mow to total the marks of each of the students, do the following:

@0 1o ol G2, Wihile the coell G2 1 wchisd, chek an the AuioSem opbon avadable under
Edifing Grown in the Home tab

AutoSum

Ky "mg ¥

v ERRRE d=s
Figure 2

Tha values in the calls from c2 to 2 will be automatically selected as shown below




Figuerg 3
Press Enfar.
o The tofal marks of Abhas appears in cell G3
o Similarly, calculale tihe total marks of the rest of the siudenis,

il

oiw
=) OE e =

- |

Figyier 4

Mote: Autosum avlomatically selects the values around the cells either horizontally or vertically. In
tht above examphé you want 1o perform addition of nuembsers listed from left to nght, after inding
e total of fwo parsons when you iry 10 perform autasum for anginer person the values on op
of the cument cell gel selected, In that case, you have o sedec] the cell values thal you wani 1o
perform addition.

MNéw change the marks of ong of the students in one of mofe Subjects. The tolal marks of that
ghiichery] wall q calculaied automabcally, Awrlomats calcwanran of formulas & one of the most
FH:F.".'I'-_'I'fu| features of electronic iFlrEaﬂﬂﬂEE'IE.

EXERCISE

Perform the following activities till you are confident:

boukate withowt wiiting the formulae wsing the Autosum function

.l.'_fr{:-{lulﬂ a lisl of all your p gl expeEnses made r_‘Iuru‘:-g; e monih and caloulate e
tod APENSES Using the aulo:

Creabe a list of names of the moanth and holidays in that month, Add and calculale the
1odal number of hodedays in a8 year using the aulosum funchion
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Fill im the blanks:

i of formulas s one of the most powerfud features of
glectionic Spreddshess

i used for adding the vabkees given i cells auvlomabcally without wiiting
e formiula

AutoSum optisn 5 avalabie in group under the Home tab.

Aufosum autemabically selects the wvalues amound the cells edher

SESSION 2: CONDITIONAL FORMATTING

Relevant Knowledge

Conditional formatling allows you to change the farmatting (fond color, border, shading) of the cells
based on the values inot, Yes, you can &0 thal mancadhy, but if can be a resome sk i you have
8 huge amount of data. So, you specify a condition for the values in the cell, and if the condition is
satisfied then automatically the formatting of the cell changes. This feature would be very useful
if you were working on a profit and loss spreadsheet, or a temperalure variance spreadsheet, or
a markshest You could highlight cells that have values ane graater than a dafined rube with one
codor and those less than another with a different color

Basically, you can selact one of mone cells, and create rules (conddions) for when and how those
cells are formatted. The conditions can be, based on the selected cell’s contents, or based on the
contents of another cell

You can control the following formats:

= Mumber formal
Font, font style, and font colour (but not font size)
Fill colowr and fill patiem

Border colowr and bonder shybe (but not border thickness)




Open a new spreadshect and enter the following data.

& § L ] L]
L] P T e b O Pl T AT P T 2

T
¥
T

Lh

R

Figwre 5

Mow to apply conditional formatting for the data do the following.

i k
-

pchciion in Ml Pradection s X1

Figuwrn &

Chek on Condrficnal Fnrm.n-l!r‘ng opbion avalable under EIFH:I': Qrodg in the Hame lab. A
drop down list appears

o
i |
i | e
-
e s
e e

 adgrugy [Bus

Flgumy 7
Click on Highlight Cells Rules option, a submenu appears

Moba: i N s@lect the comdibion hshsd '._u:.l;-:;mjlnﬂ 1o your nesds I thas example i i il
i mighlighd the values (hal are greater than 75, select "reater Than,., avalable under the
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subrmendy. A diakdg box appears

CEN— bk

el el Tl wee GELATTE PHAR
[ ] wih [Lgreboos M et Cark e Tt
| o I Lo |

Figure B

Specify the value in the box and click on the down arrow next o the with field and select a
predefined format for the condition from the drop down list. If you want to highlght the cell
contents with your own formadting style click Custom Format option in the dropdown Est

A Format Calls dialeg box appears. You can select a different font color under Font tab,
Bl -:I_'!.llt'r and color under Bonder ab and M color undes Fill tab

Go ahead and creale the data below and format & in the manner displayed

[ L =] |
P i@ JOE ST 0 Priahrtee® o 2GS B EehaTess @ B

Figura 9

Mote: Similarty you can st vanous conditons for the sebecied value like hess than, egqual bo,
batwesn e1c

Ciptionally, you can also specify the cell address where the value is siored. This can be very
halpful as simply changing the valua in one place can change the conditional formatting all over
i previously selected range. An examphe i shown in the figune Dedow,

Alemri [E R ]

e ]
T iy
Eres

Lim;

" s B i S P P

il SR e ool Rl S e Dot el Tnadt [

= (] B

Flgure 10




The result is displayed below.

i

Month  Units Sold
lanuary

February

Nuagach

April

Plary

Jure

R IE - T I TR

Figure 11

Perform the following activities thl you are confident:

| 5.No. A::m-mﬂn f

1. | Perform condiional formatting on a data subset

2 Create a stodent mark hst of '1- beasi 10 dents and five subpects, Highlight the marks
of the students who got marks greater than 80 with green colpred text with blue fill
Save the warksheat as Marks_{your name)

ASSESSMENT

Fill in the blanks:

conditimnal formatting allows you to change the formatting (font color,

border, shading) of the cells based on the values in it.

Conditional formatting is available under Siyles group in Home talb,

Anzwaer the following:

1. List any five conditicnsformats/ifems that can be used for conditienal formatting.
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SESSION 3: HIDE /| UNHIDE /| FREEZE ROWS AND COLUMNS

Relavant Knowladga

Sometimes yau have data in rows and columns which ane nessded for formulas or charts, but you
do not want the data 1o be visible. A very handy feature of a spreadsheat is the abiity to hide a
remacicolumn ihal 15 nod (o Be shown 1o the end user. The data i hidden rowdcoleman is available fos
calculatons though nof visdble!

FJ'l}-E!E-II"I-H s and columng iS5 another elphul feature In a spreadshest. When YO are -:'Ei:lhl"lg
with & nug& anmspunt of data that Spang saveral rows or columng YOu may want the headers (o
remain consiant 11FIJ-IEFI:' while yiou scnoll 1""'3[}3“ the data s0 that YOou can see thi 1I:|EI'I|ZIf'!|'iI'Il;‘
nameas of the rowsicolumns,

Open a new spreadshest. To hide a row or column, do the following:

= Imorder to hide any row or column you can either select the particular row or column thai is
to hidden or just ané céll in the comasponding row or colurmin (for example B3)

Click an Formaf opbon available under Cells Qroup in lhe Hamé lab

| Fomat

[N

: i | W Apuea leme b b

; s B : E B e Ty D

- 2 0 el pees - }n 7 F 2 L FLT i? H
big-= % # iR Eteplies: §-% 9 o8 OeiSew bems (8 el Oedy Fowd Sl tmal

ey b T 40" i e

l -
sl
IEL R
e ol m Lig o i e b I lae
Figura 12
A dropdown kst appears as shown below
A
i

[FEF T R Y




Llick on Hide & Unhide > Hide Eows. The spread sheel will be displayed as shown below
Mote: Alermatively, you can select the rowieolurmn, rlgh'. click and select Hige

F'.|_i|_1r|:- 14
Mote: |n this example the cell in the 3° row of the spread sheel was selected and then Hide Rows
option was selecled. So, the 3™ row s hidden. What would have happenad if you had selacted
Hide Columns instead?

In arder bo unhide the row of column that i hidden you have 1o salect any calls before and
after the cell that is hedden then click Unhide Rows in the Format oplion avalable under
Howme tab

To freaze the rows or columns do the Tﬂ”ml'il'lg-

. Cipen a new spread sheet

. Im order to freeze rows o colemns click on Freeze Pares option available under Window
grow in View tak:
A drop down list appaars as shown bebow. Chck on Frisezé Panas. Doing o will fréaze all
e rowts Ao and all the oo % 10 ihe et of the selecied call. Scroll your mouse & the
spreadshaet the frozen ro

EREL ST e Y e

b 11y (e wog

Res el g Ls B g
=wn gy

Figura 15

Mote: The panes ane formed where your Cursor i3 placed, Select the opbion again and notice the
change in the avalable opbiong! Go ghead and try the other oplions {00, You can aso freeze the
entire row or column by selecting the entire row or column and click *Freeze Panes” to freeze the
entire fow or columin.

Imlcnmatgn lechnmogy




Parform the following activities till you are confident:

| S.No. | Activities

hide rows columns

Create the workshaet given below, keeping your cursar on B2, try all the optians
of freazing cells and obsarve the effect. Take spacific note of codumn and row
movEments. Save [he workshael as expaEnses_(your |'|E1r'r'||'_-.:|
i MG

dglroary Wars g

ASSESSMENT

Fill in the blanks:

1. When you freeze a now, remains constani
2. Freeze Panes option |s available under aroup in

3. The panes are formed where your = placed

SESSION 4: SET PAGE BREAKS

Relevant Knowladge

To print a worksheat with the exact number of pages that you want, you can adjust the pagea
braaks in the worksheet befone printing it. This featwes is very usaful especially when panting huge
aiveEbs. You can use the A Hrgak view {0 S&e Pow olher {:h{u‘..-;:;E::;. (e.g {;i"l.{l.l‘q]u'lg FOAN hE:lgFﬂ f
column width) affect the awlomatic page breaks




I Emig exercise you wil leam hiw 10 set page Dreaks in ihe spreadshesd

Cpen a new spread sheet and creale the sheet below. On the Wew tab, in the Workbook Views
groug, chick Page Break Preview.

o L
& e A i e

R R e

e e e |
s e e E e D

Figuro 16
MNow to sot the page break do the following.

T insert a werbcal p lect il noe BeElory wherd vou waan! 0 insert e P BiEak
T et @ horizonial page break, select the oolumn (O e nght of whers you want o insert
the page break.

Click on Breaks down ammow under Page Setup group in the Page Layout tab. A dropdown
appears as shown below.

]

LT TR

Jrrert Fugs Erema
Bt Pk B2ddi
Rl 48 Page Bresis
Figura 17
Click on Insert Page Break opton, The spread sheet will be displayed as shown below. The
conbent you have yped comes in the first page and you can print i,

1o move a page break, ssmply drag the page break (o e desined locabon

Irfcrmakegn Tachingd ooy




Figure 18

Mote: You can also remove the page breaks by clicking the Remove Page Break option in Breaks
drop down lisd

To returm o Mormal view after you finash -..'.-n::-fb:mg wilh the page breaks, chek Mormal in the
Workbook Views group under the View tab.

Perform the following activities till you are confident:
S.No. | Activities

1 Set, move and debeie page breaks

.E . {]r'r‘.'tlﬁll'u‘ -.-.-Hrh::-_:r:a:ae'r !:_|.|.'.'|_!|'| BElo -alculate the closing bakance, Add 10 mone fems
o the list and set page breaks for printing. Move page breaks if contents do nod fit
onto one page. Save this file to be used in the follewing exercise with the namae
||1}:n:«_:_.|::,~:_;||_|r I'I';IITII_'.:I

n Lt = i

pandng | Closing
Balandie  |Ralande




ASSESSMENT

Fill in the blanks

1 To mssdl a page break, select the row Delow wihene you want bo insen the page
break

Toinserta _ page break, select the column 1o the right of where you want 1o
insert the page break.

The Breaks option is available under _ groug in the Page Layouwt tab

To niturn to Mormal view after you finish working with the page breaks, you néed to click
i the Group under he

SESSION 5: SET PAGE LAYOUT

Relevant Knowledge

If you have a worksheat that contains a huge amount of data with many charts and you want a
protessonal h}l}klr'r!_:j printout, whal would you doY Spread sheel software provides varous page
layoul oplions for organizing pages using the Page Layoul option, in this exercise, you will leam
how io sei the page layout oplions in the spread sheet application. Open a new spread sheet

To sat the page layout options, do the following:

= Click on Page Layout opbon under Workbook Wews group on View tab. The spraadsheet
will d:ﬁ;ﬂ{rﬁ:ﬂ A% shown below, You can sel the

= Margins
Owrberibation
Page headars and hoo
Hide or display grnd lines
Size of the page

Dafine the print area

Specify the background
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Llick on Marging oplion undes P.ug-u- E-:I'!up Qroug, a dropdown i3l appears as s
figure 20

Figurg 20

You can either select amyone of the predefined margin oplion available or else you can define
your own margin seltings by dicking Custom Margins. option. A diaksg box appears
T EE— i

P e -

Figuno 21

Yo can 58 the Fargin values manually from the opbons availlabde under iha |;||.3]-:_‘.|g [iCkE ]

You can sel the orentation of the page o either Porrait or Landscape by clicking the
Onertation oplion under Page Sefup group in the Page Layout fab

You can set the size of the page by dlicking the Sire oplion under Page Sefup group in ihe
Page Layout tab.

Yo San SFIE!{:I":.I' 1 ared b0 be prinded by EA}IEl:.‘Ilr'tl_!} e afea and then 4';|:-:::Ii.||‘|g Print Arga
option under Page Sefup group in the Page Lapout tab. A drog down list appears a8 ahown
el oM.

Aren
!- | Get Print Ares
Clear Prind Ares
Flgure 22
Click on Set Print Area 1o sef the selected to gel printed. You can also chear the print area by
clicking the Chear Prnl Area apbion.




You can specily a I::ra-.’_!h.grl;u.lr'l-.’_! lor your sheat USg e Eﬂtg'rpr.r.ﬂﬂ' Oplhon wnder Pﬂg«u
Setup in the Fage Layowt tab

Perform the following activity till you are confldent:
| 8.No. |Activity |

1 | Reopen the worksheet created in the previous exercise named items_{your name)
| Modify the marging, view the document using print preview and observe the changes |

ASSESSMENT

Fill im the blanks:

1. Spread sheet software provides vanious page layoul options for organizing pages using the
Wiew.

2.  Margins option = available under group in tha

3. Two types of page oremiation are &

SESSION 6: MANAGE WORKBOOK VIEWS

Relevant Knowledge

Spread sheet offers the users with vanable views for the purpose of viewing the cutcome of the
sheat while printing

There are e fypes of views avadable in the spreadshesat

= Mormmal

= Page Layouwl

= Page Break Preview

r Cusiom Views

*  Full Scresn

You can select ong of the abowe said views by ﬁl.-:j:h.lng the approprigte oplon under Wiorkbddok
Wiews 1n e Ve tah
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! )
Normal| Page Page Brish [
Laysut  Previdw SEreen

HArkBgst Viree
Figumg 23
Mormal View: The defaull view of the spreadsheet application is the Nosmal, It's a collection of

cills '._'1rr:_'|r'h;_;|13|:| i thie work anga

Page Layout: You can select the Page Layow vidww in onder 10 guickly fing bene & workshest that
contans many chams or huge amounis of data and achieve [h'l]h‘::.._.l{ll‘tﬂl I{:-:_‘.lhu:‘l.-:._] resuis

F:gﬂ Broak Proaview: This ophon iS5 simdar io the F"._':E'm Layout oplean axtep vou can sel the arnsa
that is to be set a5 a page afler insering page break

Custom Views: IF you would like o view selected areas of a document | you can use the custom
view opiion. For example, if you would like to point out certain row and column, you can add that
b the Cuessbom wienw!

Full Screan: Selecling this option makes the workbook cover the entire screen. All 1abs are
hidden from view, To get back the tabs, chck on File> Restors,

Additionally, in spreadsheet, you can open multiple windows that display the current spreadsheet
and than Arrande those windows in & vanely of ways, You can also open and amange mugiphe
wWorkiook windows

To open a second instance of 3 workbook in a separate window:

. Chok the Now Winoow Dutlos on the Vios tab, in e Wiﬂﬁuwg:‘r.}up

To arrange multiple program windows:

Click Arrange All button in the Window group. An “Amenge Wandown
Arrange Windows dialog box appears.

AT g
Click edher Tiled, Moerizontal, Vertical, of Cascade . el
OpIonS. Hewrmont sl

fija @ |
T inclede only wingdows i]hE:;‘ﬂ.ﬂ.ymg views of the currend
workbook, select the Windows of active workbook
check box.

Camades

‘Sefiniome o Siive weorhbook

= 1 Cansl
Click OK. == g




Perform the following activities till you are confident:

| S.No. |Activities |

1 R Ihqi:- '.-.-;:;rks:ru:;-r . A " \ th i exprcises ¢ ._ 2 na Hﬂ. h;.i,'l.l'l'iﬁ_l-l:'!.'l_"ll.,lr: r|.'1r|‘|E']
| 853 named expenses (your name) and 55 4 named Bems_{yowr name) Using the |
commands in the Window group on the View menu, Gile the three windows, and then
arrange them 2o that they overdap. Move each window separately and obsensea whal
happens in the others. Try the Cascade and Tile oplions 100

Uze the New Window command to open a second instance of one of the workibooks
| Then amange only the two windows of the active workbook honzontally

ASSESSMENT

Fiil in the blanks:
1. [Different bypes of vidws ane available under in the: View tab.

The five types of vierws anailable ane

nelps you to view a seleched ares of a workbook

SESSION 7: APPLY CELL AND RANGE NAMES

REalevant Knowledge

You can assign names to cells in a worksheet and wse it for quickly locating specific cells by
enbering the names. This could be wiedul when working with large spread sheats. For example, if
you have a Iﬁeﬂgﬂ:‘.':.l lish o QrOCEneEs and prices, you can use names (o quickly locate and find total
pricing of fruits from the entire list

Ini this exercise, you will leam o work with call and range names.

Open a new spreadsheat and enter the following (figure below):

Irformaton Teching ogy




Mow to apply range names, do the lollowing:

[

ST BT R SR

Chili
AU
Carugf
ap
} Guaea
'.I.;"H'l.]ﬁ
Freapphe
: Polalo
5 Pusmipson
T Spnach
i Tomalo
Figura 28

Select the cosl against the cells that have Apphe, Banana, Chedry, Grape, Gudava, Mango,
Pineapple values (Keep the Ctrl key pressed and click on the cells - you will be able o selec
selective cells together!). Right click and select Mame a Range.. . Alamatively, you can
seloct Dafine Nama under Defines Namas group in the Formulas tab

i N Hmn-qjl::lltig box appeans 1:-4'1:u‘|'.|:|lll‘-_:; 1o &nber a name. Enler Fruits o the Name hald
and click OK (figure below)

e [ |
e

- | e |

S,

Figura 28




agams! the cells thal have Cabbage, Caulflower, Chili, Cucumber, Ginger,
Spinach, Tomato walues, Righi dick define the name Vegetables for this
group.

Figura 27
If you would like fo calculate the fotal cost of fruits from Ehe list,
= Select an empty cell
= Type Total Cost of Frusts and in the adjacent cell, Type =SUM{Fruits) and press Enter

Motice the total cost of all items named as Fruits is displayed

Perform the following activities till you are confident:
| S.No. | Activities -

1 Apply names to cells and cell ranges and use them in formulas

2. | Lising ihe worksheet created i this exercise, calculate the cost of Viegelables
the workbook as Grocary_{your name}.

ASSESSMENT

Fill in the blanks:
1. Assigning names to cells in a worksheet help you to specific celis.

2. The Define Name oplion i available under groug in the
tab.
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SESSION 8: CREATE MODIFY AND FORMAT CHARTS

Realevant Knowladge

A chart is a graphical representation of data, in which the data is represented by symbots, such
as bars in a bar chart, lines in a line charl, or shices in a pee charl. A chan can represent tabular
numeric data, funchons or some kinds of quaiative strectures

A Spread sheel enables you o create, modify and formal chars based on the data given in the
spread sheet. |n this exercise you will leam how to create, madify and format chan using the
spreadsheaat.

Reopen he workshest expenses [(Wour name)
Mow to create charts do the fallowing.

b | BE3

ry  Febmawry Maeth g
iy b
e
[ A F o] L0 -
b Trawsleng [ngardad X 1]
[

Figura 28
Sehict all the ExpinseEs data
Click an the chart type that you want from Charts group under the Insert tab,

After selacting tha chart type the spread shaet will be displayed as shown below

Wl =
= =

EE ER | Bg BE &8 i @ E i

PeRaangs

FF A R

Figuro 29




You can modily the Chart values by making necessary modmcabons in the dala table

E} Expenses

a
B Trywelleyg [xperies
Grpcery Lupenses
& Electrg &0
£
% o

Figure 30

Chart Ras many ements Roweeer |:|r'||'!.l o of the elements ane displayed by detault Fl}lli.'_rp.'lr'|;_|
15 an descripiesn of the slements wsad in the above char

1.  Chart Area of the Chari
Plot Area of the Chart
Data Poinis thal are plotied in the chart
Haorirontal and Vertical Acas in thé chart
Legend of the char
Chart and Axis Title used in the char
Data Label for identifying details of data point in the char

Mote: Onoce ywou insert a chart in the spreadshest three additional tabs are available on the Ribbon
namely Design, Layout and Format, You can adit the chart, its design, layout and formatting
options using the thres tabs avadlable. You can change the charl type, chart opbions abc in the
I:Iq':!i:lgn tab and can give the tles atc. in the Layoul tab and set the borders, oolors and size of the

option under Format tab,

u._di § [Tep—p— i
.hh‘ﬁ-d‘*- e - e i P—

gy -
K S5 e apesles b bel0s sl 0y
g amw e & = 1

= im dor .

F igura ich |
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Chart Types:

Choosing the right type of chart is wery importani. Differani charts display data in very different
ways. Using the best char iype and format helps you to display data visually in the most
b '._‘lr'lrl':g]h_]l way

Bar charts: A bar char (honzontal bars) emphasizes the comparnson Debaeen items al a fixed
penod of ime. This chan type als0 includes cylinder, cone, and pyramid sublypes

Column charts: A column chart, unfike a bar chart to which it is often compared, emphasizes
variation ower a peniod of time. This charl type also includes cylinder, cone, and pyramid
sublypes

Line charts: A ling chart shows the relationship of the changeas in the data over a period of
e

Pie charts: Pie charts contain just one char dala senes. A phe chart shows the relationship of
the parts lo the whaole.

Area charts: An area chart shows the relative imporiance of values over time.

Porform the following activities till you are confident:

3.No, | Activitios |
B | Greate @ chan '

2. | Creale a worksheet using the sales data given below:

A |
Location

]
=

-

i

Amsterdam

Anchorage

Glasgow
Fadrid
Mew \'nri_




| Create bar and line charts using this data. Enhance the design of your chart to make
| it more presentable

!Eialculal:e the 1odal sales for @ach cty. Create a pie charl represanting the tolal sales
| of each city,

ASSESSMENT

L. Fillin the blanks;

A chart is a of data, im which the data is represenied
by E':.'r'l'ltll"_ﬂ..‘\:‘ ¥ g Jina Bar chart. = i@ ene chart, oF

The three tabs that are available after ngerting the chal n the spreadshest arg

&
Answaer the following.
List seven chart elements

List five chart types availabke in spreadsheet.

SESSION 9: SORT AND FILTER DATA

Relevant Knowledge

ot 13 a8 featung thai helps you arange thie Selected data il r in an .i,iE:{:EI"IﬂH":E; or |:|Ee.~:-:|;:1',-|‘||j||"|g
order. Filter is a feature used for extracting paicular data using some conditions. Sprepd sheet
offers both these features for sorting and filkening data in the spreadshest,

Open a new spreadsheest and enter the following data:

L B s £ E
1 Ragion Lglan O0E Lilsq NIOA Taisy HOBD Tuldsn Mil]
I P Dl + &7 | Py
LU L] i 1
Calrutia 3 L3 ]

P— O —

Figura 32

Mow to sort or filter the data do the following:
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Sebect ihe data 1o be soned and then click on Sort option under Sorf & Filter group in the
Date tab. A dialog box appears as shown below,
COE——

SRR jresng—— —

—— A

O s |

Figung 33

You need to specly on whal basis you ang going to sort the data i the Sort by held and
select the order that s ascending and descending and then click QK. For example, i you
wanted (o sort the data in Sales 2008, you would select the relevani detadl in the Sort by list
and click OK. Tha spreadsheet would be displayed as shown bélow. You can notice that the
data has been soned as per he data i 2008 and alzo that values in the Sakes 2008 held are
arranged in ascending order thal

Ly

Figure 34

To filter data, do the following:

. Click the Filter option available undes Sort & Fitber group in the Data tab. Before apphying a
e you have o select the data {n'l-::;||'|[.] wilh e header as shown elow

1 ] C [1] i r
1 P S, OO i S L MOE L 203
¥ I'HI-- 15 Sl L] [ ]
1 rmabi 28 m 8
i E:-H-.u- L] [
3 Kaicuils T3 &7
B

Figunn

Once you click on hilder, the headers will be displayed with a Govm amow as shown Delow

T bl 0 et 20 v fualen 300 -
L2 L& ] 0

7

[

L)

Figure 38




11 yoan want o ilter d

. Click the dosamn: armow
Babosar

Figuro 37

You can specity the filler by selacting the available valuas in the kst

You can also sor the fillered data by selecting Sort Smallesf fo Largest or Sarf Largest fo
Smailest oplion avallable in the dropdown list.

Click on Number Fillers ogtion under the dropdown 51, GnRee you Chck the I'-:_‘.|Ih:|'.\'||'|!_:_| Submeni
appears

[T 2
Priary e L

Lrmia Thae
e P e L Yi
v Mk

Lrns Tigem 7 P Py
LB TEE

pep 12

(e

[

L

Figure 38

Here you can select the condition that you wani to specify for the data in the list, If you select
Greater Than.. opticn the following dialog box appears
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| oY g SETE
= T OW T

Figura 38
Specity the value that you want in e value Bos, (here A i T5) and chick OK, The spresdshset
will be desplayved as shown below,. Notice that only data greater than 75 5 displined under the
Sales 2009,
IRegion |~ Sales 200> Sales 20-7 Sales 20 = Sales 20 ~
I.'.'I-.I'I'Il'_l._ll

Chenral

Figurg 40

EXERCISE

Parform the following activities till you are confident:

| 8.No. | Activities
i =0ort a datased in the reguared order

2. Filter data on specified criteria
Create a 5t alow. Creata . Calcutate pe ges,
Lz th g L0 FanK-wise = this M as Studend _-:'!.'l:u.,lr

name),

Saarbrhi
Eavita
9

o 78 56 78
ishwark] 56| 2 sa] @ 7e] 67




Fill in the blanks:
1. Sort helps you arrange the selecied data either in an
Ltsing filber you can extract data based on
Sor apban i avalable in group urder the Data tab

Filter option is availabde n group undear the Dala tab.

SESSION 10: CALCULATE DATA ACROSS WORKSHEETS

Relevant Knowledge

E:;up'lrl-.'!l Vou were working at the head oifica maintaning had data for six regqions, and you use
I'-_'ZIZ-FIE“!" the same workshesat |3'!.'EU1 and labeis 1o track the average gales of each resgion over the

pravious quarter. Each sheet contains headings by region (such as Region(1, Region(2
Regionle), and in cell H15 on each shaet, the calculated tolal sales for the quarter appear, If you
wiant to obtau the average SRles Oower ihe quaner, whal would you doy

In this exercise you will leam how to perform calculations on data across different worksheeats
Open a new spreadshest. Hame sheat 1 as year 1 and type the following data.
i - E.
oy Foron Mam Al My e
oW

1)
o

ges W W W W MW

1 b

Figuno 41
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Mow o calculate the data across worksheets do the lollowing.

= GO lo sheet 2, name | year 2 sheet, and insed the same dala in the Sheel 2 for the next
year

Go to sheel 2, name it Totals, and insert the same labels

Type the sum formula in call B2, =sumy . while the parenthesis is openad go to year 1 sheat
and go to year 2 sheel and press Enter. Repeal the same slep 1o calculate surm for othes
exXpEnsas, MNobe he way 1hiie-r'._'1r1-:_:;e % specilied (Sheatngme!cellnumber)

0]

Elactne Jall

Grocery E1penses
Trarrellang Expanses
PR Mo e PRong

“d T8 WS e RS

Figurns 42

To answer the guestion raised earier, you could create a new sheet, called Cuarer Summary,
To find the average, enter the following formula in one of the cells in the Summary sheef:
sAVERAGE(Region01: RegiondE!H15)

Regiond1:Regionds. If you mowe the Region(

the software will adjust the calculation to include the sheets for Regions01, 02, 03, 04, and

06; Regiond5 will be omitted. Similardy, i you delete or add a sheel anywhere betwesn

Reégionl1 and Regionld, the software will include all the sheets located within the range in
eulatisn

EXERCISE

Parform the following activities till you are confident:

| S.No. |Activitios

1. | Make calculations across worksheets
2. Create 2 worksheets populated with subject and marks for 1st and Znd terms.
Creabe anothes worksheal called Average and caloulate the average of marks for all

subsects




SESSION 11: USING MULTIPLE WORKBOOKS AND LINKING CELLS

Relevant Knowledge

Spraadshest also allows you to link the cells from varnious warkshaets and from various spread
sheats o summarize data from several $ources, In (his manner, you can creale formulas
that span difereni sources and make calculatons usmg a combsnatlion of local and lnked
information. You can link data from other spreadsheets and keep the information up to date
without editing multiple locations every time the data changes. For example, you can display
data from multiple departmants for an owervigw of dedails without sharing infermation betwean
S0 ]

In this exercise you will learn how [0 ink cpdls from ditferent spreadshes] applications

Open a new spread sheet and enter the following data:

Figung 43

To lnk cells from different workshoot do the following:
«  Dpen anew spreadsheet workbook,
& some formula, for axample sum formula in any cell =sem(, whie the pansnthesis is

apnid, clhck an Switch Windows option under Window group i the View tab. A dropddwn
list appears with the active workbook names

Figung 44

Click on Book1 1o select the earlier spreadshest you had created and select the cedls
A T2
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Book]Sheet] BAK-S08)

f f 3

1 UM oot ][Sheet
—

Figuro 45

Press Enter. You are back on the second spreadsneet The cell whera you were entering the
formula has the i0tal of the vakees in the first spreadsheet]. Note the way the software gives
e el reference. If you updabe any values in the first spreadsheed, automatically the sum
value in the second spregdsiveet 15 updated! 'Tr',- this ot

J E

Figuro 45

Perform the following activities thl you are confident:

| SNo. [Activities

Link cells and make calculations across workbooks

ASSESSMENT

Fill in the blanks.:
1. Switch Windows oplion is available in groug under the View tab

Linking cells from different { helps you to summanze data from different
SOUMCES.

L|r'||i.|r'|;_'| data helps you help 10 kétp informaton ! wilistaut |31_'.||l:||‘|g ol multiphe
locabons,




SESSION 12: SHARING WORKSHEET DATA

Relevant Knowledge

In most office settings, thers 5 a shared dive whare teams can store common fibes for averyona
to use. This usually leads to sighting of the message: “The document [file name] is locked for
editing by another user. To open a read-only copy of this document, click™! This massage appears
BECAUSE SOMEonE &5 i-!llrl}il.-:j:,-' has the fle opdn. Sometimes however, it is nEcEssary o g

multipde peopbe working on a file at the same time. This can be fo either spead up data entry or
simpdy make ll'nl'u_;:'g et for collabaration purposes

Spreadsheet software allows the user 1o share the workbook and place it in the neteork location
wihere Several users 5 I simulaneousty. In this exencise, you will kearm how 13 share a
workshaed

Open a now spreadsheat and type the following.

hiTa Enany February Mamn  ASe
House Rent oo . -
pitng Bl fii] =1 L
Grocery Expenses o N
Traveling Epenses W o o
Prone/Mobde &1 LU N -

Figiira 4T

MNow to share the spreadshaot do the following.
= Click on Share workbook option under Changes group in the Review tab

A depdog Dox appears as shown balow
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Figurng 48

Check the option Allow changes by more than one wser af the same time. This also
allows workbook merging.

Click O,
Maote: Most spreadshest softwane avlomatically turn off some features in shared workbooks. This
is to simplify the workbook since multiple people can be working on the file at the same time

For example, shared workbooks don't allow merging cells, conditional formatting, or insarting
piclures/graphaete

EXERCISE

Parform the following activity till you are confldant:

S.No. | Activity

1 Share workahee! data wilh other users.

ASSESSMENT

Fill in the blanks.

1. Share Workbook option 5 avaslable in groug under the Reviisy tab

Shared workbooks don'l allow £ & ingering
or
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SESSION 1: INSERTING A MOVIE CLIP

Relavant Knowladga

Presentaton allows the user to add movie clips fo the preseniation in order to make the
presentation cobourful and meaningful. You can inser movies or YouTube videos downdoaded
Fecrmy i Arib@rmied

I i eooercise wou 'wil leam how (o nsert a moves clip in slides {:'pen & new file LESing presentation
software.

You can insert a movie in two ways.

*  Lhsing Insert tab

- Lismng Telle and Coontent Layoul Optdn

Click on Mowie option pnder Media chips group in the Inger tab, a drop down appears a8 shawn

bl
N ‘_'
i ‘}
By

Riorie Trom File
E:'I'! Teom Lhip =.-"i3hl:'.'
Flgura 1

You can selec] the Movie from Eile option o Inserl he movie oip that you have alneady
doanigaded from the Intemet. A l:'lﬂll:rg Lo appears as SO Dehony
- =
Tl B i — =
R S LT AW
rpea—— | W wwial i

e i

Figura 2
You can kecate the moves -:|IF- and click OK 1o insert the same in the slide. The prr—.-sﬂ-nrahm sall
be 'UIEFIIHj'Eﬂ a8 shonw Dedon.
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0 How 5 you wanl Ene o 1o slartim e s o

SFew gD >3 |

o |

Fligisrs 3

fou can set one of the hwo optons available for playing the media cip, |.e Julomatically or
When Clicked.

Alternatively, you can select Movie from Clip Organizer... option 1o insert the movie clips that
are available under Clip Organizer. Doing 50 displays the clip an task pane as shown below

Click to add tithe

Figure 4
You can select any of the movies avalable and insert i in e slde Cnce you have insered the
TThDVRE l:|||:| in the shae, the presentaton will be HIED'EH:EE‘H a5 showmn Dekow.

.3

Flgierg 5




Using Layout Option
Open a new file using presentation software and change the layout of the slide

CEck an L.l]rnul‘-:::u[h:]n availabhe under SKdes Group in the Mama tab, a dropdown list appears
as shown below

T e |

HTeLE Theewne
[

Tithy SiNde A ctign Header

L R -
Ty *

.I-,--|:- P e .:.',rur_'.j."p:.-n Tile Sniy

Co-rtend weith S Figtuae with
CEpiaam Captimn

Flgura &

Click on Title and Content opticn and a slide will be displayed with the layoul as shown below

Click to add title

& Click to sdd pext

Fleierg 7
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You can insert & mowvie in e slhae by chcking the
el icOn, a ljla.".{lg appears gs Shiown Dehow.

— 2

e woew o=l |
K

woon in the Layaurt oplion Cinpe ol chick

L
S Pl

¥

R
[Frr—
=

——

gy —— B |
- (=] = | J
Figura B

Winen you play e shdeshow, the movie clipoawdll be played aulomaboaiy

EXERCISE

Parform the "ﬂ"ﬂ'ﬂil‘lﬂ activities till you are confident:
S.No. ] Activitios

1 { Insert a movee chp uwsing Inser opdon

2 Insert & movie clip using Layout option

3 | Download different clips on either “Effects of thoughts on water” or "Our place in the
cosmos” o “Effects of Global Warming™. Create a presentation giving an appropriabe
riame 1o the file. Inser the relevant video clips and save the presentation. Yow will

| umeE has e in fulune ses Lih)

ASSESSMENT

Fill in the blanks:

1

You can use two opbons o

The o optons available under

Mcorse oplion is available in

INSET a movie

o the presentation i order 1o make the

clip the

Movie opbon ane

group under the Insert tab.




SESSION 2: INSERTING AN AUDIO CLIP

Relevant Knowledge

You can inchede audio clips to 8 presantation similar to that of videos. For example, you can play
mild bhackground music wihie |||:J‘i:ir'mg wour presenfation. In thes axerciss you will lzarm how 1o
ingert an audsd clip in shides

Lipen a méw hibe uSing presentation software, Glick on Sound opbon under Media :ﬂp: QroLg In
the Insert tab, a drop down appears as shown in figure 9

.

Tound

.g:_. Sound from Fis
Fowung from Clig OFganizer

Flay OO Audio Traci

Figure 9

You can select the Sound from File... option to insert the sownd clip, A dialsg box appears as
i el

SEEE Y

o pe— T oy
i, e b
T ]
B ==
ey

Figura 10
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You can lacate the audip chp and click OK 19 insert the same i the shde, You may lollow the
same sieps as you leami while ingerting a Movie Clip. There is an inbuilt clip organizer for a list of
sounds. You can access them via the Sowvnd from Clip Organizer... option. Go ahead and insert
an audio clip wsing this option.When you have completed inserting the sound clip, and you play
i shideshow, e audio chip will be F}E{I‘Er}t] '._'1|.|1|:|r'r'|'._':r_r:';.a|.f:.l

Parform the following activities till you are confident:

S.No. | Activities

1 Inseri & sound chp in a presentation

Z Dowmboad appropriale music and then reapean the file created in the last session. Add
tht mugic fles 1o gnhance the efect of your présentation

ASSESSMENT

Fill in the blanks:
1. You can include oa -F'fEEEFItHllm similar to that of videgs
AL {]Ilp'}: are used for playing while making presentations

Sound option is available in the Media Chps group under the tab

SESSION 3: WORKING WITH TABLES

Relevant Knowloedge

Presentaton software enables the user 1o 200 tables in the shdes in onger o repnesent the
statisical data meaningfully,

I Ehis exencise you will learn o work with tables

Open a new file using presentation software. You can insert a table in two ways:
= Using Insert tab

= LUising Title and Content Option

Click on Table oplion under Tables group in the insent tab, a drop down appears as shown
bt




Egoei Spresduhest
Figure 11

You can have learmi to create tables in a word processor By dragging the mouse over nisquisibe
number of boxes. Follow the same method here and creabe the able shown balow, Mow go ahead
and try the [nsert Table... and Draw Table options o create the able

Figura 12

Figura 13
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Using Title and Content Option

Open a new file using presentation software and change the ayouwt of the slide. To change the
layout of a slide do the following:

Click on Layout oplion availabe under Slides group in the Home lab, a5 you ded while seteciing
a movie clip. Click on Tithe and Content oplicn from the dropdown list. You can insert the tabla
in the slide by clicking the icon available within the layoul. Once you click the icon, a dialog
appaars as shown below

2%
Mumber of gohamrs: |5 =

e @=rbir e waly
Fa cample, i you nessd & table weth
and Number of rows fields,

Onece you hawve insarted the tabla into the slide, addibonal tabs - Dasign and Layouwt - ang made

AP LR
Y e O T S

i e L Fet

Figure 18

Yioui can chandge the dessgn ol the labhle by changing background, borders or effacis Dy LESIng Tabila
Styles group in the Design tab. To use a paticular design, Select a desigyn under Table Styles
group and double-click an it. If you would like to change a dasign. choosa a differant design undear
Table Styles group and double-chck o e rew :11':5'|E|r'r

You have leami o creabte a table in a presentation, but i the table already exists in a word
PEOCESSOr dOCUment o & spreadsheel. you can deeclly impo il Trom here. To do




Wilh @ slede i edsl mode, choose Qbpect rom the nsoert menu

In thiz Insert Object diakpg box, cick the Create From File opton and chick Browse (o locale
and chpose the document of spreadshest that contains the lable. By default, the presentation
software will insert the table.

When you click OK, the entire document or spreadshes! is imporied fo your slide. Double-
click the inserted taxt to remowe exira tecdt if the document contains maore than the table.

I you check the Link checkbox while ingerting. On doing so, afier you update the fable in the
document or spreadsheat, then right click on the imported table in the presentation software,
and sehect the option Lpdate Link, the embedded table gets updated aulomatically

Dwag and drop the table on the slide to position it.

Perform the following activities till you are confident:

_ S.No. | Activities
1 Insart a table in a presentation using Insert and Layout tab

Z Change the design and format of a table in a présentation
3

3. | Impor a table from another application

4 Open a new file. Try inserting the table given in this exercise with multiple rows and
codumns and also use dfferent pre-defined styles by using the Table Shes opbion
under Design ab

ASSESSMENT

Fill im the blanks:

1 are used 0 represent the stahsbeal data ﬂ'lEEﬂ'ﬁgrl.l'-hl n a
presentabion

Table oplon is available in group under the Insert tab
Tiea witiys b0 create & table ane &

Additional tabs that will be available for editing and |.f|=‘.'ﬂ1.ﬂ1[|['rg ihe table ane
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SESSION 4: WORKING WITH CHARTS

Relevant Knowledge

Presantaton softeare enables the user to insarf charts in slides o present siatistical table data in
a piclonal representation. This enswres that the aedience can grasp complax data at a glancs

In this exercise you will leam 1o work with charts. Open a new file using presentation softwane,
To st a chart o (he shide, an Chart opbon under Nusirations Qrougs in thie Insert? tab, A
dialog box appears as shown bel

You will notice different type of tha charts that can be used in the presaniation.

Select 8 char By and chck O, & defaull char will B insefted on e slide. The defaull dala

Ll i il | i

FERRE 8 e
4

Figurg 47




You can edit the values in the spreadshest and the presentabon soltware will automabcally updale
e chart. MNow enler the 1n|l-:rmng 1N e E.FIFEEﬂ’HhE‘El WiINno oW

_- | Dag,'- 1 Savings Day 2 Savings Day 3 Savings

Arun S0 250 500

John 200 300 300

JBCoh 130 200 ' &0

Salim S0 150 15

Once you have modified the data table in the spreadsheet the chart in the shide gels modified
automatically and the chart will displanyed similar 10 the ane below

w Curp | Saramge
H Chirg 0 Larvirggii
i By ¥ Sarvings
LT ]

Aniah Sl
Figure 18

Mow change the values in the spreadsheel and obsene the changes in the chan

You Can change the colors and efecls of the chan by usang Chiart Shles avadable under Dasign

tab. To change to a different style, selact a style from Chart Styles and dowble-c n it

Some Basic Guidelines are as follows:

= Convey one message per charl. Make the message the heading.

*  Make the chart easy o read. Label the X and ¥ axis and label the lines, bars, or pie wedges.
Make the most imponant text |argest, the most imporiant data lines or sactons darkeast

Make bars and columns wider than the Spaces babwden them
Be accurate. Always stan a numenical axis al zers, Compate only like varables

Eliminate al unnecessany delaals., Avosd gru:j hnes, data poin a5, abc. unless they retale
b the message

Lise a few (maximum four) colors per visual

Irformaton 'Ii_'n:hn:h:u_;!,'




Importing a chart

You can also impon a char from a spreadsheel. The method i the same as importing a Labhe mivley
presentatgsn software. Since the entire sheeal is imporied, you may need o maneuver arcund and
display the chart in the embedded object. To increase | decrease the size of the object, you can
doubde click on it and resize i

Perform the following activities till you are confident

| SMNo. |Activities
Insert a chart onlg a siefe

ver applicaton
Create a chart using the data below in a spreadshes!. Import the chart onto a slide

ASSESSMENT

Fill im the blanks:

1. Presentation enables the user to insen in slides to present statistical table data
in a pictonal representation

Chart option is availabde in group under the Insan tab.

SESSION 5: INSERTING TRANSITIONS

Relevant H-h:rwlr:ﬂge
Tranzition efacls 3 ri{ “TEAS 3 AR S inleneg) '!I_J|||||:| A presentatgn

A shnhe I | v sl rmoon whien o aAnges to i@ r'||ie-r:r_4_'1|_1r|r'|;_'| @ presentabhon E!:,r
default, ome slide simply replaces the previous one on screen, [ust like a slede show of photograghs




ouilg |:::h'._'1r1-:._]1_! from one (o the next, Most presentation software provides many different transition
effects thal you can use to ven up your slide show,

I this exercase wou will leam 19 add transsions i the presentatsn, Elpen a new fila LSIng
presentation software and add contents to the presentation based on the guidelines provided
earlier. To work with transibon effects, click the Animations tab. You will be displayed with list of
Irarsion efects samilar o the one belo,

e | Gk Tam w

i el el e Ry

ot i ¢ el
CCEE oty B B |

1
w

I'l'.l-'l'" Moy *
Figura 18

To apply, select an effect from Transitions fe this slide group and double-click o it

You can also increase or decrease the duration of the ransiion eflect by seliing up the tme
interval {in seconds) in ouration oplicn under Timing group. Try sefting the duration as 1 minute
and observe the affect by performing the shde show.

You can set sound effects during transitions by selecting a sound scheme available in Sound
option under Timing group. Try using different sound schemes and obsense the sound effect by
:uEerf[:lrn'm'lg e hicde Siow

Il you would like to keep the same transition and sound effect across the entire presentation,
click Apply to all under the Timing group. Selectng this optan will apply all the selecied affects
across all shides

Mote: Acemmon mistake made is using oo many transibons, oF using one that doesn't it well with

|_1hJ|;:|;‘:I maiber Tr':.l io find ane transition that doesn't detract from the pre Al and use
it throwghout the show, Using 100 many makes your presentabon looks amateunsh. A ransiion
is the final effect to be given to your preseniation so edil and amange all slides in the prefermed
order before setting them

Perorm the following activities till you are confident:

5. No. | Actvities

i. Apply iransitions o shides

Informaton Taechno oy




Mow opan the presentation created in Exarcise 1 (either "Effects of thoughts on
wated™ or "Our place in the cosmos™ or "Effects of Global Warming™.) and try apgilying
different transition effects (o your presentaton slides

ASSESSMENT

Fill i the blanks:
effects can helpin increaseng audience's inferest dunng a presentation

A 15 the al mohon when onge Shde {:h;.':lr'll_:_i'l}.‘j- o e e 1_'.1|_J|'|r'|g a
presentation

The st of transition effects will be available under

Transition effects are available in group wunder the

Animations lab

- are someé of the transibion efecls avallable n a
presentation softwane,

SESSION B: INSERTING ANIMATIONS

Relevant Knowledge

While transsion ofours bebtween each slide. animabon allows yvou [0 put slide ekements, such as
text and graphics, in motion within a8 shde! Animatepms are helphul way t© make your sleies ook
more dynamic. Besides adding acton, they help steer avdience focus and emphasize important
points. They are also a greal way to reveal text of object on a slide one step at a time. For
exampde, you could hawe fve bullel points of text, and réveal them one-by-one on the side wilh
gach chck

In this exercise you will learn 1o add animations in a presentation. Open a new file using
présentation softwane and add contents to the presentation based on the guidelings paonvided
garher, To work with animabons, Chck Animations fab, You will 38 Animation ophons similar
to the one balow,
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Figung 20
o apply. select the grapiecal ofyect and chck Animalte under Ammelions Group Select the

animation effect under the Animate dropdown list. You can apply an animation effect by selecting
different animation schame from the dropdown manu.

Oy e - o
- Bl [T L] Eor i

-;.':. i Amimmpy Ply Snemgion s
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Figura 21
Once you have selecled an animation scheme, play the slideshow o preview the effect
Surveys show that animation effects are ane of the most annoying elemenis in presantations.
Hendwad, when used affectvely, these effecls can insert a dramatic momani fo a paricular
it A and add spice 10 8 dull preseniation
To summarize the effective uses of animation effects:
- Helps focus audsenc: atlentssn on information
= Conbrols the flow of inbormalon esp by witidle i}r:;_'ﬂ{t:mng a -:_!l'.'lgr'.ﬁr'n

=  Reveal concepls one by one

Parform the following activities till you are confident:

| SNo. |Activities

1. #Apply animation on slide objects

2. Create a presentation w

IrTfcmadsgn ]F_ll:hrlﬂl:r!;!.'




ASSESSMENT

Fill im the blanks:

enables you o pul shoe elements, such as lext and graphics, In

Fnalein wWikhin a shde
are helpful way to make your slides look mone dynamic

L[+] {I[;lpl:,r an animabon, select the Animale oplion as ildE B - _ Group undar the

Animations fab

SESSION 7: GROUPING OBJECTS

Relevant Knowledge

Grouping can help when you wani o move, rotate or resize multiple objects in a presentation.
You can group objects swch as pictures, clip anl, shapes and text box: onte grouged thay appeaar
a3 a sangle object

Im this exercise you will leam to work with grouping and ungrouping of objects. Open a new file
using présantation software and add graphical objects (o the presantation based on the guidelmes
provided eardier. To group the graphical objects, sedect all the objects that you wand to graup in the
glage. To sekeci mone than one oipects in the shde hold down the cirl key and select the object In
the slide

T group the objects, click Format tab

8, i w53, S

Figung 22

You can select the Group oplion avaslable under Arrange group in the Formaf tab. Once you
selecd the oplion, you should see a drppdown similar 1o one deplayed below,




Filgurg 23
Click on G‘-mup o group all the selected graphical objects in the shde

E:;ll'l‘ul:_iﬂ',' Wou Can ungroup the grouped oecis by sedecling the ungroug opbon avalable under
GI"EI'LIP dropoown menu.

Parform the following activities till you are confident:

| 5.No. Activitios
i ' | | Group obiecls on a shde

2 Opan a new presaniation, and creats the following images and add small textboxes |
as headars o descnbe tham:

Mow try selecting the cbiecls, practice grouping and ungrouping functions.

ASSESSMENT

Fill in the blanks.

hedps to move, rofate or resize multiple objects in a presentation
2.  The Group option is availabée in group under the Format tab

3. The three options available wnder Group dropdown opfion are
&

Infcrmakegn Tachingd oy




SESSION 8: INSERTING SPEAKER NOTES

Relevant Knowledge

Good presentars always rehearse their presentations wall but thera's often one morna thing thad

helps them deliver flawless presentation — speaker notes, Speaker notes are guided texi used

by the presenier dunng a presentation. Speaker notes can be short or long texts thal can be
| ation. An antd a PoswnerPoint o

OpenCifice Imprass slide that i hidden during the pres

speaker. Hent you as the presenter can nole imporant k y podnts et yoOu wish 1o cover rJr.;III"I;_]

e presentalion

You can prnt these noles out, accompanied by a thumbnail verson of the approgaal & 1o
keep as a handy relerence to use when you ane making your oral presentalion. This can help you
ommunicate specihc ponts relaed o each je and make the presentaton effective for the

audience

In this exercise you will leam to aéd speaker notes. Open a new file using presentation software
To add noles to a particular shide, select the slide and type the notes in the Click to add notes
ared located at the botlom of the presentation software (Figure below)

Iﬂ J =13 |7z Freentafionl - Microsoft PoweerPoird

“ Home Indert Deign  Treniibond Armematsond Thde Thow Beview View & E

Sl Doyl =iy + E-="| 3 il £ M
B J I 8 de - iEiR ~
Shideey ey Lddtang

A Ay & EEIAN

Type Speaker notes here..|

|[De2 . s (=T,

Figurs 24




Alternatvedy, you can select View tab and chck Noles page under Preseniation Views Gioup
Ky things to remamber about &poaker nobies:
1 They should nod restabe the conténts af the slide

Speaker noles should suppor the content of the shide with in-depth informaton

Whilé the regular presenlation shdies ane shown on the main scheen bor the aedience, he witw
on your computer screen is slightly different — you can not only see the current slide but akso
i bext nobes and other key points that should be discussed with that shde. To do 5o, open the
presantation file wsing your presantation software, go to the Shide Show fab and check the option
Use Presenter Wiew.

Parform the following activities till youw are confident:
S.Mo. | Activities
| Insen speaker notes on slides
I Open the presentation you had created in Exercise 1 [either "Effecis of thowghts an |
waler of “Lur place in the cosmos™ of “Etfects of Glabal 1|I"||'r'_'lt!'r'llr'l-§_i- b and enhancosd
in Exercige 5. Add speaker noles o each of your slides,

ASSESSMENT

Fill im the blanks:

are guided text used by the presentér during a presentation.

can be short or long texts that can be used as a reference oy the
prasanier.

Moles page opbon 5 avalabie in group under ihe View ab

Infcrmakegn Tachingd ooy




SESSION 9: REVIEWING CONTENT

Relevant Knowledge

You should ahways review the prasentation and make changes if required before you present it 1o

in a presentation. However, il s he presenters responsibelity 1o check each and every poanl
I‘I'!EIFIIJE"'r' an each slide before BI'EEI'I'IFI['.FIQ 1o make a FITEE.EI'I[F!lI-’."'I"I.

In this exencise you will leam o make an effective presentation. Making effective presentalions
takes practice, bul with a few tlips up your sleeve, you are ready fo lake on the challenge.

1

Horaiw your tapic,
You may wani 1o change fght im and stan usang the prasentation softwane.

However, do the ressarch first and know your maierial, think throwgh what and how you
will present get comiortable with the matter before beginning the project on the computer.
Creating the presantation is the easy part. The best classroom prasantations are created by
people wha ang comiomable with what the) giinyg 1o talk aboul

Use kiey phrases about your toplc

Good presantars use key phrases and inclede only the mast important information. Chogse
anly e 100 threse of four poinks and make them sevanal imes thn JE]FI{H.,I'I e presentabs

Highlight key poinis thal are necessary for the audience to remember, Keep the points as
short as possible, use 56 words to describe the poind

Avoid too much text on each slide

Do mot write your whole spaach on the slides. Tha slide show is meant lo accompany your
oral presentaban, Surmmdarize he conten bBullet points. Usa simple B ngu and limd tha
number of bullets to three or four per slide

Limit the numbar of slides.

Too many slides in a presentation may cause you fo rush to get through them and your
audience might end up payng mone attention (o the changing shide than to what you ang
SayINg I an fage, one ol el minute s aboud |'|gh|: Ifi 8 CLASSO0M presen tainon

Plan the layouwt of your slide.

Make your slides easy 1o follow. Put the tithe at the top. Phrases should read left to right and
top 1o bottom. Keep impoartant information near tha top of the slide




Avoid fancy fonis.

Make sume the Tons, r._‘.id'u"rg-l‘l and oplors ang consishanl t‘hl'nl_Jgt'b:::-l_JI the presentabon; dont
use different styles for each sbde. Use fonts that are readable; recommended fonis are Arial,
Tahoma, Verdana. Use standard fond size that is readable even from the last row if presented
in a large hall of to a large audience. Use combination of capital and small latbers. Do MOT
use all capdal letters as il may be dehoull to redd. Use bold, dahcs or undering only i
required or i highlight key polnis,

Use contrasting colers for text and background.

ise reasonable mix of text color and backgrownd; preview 1o check if it is readable without
any difficulty. Dark teod on a light background s usually the best as this combination offers the

Usa a slide design template to keep your presentation look consistant

Lise a single background on all slides; do MOT use multiple backgrounds. Use a pleasant
template or style sel; do NOT use different style sets for different slides as it will distract the
audsence and they might lose the focus.

Use animations and transitions sparingly.
You may enoy apphying ammabons and transftions in every place thal you can. This will

certainly be entertaining, but ai the same time very distracting. So use this feature with
prudence.

. Alzo, always review the presentation 2-3 times before making a presentation;

this can o in ||:1‘_1u|:ing o & My SNOFS BN il R sming piEvant po r||_|r|r'|5_; ih
restiew, Bid oF remove mages dunng reviess Try presenting 19 a smalle i 115]
nNecessary comections bafore FITEE.EFIIZII'IQ nioca Iarger Bindence

Mote: Most presentation software includes many features; do NOT iy fo overuse them!!!

Onece wou have crealed the presentalion of your choloe using the guedelines, you may now
|:lrl31:EEl:| bo reviewing the prr—.-senlahm. Use the addional gIJII:IF_'llﬂE'E Do

Do & thorowgh spall check acnoss all slides

Perorm a2 manual spell check for ferms thal s nod included dunng the standand spell check
in the presentation software; NOT all terms (particularty technical terms such as biological
names, atc. | will be checked

Remone irrebgvant content Such as images of clip as, lerms, atc. if they arg not reguired

Irformaton Techng ogy




Perform the following activity till you are confident:

Activity |

| Prepare a presentation with a topie of your choice of as assigned by your teacher.
Ew Lsing the guedelnes and have o vabdated by your [eacher.

ASSESSMENT

Fill im the blanks:;

1. Presenfation software incudes options such as spiell checks for comecting
BITORS in @ presentation

Tips o make an effective presentation are

)




SESSION 10: PREPARING TO DELIVER A PRESENTATION

Relevant Knowledge

Mo that you have & pie : Ay, Vo mze the delrsery of the presentaton
For example, you can customiz slides 1o be displayed fo the audience or
configure for multiple monitors, elc.

In this exercise, you will leam to deliver a preseniation

T work with Shide Show, open an axisting presentabion in the presentalion software.

Chck on Set Up ShideShow option under Saf Up group in the Siide Show tab

Once you click Sef Up ShideShow, a dualog Dox appears 55 shown below
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Figuro 2§

If the presentation is 10 be made (o an audsence, usa the Presanted by a speaker (full screarn)
optian

It the presentaton is o be made o an individeal, use Browsed by an individual (window)
aphian

If the: presentabon s (0 be made al Kiosks, use the Browser af & Kiosk ffull screen) oplion

Mote: A kiosk s 8 compuler terminal featuring specialized hardware and software designed
within a public exhibil that provides access o information and applications for communication,
commarce, antefainment, and education

In addition, you can configure the presentation (o be automated (run continuoushy), with or witfeut
animation by using the options under Show Options group.

You can display selective sikies from a presentabion using the Show slides option

Irformaton Techng ogy




Parform the following activities till you are confident:

|  SMNe. Activities |

1. Create a slide show

2 Recpen the presentation created in Exercise 1 (either “Effects of thoughts on

Cur place in the cosmos™ or "Effects of Global YWarmi : ) @nd enhanosd

in Exercises Sand 8. Frepare (0 deliver the presentabon based on all you have
learnd m this SEE.H-II'L'I'I"I_. presiew and make your presentation

ASSESSMENT

Fill im the blanks:

1. Set Up Shde Show oplion s available n group undér the Slide Show
taib,

Th aption should be used while prisenting the presentassn 1o an
Aldsence

The option should ba used while presenting the presentaton fo an
Ao

A 1= a CE-TH[:HJ‘IEI" tenminal rearunng EFIIEI:IiilLIEﬂ hardware and software
IJE!!i:L!:.]r'lﬁh::i within 8 publs exhibd thal provides actess o informabon and applicatsons for
commurication, commerce, enfertainment, and education

SESSION 11: PRINT A PRESENTATION

Relevant Knowledge

SOmelim O sy need 10 provide prnt outs of the presentabon 1o the audiens & & relerence
malengl, You can p-.r:nl noles, handowlts o Oullense of (i j5+] prese tabon using thie FH'EEI-E"I"I‘IE‘IIM
software. In this exercise, you will leam ko |:-rir|t nodes, hansouls and culling

To prnt, open an exishing presentation and select the Print option

Select the Nofes Page option under Print what: dropdawn list (figurne 26.)




Timtm- =
FifuT
——
Py T
& ] ™ Lo gt "
f
™ s
Erie woe muroees srcaor mide crges Fre miaemi
LLFiX

H-.l*

Figunp &
Chck OK once you are ready to pant the nobes

You can print handouts for audience reference by sebecting the Handowuts option under Prird
gehatl: dropdoam list. To save paped, you can prnt mullipde slides on a singhe sheat

To print multiple slides, select the number of skdes that you would like to print by choosing the
number displayed under Slides per page dropdown under Handouts Group (figure 27).

F iguing ri i

If you would to print only the text part of the presentation, you can use the Oulline opfion in the
presantation softwang.

I pirent the outline, sedect the Outling View oplion under FPrind whal: dropdoan st
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Perform the following acthvities till you are confident

Pt

Creale a presentation (10-12 slides) on any two of the following topics
+  Sehool Annual Day funclion
+  Spairts Dlay
Indepinoence Dr:l.':.l
Healthy Diet
Savings Plan (Fost Office).
{.‘rlf::_’mr'lg Presentabons
Wirile r'|'::jll»:r1‘.-g:;| the presentaions use the '.{lll{:mlr‘lg} featenes based on the presentaton |
guidelines laarnt earlier,
«  Llge Transshon effects for slides
Usa Animation effects for text and objects.
Group related piclures
Use tables and formal them with diferent table styles
+  Use charis to represent data in graphical fiorm.

«  Download and lemplal

ASSESSMENT

Fill im the blanks:
& ol a presentatson,
Handouis oplion 15 availkable under dropdown hisd

The option is wsed to print only the text part of the preseniation




Unit 6: Email Messaging (Intermediate)




CONTENTS

Unit 6: Email Messaging (Intermediate)

SESSION 1: WORKIMNG WITH CALEMDAR ... ccrames i assm s s e mms smsmsas

SESSION 2: SCHEDLULE aM APPOINTMENT ..

SESSION 3: CATEGORIZE AN APPOINTMENT

SESSION 4: SHARE A CALENDAR

SESSION 5: PRINT A CALENDAR

SESSION &: CREATING A MEETING REQUEST

SESSION T: RESPOND TO A MEETING REQUEST

SESSION B: CREATE AND EDIT A TASK

SESSION 9: CHREATE AND ENT A MOTE

SESSION 10: CREATE AMD EDIT A JOURNAL ENTRY ..o e s 0




SESSION 1: WORKING WITH CALENDAR

Relavant Knowledge

Tirme f-.i:]l'l:_‘:l_'.]&f‘r‘l{efl1 1% The A
and prosductiviby Time ma nagement can be ;nerl'r:.rnm-::l using simple echmgues
and pen; you can also use calendar software io plan your timea

Calendanng softeane provides the user an electronic version of a calendar. i is a time manadgemssnt

g ;. L |'-|3I|g|{||,p§:_ cofmmercaal, or adrminstratnee purposes. Most
email applications include suppor for working with Calendar; you can also use online calendar
such as Google Calendar however this requires internet connectivity.

Ini Ehis exercise, you will leam 1o work with a calendar application, In these exancises, you will bé
pracioing on Oullook Cabendar, Al the end of the 5 . YOU Can e Iy nawvigale on any ofhes
calendar software as the features ane almost the same. To leam about Google calendar you can
gxplore the site hipofsendces google comfapparesources/ovendews_breaze/Calendarfindex.
htmi

Start the email program by
Click Stant > Programs > Microsoft Office > Microsaft Outiook.
ck Cakendar located ai the boftom left cormer (fagune Delow)
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Figure 1
A window similar [o the one below appears
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Flgura 3

You can creabe appaintments and schedule day-to-day activities using calendar. The application
provides (hnse vidws

Foe fat Yiew Go Jook Adbons  Help
Shew - & X ga Tedsy W

Calendar Day
Figure 3
For example, to schedule an activity for a particular time in the day. choose Day view, The default
view is by “Day”
You can selec] either the Show work week (Monday to Friday) or Show full week (Sunday to
Saturday) to view the appropriate days in the week by selecting oné of the given options.
Dy Week | etk & Show work weel O Show full werk

) Fi::|-.|:r_- i
Seleching the Month view sShows calendar for a month, You can plan Yo minifdy schedule
here .l’!.n.g.r appointmentsimestings/oommitments previously sef in the dayweek view will also be
reflected here,

You can swibch over o a '!]F':-Eﬂl.‘u_‘.' dale in the calendar by selecting the dale in the dala navigator

Calemdar
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Flgura &




You can sel the options for the calendar by selecting fooals > Qpiions. A dialog Box

o Delonw,
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Figuere &

Chick on Calendar Options... and a dialog box appears as shown below.
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Figura T

You can make changes io the calendar by using appropriate options in the dialog box
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Perform the following activities till you are confident:

Activities
| Try each of the options in the Calendar Options dialog box and observe the changes
!MEIH.-E‘ a note of all changes in your notabook

ASSESSMENT

Fill im the blanks:;

s the act of planning to stay organized that wall result in increasad

eficiency and pood I_JI::1I'-'I|_':.I

2 i softwane provides the user an electronic version of a calendar,

3. The three view supported by a calendaring software ane &

SESSION 2: SCHEDULE AN APPOINTMENT

Relavant Knowladge

Your can Ccreale EFIFH:IIH‘II'TIEI'II!-} ugEng e calendar For E!I'.FIFI‘._plE_ youl Can creabe an E[!i[!il:llrltl‘l".{!'['ll
T wigaling a dentisl

Iry Ehis BXErciSeE, YU will learn o schedule an apposntrment
You can schedule an EF-:.’.'IL"IFIHHE‘H‘I In two Ways:

1. UWsing menu bar.

2. Uamng calendar view

o o Fie > New > Appaintment, & window samilar 1o the one below will be displayed




appainiment

Lataticn ol the appointmen

Figura B

Once you have crealed an appointment, click the Save & Close option for the calendar o sione
this information. The details will be raflected in the calendar.

Figure 9

Calendar software prompts you with an alent based on entries schadulad in the calandar
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You can create apposniments on a dally, weekly, monthly or yearty Dasis. You can creabe recurmng

appoiniments, for example, you create your breakfast schedule evenyday between 7:30 io 8:00
AM. To do 5o, righi-click on the calendar and click New Recurring Appointment.

. j l4ew Apposntment

Mew Al Day Frent

‘A Mew Meeting Reguest

0] Mew Recurring Appointment
Hew Recurring Eyent
Hew Reguiring Meeting
To-day
o to Date...
Other Settings.
Customizne Cument Wiew.
Automati{ Fermatting

Flgure 11

An Appointment Recurrence window appears. You can specify the appointment ime, recurrenca
pattern and the range of fscumence e,




Figurg 12

Enter a recurming evend, select multiple days and click OK.

Fecinnng appomniments appear on the calendar as a daily activity as displayed below
| Breakfast; School Co | | Breabkdast School l‘_h:ll Breakiast Schocl I:.'-;'ll

Figure 13

EXERCISE

Parform the following activities till you are confident:

[ S.No. |Activitios
1 Srhadyle a onelime and a recaimng appomniment

Fi

Create appointments for the following Hems:
1. Dally class schaduba.

. Exam schedule.
3. BExam préapadation schedule
Wisil 1o Circus (One time activity)
Parenl F Teacher Me Elifg {Mariinky acirely)
f 1o a book store (One time attivity)

accane Schedule [Yearty acivity)

v the appoiniments, you

Infcrmakegn Tachingd ooy




ASSESSMENT

Fill im the blanks:

The two ways o schegule an apponiment are

Calendar soffeare prompts wilh an based on enitmes scheduled m the
calendar

appoeniments can be used for E_:I::hEl:Il.rIu‘rg_:j repeliive [asks

SESSION 3: CATEGORIZE AN APPOINTMENT

Relavant Knowladgea

Yol Can t.illi};}::;u ine the appointments in ime ma MAQEMEnt S ftwane by Vi hie S

io the appointments, For example, you can use green color for all school related actvities §
blue for all personal activites. Using Calendar you can name colors (and change the names when
you wani o). You use colors o make specific entries stand oul at a glance and caich your eye. In
ihis @xircase, you will kearn (o categorize appointmenis

You can either categorize the appoiniments al the lime of creation of the appoiniment or calegodize
afler creating the appointmant

To use a calegory while crealing an appoiniment, select a color from the Categorize dropdown
list {figure abowve). To appdy categony for an existing appoiniment, double-click on the appointment




Yol can name all the 1_‘.._H1E=gf_:-1"u_!::1. A sarmple has Been shown below

I = B iow E——

ECDEEEEER

Porform the following activity till you are confident:

S.No. | Activity ]

1, Create appointments with different categories and apply calegones o existing
appoiniments crealed in the previous exercise. Also, try to rename a named
category and bo remowve a category you have created.

ASSESSMENT

Fill im the blanks:

1 Yol San Cabegonse Appoinbments in Wme b EmIEni sofhaare [!:,r-:._]ll.rn‘q_!j Speific
{14 H;'!I,."il:ﬂrltmﬂ-ﬁl!.

Some of the cateqomnes in the birme rr'::an.af._temgnl goltware are

a)

Irformaton Techn ogy




SESSION 4: SHARE A CALENDAR

Relevant Knowledge

You can akso share your calendar with someone else by sending the calendar to the concemead
parson’s email id. The queston that comes o the mand is why should 1T Shanng youwr calgrdar
helps 1o shane wanous 15.'-:.::I'|H;!-I"I|$ of your Hme-cenins like wilh vour spouse, family, and others
You are able o receive Hme-centric news and updates from truested providers. Cakendar sharing
is the last frontier for true collaboration and social neteorking. Moreover, you can create calendar
fodders and choose specific folders to share, Fof examplé, you can créate a calendar folder for a
particular progec and share il with your co-workers, You can also grand them penmi N bo rmodily
the events and appointments in the calendar,

Im this exencise, you will learn (o share a copy of your calendar i an emal message using email
server. The calendar will be uploaded to the mail server and can be accessed by others using
thegsir &mas i

CEck on Publish H'l-,r Calendar... opbon available in the r'\l.i,h'IEr.i,i'Ill:::ﬂ Fane of the Calendar as
SERCANTY ERaIOnN,
Bty Cabensdar
3 Calends
Heow R SPuie Calenda
Yewnh Calensdsn £ T

el & LRlinaad wia (-

Puibdinb By Calengd g

A Nrer Lfguap

Figure 186

Mote: In order to upload your calendar to the mall server, you must have an emall accouwn
in Microsoft Mailing service. Click Sign [n, to kogin with your account, if you having one; otherwise
create an email account by selecting click here to sign up for a free account available
in thée window, Enter yoaur emaid ID and pas d and clhick Sl-;;n i, Thi r{;llll:lwu:".-;; window
AppEars:




e Craitwemh ol BPariey Lereiee
- ma—

Chck Finish o publish the calendar on the mail server. The following dialog box appears:

':I-J—- — —
iyt la mrena
LT R SR ey, [ Sy —

el

T S ———
- [ R S —— Y—

L e ]
&

| I
Figuro 18

Select the time span in the calendar to be shared by selecting the drop down values. You can
i ils are (o be shared with ohers using the Detail k5t and Permissions options
Atter apecifying necessary details, click QK. The following dialog box appears &5 shown below,

e T gk e ¥ s 1 B e miiag
el R el LS Rdeme

You are asked fo enter your eémail account details to publish the calendar
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Once you enler all the dedails, click OK, Onee vou click OK the Iollowing message Dox appears

Figuro 20
To send the invitation, click Yes. The Calendar - Share window appears.

Figura 21
Enter the emal accounts o witom you would like 1o share the catendar wath and chck ﬁel‘l-l:l and
the Invitation will be sent to their email accounts,
When others sign in indo their mal accounts, the following message will be displayed o the
rEcipients

et T Ry LR,

igura 22

To view the shared calendar, the reciplents have to click on Subseribe to this Calendar option
available at the top of the message. The following dialg box appears:

T — 1

g

b g Fen e il ke,
b | = |

QLD &




e

CEck Yes to subsciibe to the shared calendar, Once you click Yes, the recapients will be displayed
wilh a window similar io the one below o enter their accownt details

Figuno 24

g authenticabon is compsete, the calendar will be downlioaded and mad
Chlendar PrOram

= .
TTAT T

e T T e
==

Figure 28

Mow other users can viaw your caléndar

You can also send a copy of your calendar (o oliver users as a standand email message. The
calendar will be displayed as an attachment to the reciplents in the email. To do so, click on Send
a Calendar wia E-mail option available in the Mavigation Pane of the Calendar as shown below

Figura 26
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Tne Send a Calendar via E-mail dialog box appears

Figura 27
You can send eiher the entire calendar or parficudar week or day in the calendar by selechng the
approgriate oplion and click OK.

Figura 2

You can specify the address of the user 10 whom you want o shara the calendar and click Send
1o send the calendar to the person

Parform the following activities till you are confident:

S.MNo. | Activities

1 | d in ihe previous




Fill im the blanks:

your calendar helps to share vanous segments of your time-centric life with
your spouse, family, and others

i3 the [ast frontier for true collaboration and sockal neworking

To share a calendar you have 10 selact I!'!-Fl‘lll':':l"l available i the
M A I3 FPare

SESSION 5: PRINT A CALENDAR

Ralevant Knowledge

‘Yiou can print the calendar and keep it for reference. This might be usaful in sRuations when you
don'l have access 1o a compaler. bn this exercise, you will leam o print a calgrdar

Go to File = Print, the Print dialog box appears.,

Figuro 29

Irrfcmmiadsgn '|i_'||:l'|r|ﬂ|:r!;!|'




=elect the range of the calendar by specibying the dales thal you need 10 be printed and chick
O,

Mo try prnting using different styles (Daily, Weekly, and Monthiy) available in the Print stgle box
{figure abowe)

To print the details of prvate appeiniments, uncheck the Hide details of private appointments
check box

To prenl non-adjacent days, ch.ang& o WWeak or Month view and then select the days you wani 1o
print, and then click File > Print.

Parform the following activities till you are confident:

| S.No. |Activities i

1 Prini a calendar using options in the pant dialogue box. You may opt for either IH_
daily. monthly or weekly style as per your choice

ASSESSMENT

Fill in the blanks:
1 Prind ophon 5 avalable under MEemu

2. To print the details of private appointments you have to uncheck
check oo

SESSION 6: CREATING A MEETING REQUEST

Relevant Knowledge

A meeling is an appointment o which you imdte people or reserse resources for (meeting hall
equipmeni elc.). You can create and send meeting requests and reserve resources for face-lo-
face meetings or for onling meetings. To create a mesting, you identify the people (o be invited,

e resersed and pick a mes ng hime. B 0 your r'r'|E:£.=1|r'|f.] request appear
in your Inbox. You can also add people to an existing meeting or reschedule a8 mesling i the
schedula is not convenient. |n this exercise, you wil learn to create a mesting request. You can
schedule 8 meeting request wiing amail apphcation softwade,




Go 1o File > New > l!'wrfﬂ_g' Reguest, the f-:_‘.llll:r.-.'u‘lg window will be displanyed:

Figura 30

= i

You can send the maeting details fo another user by sefting the Subject, Location and Timings of
thé meating in the window shiem abowva

Chck Send.

Parform the following activities till you are confident:

5.No. | Activities

ate meeting request for the follo

1. School Annual Day function discussion

2. Blood donation camp discussion

s 5

ASSESSMENT

Fill im the blanks:
A isan appoinimsEnt i which you nvile pRophE oF fesens

You can speecify , & while sending a meeting reques

IrTfcmiadsgn '|i_'||:l'|r|=l|:r!;!|'




SESSION 7: RESPOND TO A MEETING REQUEST

Relavant Knowledge

Calendar software allows the user to respond 1o other users meeting requesis. In this exarcise,
you will learm to nespond lo & medling redquest.

Dpen the email applicaticn o view the request. To respond, select Accept, Tentative, Decline or
Propose New Time oplions (figune below)

| i N

Figurg 3

Figura 32

A% a mesling attendes, you can propose an alternatve migeling time However, the meeling
organizer must accept the new time, Meeting crganizers can send meeting requesis that restrict
the abdity to propose alternate meeting times. If the meeling organizer has restricted meating
progosals, the Propose New Time command is not available. By defaull, whan you proposea
a e lirme, you tentatn ely accepl the meeh B, il yo K the tex] Propose Now
Timne, you have the additional oplions 1o click Tenr.!.rm. and Propose New Time of Decling
and Propose New Time.

Perform the following activities till you are confident:

~ S.No. | Activities
1 F'.e-imnl:l to the meeting requests sent by one of your classmates using mentioned
procedure you have keamt today




Riespond bo reduests from ather classmates wsing options such as Accept, Tentatne
etc. and obsenig the nesulls sent o your mail

ASSESSMENT

Fill in the blanks.

1 Calendar software allows the user o 10 ather users mestng eguests.

£ Responses to your meelng requast appear i your

Some of the response oplions for FEEting redquiest ane
]
L.

You heve recened a I"I"II'-_'I'-_".II'Ig I"E'QIJE'E.‘I for which the schedule s niot comvenient Lo oL
hovsever you would Bke (o reschedule (hes mgeling Which opbon should be used when
responding Io this meeting request?

SESSION 8: CREATE AND EDIT A TASK

Relevant Knowledge

Tasks refers 1o aclions that can be performsd I-_'|-,- an user tasks rhay include action Aems Such
As I!ll:lll.'.lh:lr'lg a conlerencs noom, booking Uckels, remindger 1o a task completion tsed, e, In this
EXElCESe, you will be=amn 1o creabe and edil 8 lask.

You can creale tasks in email calendar application softerana
Go to File = New = Task, a Task window will be displayed as shown below
Tya=. . -
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Here you can deting 2 subject name for the task; the start dabe and end date of the task,; the siatus
of the task and the prionty of the task. Once you have given the entire defails click Save & Close
at the top of the page. A window is displayed as shown below.

F|!:_'||_|r{| 34

You can also the edit the task by dowble clicking the task name available in the email application
soiftwang,

EXERCISE

Parform the following activities till you are confident.

S.Mo. | Activities

1 Create a new lask

]

Edif an axisling task

ASSESSMENT

Fill im the blanks:;
refers to actions thal can be performed by a user

2 While creating a task you can define
5 ! af a task




SESSION 9: CREATE AND EDIT A NOTE

Relevant Knowledge

Motes are short taxt messages that can be used for taking quick notes. You can creata nobes in
the calendar software. In this exercase, you will learmn b create and adit a note

Go to File = New > Note, a window will be displaned a6 Shanm Dabon,

s x]

You can type the content of the note and chick the © con. Once you click the = icon, a dropdown
list appears as shown below

B Hate  pr Enail

Twer L

Cabrgoion |
ord et
Erot

Flgure 36

Tix wigw thi nobes that you have ereated, click Notes in the calendar application. It you would ke
to edd the nofe, double-click on it and edf a3 reguered

Infcrmakegn Tachingd ooy




Parform the following activities till you are confident:
S.Mo. | Activities
1. | Create a note
Edil a nole
| Create note for the following ilems
1. Grocery lsi
5 1o buy lest

ASSESSMENT

Fill im the blanks:
1. are short lext messages that can be used for taking guick notes

2.  Towview the list of noles you select the option in the Calendar application

SESSION 10: CREATE AND EDIT A JOURNAL ENTRY

Relevant Knowledge

Journal entry creates a bmehne of ransactions thal can be bnked 10 8 contact. A ransachion msghl
be an email, task, appointment etc. The following activities can be automatically recorded

. Emails Sent & Recatved

*  Masating requests & fesponses

= Dffice documents you manage

By automatically recording all documents you work on, email senf to specific conlacts, and phona
calls mada, the joumal ogs all your activity. This is werny useful when you neads to know how long
you worked on a Gotument or Spent on a phone call Becaess the jpurnal tracks the elapsed me
along with the ewant; of whan a8 manager mighi wani o know the number of calls made o email
senl by the team members or track the number of documents created per hour,

I Ehig exercise, ywau will leam 1o work with pournal enires,




I you would like io track the usage of an application such as Microsoft Word, go o Teols >

Qptions, a dialog box will be displayed as shown below
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Figure 37

Click on Journal Options butbon,

Once you click the button, a dialog box will be displayed as shown below
TS 2

For Thitid (0PT.RCL

Figuira

Check Microsoft Word under Alse record files from Section and Click OK. Clos
managemeani softeane,
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¥en the word p ng solhware, créale a document and save I Close the Word
Processing software. Open the time management software

Select Go » Journals.

Following window will be dispiayed.

Fiw i Jew Ga Jesh Jdweed  Belip
Bipe= - ¥ tpow TDe Tl e 1
Journal A Journal

l_ﬂ 1 [lnjeme il gl WP LE D 10f e fisei] pde
o} Eniry Trpr Haooeall Word

"ﬂl. - i iy LEaragi ik 08y Do e

Figura 33

Mohce the document that vy rreated earlier 5 ad, You can edd the journal entry by double-
clicking the entry or by right-clicking the entry and selecting Open Journal Entry.

f et ——
Qpen

Print
Fangurd

Oipen Jourmal Enkry
Open Tbem Peteired To
Wirst AR RChmE AR
Cutegorze

i A Debete

Figurng 40

A window similar to the one below will be displayed
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Figuro 41
Hotice the following ilems that are displayod:
. Document file name and path
= Created time and date
= [Dwration (Amount of ime spent on that document)
= Bhorcut to the document itsell (Doublp-clicking tha shomcut will open the documeant)

Sirmilarty if you would like to track emails send fo your contacts, Go to Tools > Options. Click on
Journal Qptions bullon

sl
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o el e

Figurg 42
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Linder For these contacts: sechon, select ihe contacts that you wish o track by placing & check
againsi each contact. Click OK.

Maote: The contacts added in the calendar applicabon wall be visible hene,

Mow send mail to the contacts (selecied in the previous step). Once you have completed sending
the maiks, Click Go > Joumals. A windaw similar to the one will be desplayed
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Figurg 43

Motice the mail entries (sent & recened) displayed. Righl-click on the entry and select Open
Journal Entry.
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Motce the following iems thal are displayed

- Mail Subject

- Timestamg (time and date)

= Shorlcut to the mail #sell (Double-clicking the shortcut will open the mail)

Mowe that you have learnt 1o work with Journad, waork with different other oplions such as task
requests, meeting requests, atc. and obsenne the tracking in tha ime managemean] softwane,

Peraorm the following activities 1l you are confident:

S No. | Activities

1 Create a new journal antry

2. Edif an existing jowrnal entry

ASSESSMENT

Fill im the blanks:

1 creates a timeline of iransactions that can be Enked fo 8 contact

'
F=

somie of the items that can be avlomatically recorded by the Calendar Softwang,

Imlcnmategn Tachnsogy




Unit 7: Database Development (Basic)

i
_'r 0k

sdatabase

:

sy gat

—a




CONTENTS

Unit 7: Database Development (Basic)

SESSION 1: DATABASE DOMCEPTS ......cocoeocveoeveasetsmomsensebssssbansssasstomsastesetossasessesmsmsaesese
SESSION 2: DATA STORAGE

SESSION 3: MAMNIPLILATING DWATA

SESSION 4: CREATING A DATABASE OBJECT

SESSION 5: CREATING A TABLE

SESSION &: BUILDING FORMS

SESSION 7: CREATE AND MANAGE QUERIES

SESSION 8: DESIGN REPORTS




SESSION 1: DATABASE CONCEPTS

Relevant Knowledge

A database 5 an onganiyed oollection of data. You can visuahkze it as a containes of iInformatn
The data is typically organized to model relevant aspects of reality (for exampbe, the avallability of
rooms in hotels), i a way that supports processes requiring this information (for examiple, finding
d heobed with vacancies),

Suppose if you own a staticnany shop, you need 1o keep delailed records of the materials available
in your Shop. You akso need to stone information aboul pricing, $lock levels for reordenng, old
giocks, eic. Wnde in the manedl sysiem, you would mantain several s with different bits of
information; in the computenzed system you would use database programs such as Microsoft
Access, OpenOffice org Base, and MyS0L, to organize the data as per your busingess need

Tha data & concept has evolved sincoe the 19605 (o ease ncreasing dificulties in ﬂ:‘:;‘;lg!_]r‘lu‘:q'_
bulldimg, and maintamning comples iriformnation yelems (ypically wath many oo Tent &nd-user
and with a large amount of diverse I:IEI‘IE_I

Inthis lesson, you will leam datebase concepts and fo work with a Database Management System
(DEMS).

Databasa Managemeant Systém

A database management system is a software package with computer programs that conlrols the
creation, maintenance, and use of a dalabase. It allews organizations to conveniently develop
databases for vanious applications. A database | ; 5

and other objects. A DEMS ailk dilterent

same database

Wedl known DBEMSs include Oracle, IBM DBE2, Microsoft 50 Server, Microsofl Access, PosigreS0OL,

MyS0OL, FoxPro, and SCHLe

Data can be organized into two types:

= Filat Flle: Data is stofed in a single table. Usually suitable for less amount of data
Relational: Data iz stored in multiple tables and the tables are lInked using a commaon fiedd.
Relational is suitébla for medium 1o large amount of data

Databasa Servars

Database servers are dedicaled compuiers that hold the actual databases and mun ondy the
DBEMS and related software. Typically databases available on the database seners an accessad
|_!".4'{;|I_.Igh command hme oF IFREENIL LIS milerface (ooks referred 10 a8 Frontends: da WS
are referred to as Back-ends. Such type of data access is referred to as a client-serder mode




RDBMS

A relational database managemant system (RDBMS) is a database management system thal is
based on the relational model as introduced by E. F. Codd, of |1BM's San Josa Resaeanch Laboratory
Mot popular databases curmenily im use aré based on the refational database model

The relational model for database managememn is a database moded Dased on first-order predicale
logic, first formulated and proposed in 1968 by Edgar F. Codd. In the relational moded of a database,
all data is reprasenied i berms of fuphe cuped nlo relations, & database 1:|rg';1n|£r_':|;] in bErrms of
e redahongl moded 15 8 relabonal ga S

The purpose of the relatonal moded is 10 provide a declarative method for specit yireg dalta and
quenes: users directly state whal information the database contains and what information they
want from it, and lef the database managemeni system software take care of describing data
structures for storing the data and refrieval proceduras for answering quenes

Database Concepts

Database containg oeects that ane used Tor 'I|:j:-‘.:||':|g and mManaging informaEian, 1o undersiand
a database in very simple language, let’s ook at the example of your address book, What do
you store in an address book? You may have people’s name, people’s address, people’s phone
number and maybe eéven people’s birthdays. There is a common ebement here — people. In this
example, éach person 5 considertd &n “item"”. S0, an leém 5 what the database 15 storing
information about. Wihen Vou were recording information in your addness book at did you ask
the people? Whal is youwr address? What is your phone number? elc. Each guestion that we ask
about our item s a “fald". Mow, "a'.-' you make new friends and want o add their infermation
1o your address book. You will il EhE Answirs and creale a niew "recond”. |
record 5 a 521 of imioemation (made up ol e ed in your database aboutl one of the fems
“value®™ is the actwal text or numerical amount or date thal you put in while adding information to
your database. When you put all the information together in a grid {like you do in a spreadsheat),
a collection of simiar records creabes a fable

A database can have one or many tables. An address book example is a very simple ona, in real
I thvird 2@ ridny mdng dedaiks involeed. A big oo ¢ weduld haove an 1ks database. one table for
its products, one lable for s suppliers, one (abée for its customer detalls, one for orders receied
and maybe many others. Basically each lable in a database contains infermation about one type
of item. 5o a database is basically a confaner that holds tables and other objects and manages
how they coan be used

Another very important thing to remember is that when we put in infformation, we may have peopla
with the same name (there can ba more than one Charu Arora) or the same address {members
of a family). But when créaling a database an important feature is record uniguenass in every
tabde, It is important (o be able 1o dl.‘j:lll‘bg:;l_n:‘..]'1 Babaaan oflensanl (EmS h:_'i'-'u"q; duplicabe values
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can be achieved by using some number or value that uniguely identifies a record. i such a unique
value does not exist in your fields, as the dalabase designer, you can create a special additional
fizld in & table whene unigue numbers or values can be assigned for each new eniry. Thensfone,
gvery table has a l'.-m; figld which ensures thal thefe are 10 y unigLe values 1h|"|:j:-4_=5|'|{||.|! 1he
database

Every database table should have one or more fiekds designated as key. You can assign a unique
value to this key for differentiating records that may have similar names or address. Look at the
foldlowing examphe of stuedent database:

MNarme Eu_mand ' ql_nrgl:_tmn

Ram

|

I #
| Ravi .
[ Ravi

Sanjay

Imi this table, i will be edremely difficult to differentiate between student records as thay have
that are semilar, To differsniale. YO CAN add addtionad Geld - roll number = hat will ba
uniguee for each recond (example below)

|. Roling Name Standard Section |

' 149 Ram

20 =500
21 Ravi

x2 Sanjay

EXERCISE

Porform the following activities till you are confident.

—-

 S.No. |Activities ;

1 Pll'lEl'g.'?.E dalabage rE-qlJlrF.'['lH_‘.'r'llf_i for a retail 5-:I'!|-'."FI r{éi,'.-’.'lr-ﬂ thie business reqLingme nis
and documeni. I!'I'!EIIJ can use this information for EFEE'III'IQ a dalabase o sult this
| business requarament)
Anakyre da i
library, studeni admession centre, 1o gather requirements. Dooument the busing
req-Juremenl (You can use this information for ETEH[IFIQ A database to sult this
| requenement




Short Answear Questions

1. 'What does DBMS stands for?

2. ‘What does RDBMS stands for?

4. How is data ornganized in a RDBMS?

Fill in the blanks:

1. A i an arganized collection of data.

A is a software package that can be used for creating and managing
databases

A is a dalabase management system thal is based on the
relational model

Three popular DEMS software ane

SESSION 2: DATA STORAGE

Ralevant Knowledge

Data b a relational database management system (RDBMS) s organized in the foem of tables
“fou will nonw quickdy recap whiat you bearmni in the last session and assimilate more concepls

Tables:

A table is a sei of data elernents (values) thal is organized using a8 model of werical columnsg
{which are identified by their name) and honizontal rows. A table has a defined number of columns,
but can have any numbes of rows. Each row is identified by the values appeaning in a particular
codurmmn idenified as a unsguee l::',"" dax od the l::':':.' figded

Columns or Fields:

A codumn is a set of data values of a particular simple type, one for each row of the table,
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The Colpmnsg pros clure according o whech the rows ane composed, For example,
cFirsthame, or cLastdMame are fields in a row.

Rows or Records or Tuples:

A row also called a record o buple represents a single, data item in a table. In simple erms, a
databaze lable can be visualized 8% consisting of rows and columng of hebds. Each row in a lable
represenis a set of retated dala, and every row in the fable has the same struciure

Data types:

Datatypes ane used 1o dently which type of data (valee) we are going 1o shore in e dala
Fields themselves can be of different fypes depe g on the data they contain, Data types
OpenOifice base is broadly classified into five calegories listed beliow.

= Mumenc Types

= Alphanumens Types

*  Binary Types

¢ Dabe time

=  Dther Variable types

Mumeric Types:

MNumens data fypes ange used lof descnbing numenc values for he beld used ;o the jable of a
database. Mumeric data types in a database can be using for storing information such as mobila
number, roll number, door numbaer, year of school admission, true or false statements, statistical
valpes, ate. The different types of numenc data types avaslable are listed hane

Namo | Datatype |

: BOOLEAN Yas | No Valees as 0 or 1. Exampla: True ar False, Yes or Mo, |
TINYINT

Tirng I|‘|I1‘:~;:;| = e 1|‘|IE:~_'.:|1} I g i b O bo 255

SMALLINT Small inbiger Store integer range between -2 to +2'%-1

INTEGER Integer Store integer range Detween -2 (o +291-1

| BIGINT Big Integer ange between -2 to +29.1

| NUMERIC MNumber Maximum precision of e @t

DECIMAL Decimal Maximum precision of e/ ="

| REAL Real M | (2.2°) Prom

| FLOAT Float PT——

| DOUBLE | Double 20 I (2.28) e




Alphanumearnc Types.

MName Data typea Dascription

| LONGWVARCHAR Memao

Siores up o the max length or number indicated
by user. It accepts any UTF B Charactear.

5 i scibed by user, Pads
| CHAR Text {fix) alling 5 sirings. Accepls

VARCHAR Text i
(Same as long var char)

| Bionex up the specied length :E:I;I;"I'IFI:_'iI'.I!E:I;H'I'.-':: are .
ot case sensidnve bul stores capitals as You '.!"{.'IE
| tham.

HAR _IGNORE

Binary Types:

Eilr'lEIr':.' A Types ane used for sloring daka in nlr'l'r:li':f format s
be us r shosing pholos, music files, etc. In general, files of any format can be siored using the

binary data type. The different types of binary daia types available are listed hare.

Slones any array of byles (images, sounds, #lc.). Mo

DIMGW, INARY | Imade
LONGVARBINA mage valdahon required

BINARY Binary (fix) Shones any amay of byles. No validation reduened

| YARBINARY Binary Stores any array of bytes. No validation requéred

Drate time:

Date ime data types are used for descnibéng datle and fime values for the fiedd used in the table of
a database. Date time data types in a database can be using for storing information such as date
of birth, dale of admission, date of product sabe, eic, The differant types of dalke tene data fypes
available are listed harg.
—_—_—  ——— T

Description Format

| Date | Stores month, day and year information | 171099 to 1/1/999%

stores hour, menute and second
armation

Seconds since 1111970

Tirmse

| Timeestarmp
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Other Data Types:

E_Hama |

[ O Oigecl

senahzation roulines

You had used the example of an address book in the previous lesson. An address book uses only
one labde, But look al a different situation. if you are a deader selling a single type of item and
want o recond details of yiMar sales in the past montn and also wani the detads of the chent who
purchased the fem { name, address, phone, date purchased, number of lems bowght eic), wihat

)

wiould you do?. You create a table Sales with all the details:

Dr:larll:r' Customer Name I Customer Address |r Phone |r Sale Date | ﬂtﬂrﬁ.ﬂﬁught ;

| pROTES | Shesla Aroda | otoMoida | 2444480 | 0111112 3
| OFO0 | Vabhay Miflal wwrx Ghaziabad 091112 a4

| G0OTE1 | Sawrabh Tayal wxMew Delhi 2678045 | 02112 12

| 000792 | Vaibhav Mitttal | ;mxxGhaziabad 2443258 | 021112

Frashant Singh XuxxFohtak ITE4 534 | D212

l".'ﬂ.'.'H:I'.'ﬂ-ﬂ Shia Arora oooooMoida 2444400 | 031112

|"PCHI '-I 3 | Vaibhay Mittad 'b.-rnﬁh dIIbE:! | "-1-1 3..'5‘4 0312
D your s @ problem here? Every time you sell an dem to Sheala or Vaibhav or any other
: ong fable
3 nnsed a
ClientlD field to uniquety identify each client in the client table. In the Sabes table, you would give
a point of reference which “points™ to a particular record in the Client table.

In the axampla here, the field ChentlD ocowrs once in the Client table, buf since one chent can
place mam k. s & numbar of times in the Sales lable. Since we cannol have an order
] : il fhe parent a Sales e child lable, Relaled tab

Share 3 COoMmimn ||-F'||! 1|"1‘|u 51|:I-|'P data about pecple once, but reder o those people many Lmes
in the database

This wnigque field 5 called thie primary kay (PK). A pimany key 5 & waigue valve thal ideniiies
a8 row in 8 table, In our excample, Chentll) 5 the primany Key in e Chent table, PFimary Keys ane
also indexed in the database, making i faster for the database o search for a record.

The refermed field ClentlD which oocurs in the 5 table s called the foraign key [FK). Hence,
the foreign key identifies a column or set of ..a::lurn e in one (referencing) table that refars to a
colurmn or set of columns in another (referenced) tabde. The “one” side of a relation is always the




Client Table
| ClientiD |  Mame | Address Phone

DO Shila Arora NN 2444400

QOO0 2 Vaibhav Mittal | oooeGhaziabad | 2443358

0000003 | Saurabh Tayal | wexxMew Dedhi | 2678945

o | 0000004 | Prashant Singh | cooRohtak | 6784534 |

One client, three ianar'r H-frl
orders for that client. 3 o

Sales Table

| Orderd | ciieniD | SaleDate | #itemsBougnt |
000789 | 0000001 | 0111112 3

™| 000790 | 0000002 | 012

O rE DO 3 21z

000792 | DO00D02 o212

000793 0000004 | 0211112

000794 OO0 1 azinz

11z |

parent. and provides the P attributes to be copied. The “many” side of a relation ks abways tha
child, into which the FK attributes are copied. Memanze it one, parand, PE: many, child, FI

Another point 10 remember 5 (hat the end users willimay newer have direcl access to the
database. They can only see whal you permil them fo and can select only from the oplions you
Qive them.

Perform the following activities till you are confident:

 S.No. | Activities

1 Create a database for a stationery shop.
Hint : Create flields for items., price, cobor, vendor, elc
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Short Answer Questions
1 List thee data types used in a DEMS MHDEMSY
State the relationship and difference between a primary and foreign key?
List datatypes available in Mumenic Datatypa?
List datatypes available in Alphaumeric Datatype?
List datatypes available in Numenic Datatypa?
List datatypes available in Dala Datatype?

Fill in the blanks:

1 A 1% & 58 ol data elements that 3 :urg:.mzq';-::l Lging a oodel of werbical columnsg

e e

and honzonial rows.

& is a sef of data values of a particular simple bype, oné for each row of the
table

A represents a single, data item in a lable.

are used o identity which type of data we are going o slore i the

database

A 15 @ unique value that ideniifies a row i a table

SESSION 3: MANIPULATING DATA

Ralevant Knowledge

In a database you can define the structure of the data and manipulate the data wsing some
commands. There are o fypes afl I;jr'r:.:gljilgfer; for thes task, These ang

«  Data Definiton Language (DOL)
= [Data Manipulation Language (DML)
Data Definition Language (DDL)

A data definition language or data description language (DDL) is a standard for commands that
define the diferent structeres in a database. DDLU statements create, modily, and remowve database




obects such as tables, iIndexes, and users., Common DOL statements are CREATE, ALTER, and
DROE

Data Manipulation Language (DML)

A dala manipulation language (DML} Is a language thal enabéeg users o 8o and manipuiate
data in a database. The goal is fo provide efficient human interaction with the system. Data
manipulation involees:

. Fetmeval of information from the database- SELECT statement

*«  [nsedion of new information nto the database - INSERT statemeant

- Dedetsnn of informaedd o the dalabase - DELETE stabemenl

. Modification of information in the daiabase - UPDATE statement

A query language is a part of DML imvolbving information retrieval only. The terms DML and query
language are often used synonymaoushy.

A popular data manipulation language ks Structured Cueery Language (SOL). This is vsed to retrieve
and manipulate data in a relabional database. Other forms of DML are those wused by IMSDLI,
CODASYL databases, such as IDMS and others, Data manipulation [3nguadge compases the S0L
data change statements, which modidy stored data bul not the schema or database objects

There are two types of DML:
= Procedurall The user specifies what data is needed and how to gel it

Honprocedwral: The user only specifies what data s nesded, This B easaer for the user but
iy mod generale Coide @ effhicient as thal produced by procedural |E!I'IE|LI{I.-§:}E!5I.

ASSESSMENT

Fill in the blanks.

1. Types of Anguages used for creating and manipulating the data i the Database are
&

A s a siandard for commands that define the different stuciures in
a database.

A is 8 language that enables users o access and manipulate data in a
database.

o 15 @ parf of DML mnddving infonmabion nebreval ondy
& popular data manipulation ii,'ll'l-!;l._l'r:lri']ll': i%

Common DDL statlements ang
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SESSION 4: CREATING A DATABASE OBJECT

Relevant Knowledge

Thera are a vanety of DEMSRDBMS available; in this exercise, you will kearn about OpenOffice
Base an Open Source RDBMS

Launching Openoffice

= To launch OpenOffice, chck Sterr=Programs>0penOfice.org 34 1>0penOffice org.
Alternatively, you can also double-click on the OpenOffice.ong 3.4.1 shorbeut on the deskiop
if available. You should see a Window similar to the one displayed below

EETT i

e e s

Apache OpenOffice 3 9
I"I o, o e i Py

l.' R - E [T -

-.. -
I_ Framid i i Py

Trmpiars

.F Il£| U .rl.' | |
Select the opton databasa o launch the base application
You can also directly launch the OpenOffice Base Application by doing the following:

¢ Click Start>Programs®>0penOffice.org L4.1>0penOffice.org Base. You should are
guidiesd through the Database Wizard for creating a database. You will see a dialog oo
gamaar o the one dsplayed bekow




T e Uy o e Ty 5 e [ ey W

jli ]
BT B T O O e e L T
| d—

Figure 2

You can create a new dalabase by seleching the oplion Create a new database.

ou can also open an existing database file that you have already created by sslecting the opiion
Open an existing dafabase file.

Chck Mext. A dia

[ T P ——

o e P v by i B dialaen P g
- regee T e e v
Ty e A S

LB py mpas e Rt ER A e R S TR
= e P Daelaes B e STy
I Crmerm iy ey, P i g

Tk T s -

o | sueg | e ] e |

Figurs 3

Click Finigh. The 5awe As dialog box appears as shown below.
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Figura 4

Specify a name for the database in the Fife name: field and click Save. A window similar to the
one displayed be

g il s oyl
e N o= et Qub el e
k- =l

0 g Vgl e Py s Lo el e
R e e T
B Cimew e

Figure &

Mow that you have created a database, you can work with the database as outlingd in the neaxt
five BEGSI0NS




Porform the following activities till you are confident:
| S.No. |Activities

1 Create a dalabase

ASSESSMENT

Short Answer Questions:
1. What is the file axt n for databases crepted using OpenOifice. Org Base?

2. List any three file formats that can be managed using OpenOffice. Org Base?

SESSION 5: CREATING A TABLE

Rélavant Knowladga
Tables are the basic buildng blocks of a dalabase. You sbose the dala in the database in the
formm of tables. In the previous exercise you have leamt how o create dalabase objects In
OpenOifice,
Imi this exercise you will learm how to creafle a lable in a database.
Aler creal ing the database, you S8 4 window as shown Delow

B i s e Db Gesies e

- =R N "

e

o | [ e— DSEr—
L e R
o

L

e
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Chek on Croate Table in Design View... oplion avadable undger Tasks and a Tabhe Di.‘.'.ﬂ'gﬂ
wWindow appears s SO Dedonw,

B BE = Den e o

Figiery 7

Specify the field name and data type of the field to be created by selecting the appropriate type
available under Field type dropdown list.
Mow create a table with the Eollowing helds displayed below

Specify the feld name and the data type for each field name, For example, the table comlbaknsg
Mame field and the data type of the Mame is TEXT [VARCHAR). You can specify the length of the
fiedd value

Length
]

Roling E, |

DOo8 Drarber | DDMMNYY

| Class Char

| Phone INTEGER

Ema# VARCHAR

| Colour VARCHAR

| Location VARCHAR

AHer r:.ner:nr-.-nr'ng EriE Tl n@mse and data tyipe for the field varables, save the tabie b ) t'Jule:lr‘lE] 0
File>Save shown below,




" Flgure B
sSpecily the table name, The defaull name 5 Tablet, Chek OK.
f

i v g

| = | Carew | e !
_I.:l-; T rr:-Ei )
A diakos a1 irmilar to the aone displayed below
BTN

ﬂ -

L T SR SRR RN

R _ 1§

i e i e i e e s e o

[ . L

A e

i ] e | e |
Figure 10

You dne asked 10 et a piimany k{r':,r far ihi table wou Jur‘ﬂ criabesd, You can selec] the approprale
option 1o set the primany key of leave the table withoul & primanry key

If you click Yes, the application will set the primary key for the first fiekd created automatically. if
you click Mo, you should see a window similar to the one displayed below

a0 i
- s P e g S B

-l

= ———

Figure 11
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Motice the table by the name SDefals created and wissble under 1;

Cregbe the T

| Radha swaims
8, WManetwin ; i X AW { | VAararassTa

Orisga

| [ B | L'lt':-':l

To insart valses into the table. just doubla-click the table name, you should S8 a window similar
b the ane displayed below

D Edt pew Juert Took s o
& -

[ Don | Coes | Prone | Gmad | Colw | cocesen | |

Start typing the records in the table with the data provided in the axcel sheet and select File >
Savecurrent recond o save data in the able

Perform the following activities till you are confident:

[ S.No. |Activities

1 Create a table and enber data in it

2. Create a database to store your academic records using the guidefines below
+ Lise wour roll number as the file name for your database.

« Creabe fablds such as subject name, required scone, passing score and your
pefceniage
« Sel the subject name field ag the primany key

Fopulate wour database with your mosi recent exam resuls




ASSESSMENT

Fill im the blanks:
1. are the basic building blacks of a database.

To design a table, you need 10 Selee] i apelicn
avallable under Task

SESSION 6: BUILDING FORMS

Relavant Knowledge

A form provides the uSer a sysbemahc Wy o r::'.l:lrlr'l-;}|I‘:1n|:'r'r'|'.:|..u_‘.|r'| inko e database, 1S an inberface
1IN a8 user E:Flﬂﬂlrrl!ﬂ |F.I!"-i_'JIJ|Z thal kels users o veesy, enfer, and EI'IF.II"I’QF.' data I:Irl"F.'-i‘.r.l:r' N dalatane
I:ll:I|El'.'|Z‘5 SUCh 85 lables

Iru this axercise, you will keam bo craale a form

To create a form, Click on Forms option located under Database sachon (Figure below).

F igura 13

Chick Use Wizard fo Croate Form... oplion under Tasks group. The Form Wizand diabog box
appears as shown balow
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F igufa 14

You can selec! selective fields to be sent onto the form by selecting the fisld name and dicking =
bution. You can select individual fields in a database or all fields in a database

To use all the Gelds o the (abke i oa lonm, click the == Buthon

Motice the fields displayved under Flalds In the forms secton (Figure below)

s S A S R
° il Sy s S i

.1—-| | e |

o 15

v Saf up a Sub form sbep dia h::lg Box of the wirard & Wi Belonw.

— [ T — T——t———r—

§ o - S Lt

= b 5 e —— S
LU
e A P A S S

spes e ] e | s |

Figura 16




You can select the opon Add Subform i vou need o insert the conlents in the table in a separale
form. Click Next>,

Mowy wou nesd o amange selecled hekds in a formy, You can use diffenant shyvles from thie st
displayed below:

Lince you have slEd yhe, chick Moxt >

A 2k o appears whnerein you can selact the data entry modeid.

[ | e e
. —— -l-llll-u'.-il-m-lﬂ-ﬁ
PO
m o whn hr  ra —
m e
T s T e

|=||Jur1_I 18

Chick Mext > You should see a delog box whengin you can specity the sl b b used in the
form

Figura 19

Irfcmiategn Techingd ooy




Chok Next >, You see a ﬂ:ﬂl:}g box where you can specily the name of the form. Click Finish.

Figunp 20

A fosm window appears. Mobice that the records in the labbe are displayed automabically within the
form that you just created

You can add new records to the table using the form by clicking the #  symbal located at the
bottom A% shown below

C M mecoed s of & k

Figura 22

Once you click the ¥ symbol, you will be displayed with a window for creating records (Figure
below)




T
Lo L 1]

You have leami 1o creabe reconds using desagn view in ihe eanier SessEons, You can a0d reconds
using the form as displayed below. Type the following data in the textbox provided in the box as
SEWCATY DEiOn

Name Gautam

RoEng

Fhone

Color

Ernaail gautams Jiixgpmall.com

Localstn

Toy il thié Saved records, Double-click SDetalls (Table name) under Tables sacton, A window
sumikar 80 the one Delow will be displayed; nolice the record that you created using a form 5 alsn
displayed along with other records (Figure befow)
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Figure 24

Mow ented (hrde mone fecords wsing the form and view thern uging the above mentioned
procedune

EXERCISE

Perform the following activities till you are confident:

Enter data in a tabbe wsing a form

Create a form for the academic database created in the earber session. Populate the
academic databa IF mark resu ing 1 Barm

ASSESSMENT

Fill in the blanks:
1. A helps the user o systematically storé infermation in the database.

£ A enables users to view, enfer, and cha nge cata directly in dalabase oDpects SUCh
as iables

To create a form you need D sehec]




SESSION 7: CREATE AND MANAGE QUERIES

Relevant Knowledge

Having created the tables and antering data into tham, now you want to extract some information.
That's whikn you querny the database. As the name SUQQEsts, queny i5 to collsct spacific information
from e panl of data, A query helps us |in nlomaton fray different tahle rnd filler thal
information, Filtering means that the querny uses crileria you provige |f o hide some data and
present only what you want 1o sea.

Some RODBMSE provide a graphical means to creale quenes, but most RDBMS do nof do so. That's
wherg you use S0L (pronounced as “sequel™) or Structured Quary Language. Cuery languages
are compater |E‘|r'l_nj udges used to make guenes nlo databases and mformation :;':.-r:,lq;-i'r'ui_: QusaeEs

database

A SELECT statement retreves Zend of mone rows from one of morne database tables or database
vilws, |n most applcations, SELECT is the most oo |.1T'||:|:1E':|l used Dada Manipulabon L.Fl.'!l::]l_li:!gf_!
(DKL) command,

The SELECT staternent has many optional clauses:

. WHERE specifies which rows to retnieve.

*  DRDER BY specifies an ander in which to return the rows
To revfrigeve all the columns in a tabée the syniax s SELECT * FROM <TABLEMAME>;

Ini onder (o axecule quenes click on the Queries option availabla on the left side under database
siciion, click Create Quary in SQL View & sh

[ T S B R T— —

[ Crmam Chomp o g e
W fow S B Creww Query

s Pl ey B S

e iy B
rEEd Gt

Figuro 2§

Awindow appears similar to the one displayed below.
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Figure 286
You can type the guery In the above window and execute i by using tha F5S function key or by
CRCKING the & ICon M Ehe wirsiow
Faor example, if you want to display all the data in the table that you created in the early sassion,
i (he Select stabement will be: select * from SDotails;

Afper executing the sebect querny the output will be shown samilar o the one displayed below

Figuro 27
To get details abouwt the list of students whose favorite color is blue, you can use
sefect * from SDetails where Color="Blue’;

After executing the select query the output will be shown similar o the one displayed below

F Bew b abaa sl ey | il B e ity (et D

LF = BTy gy -
ey i Cmd

F:gurﬂ 8




T v PeConds in .'_iE.a:_‘.E:ﬂl!]:l‘ng arder of RollNo, from he lable the select statemen will e

salect * from SDelails order by “Rollne™ ASC;

o eim Ll b ol Chaerp | Opetrelie o sy Raae Qe Bermign

Pe= (raw? Josh Erdos Do
¥ & & g

- LR

Figuro 29
‘fou can add, modify or delele records using the Insert, Update and Delete commands
To type and exscute SOL commands, click on Tools > SOL. A window similar to the one babw

will b displayed
e &

r—
el
=
1
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EEEep— 5

=
=

| == |
Figune 30

Yiour can type the S0OL Commands in the Command o exacute space and click on Execute.
IMSERT statement

IMSERT statement is used to add one or more records o a database. The general syntax of the
insert statament 5 shown bélow,

INSERT INTO <table_name=<calumnd, calumn?, calumnd. > VALUES <valuel, valuel,
valued .. >

T add a record in the database created earlier, type the following and click Execula

ingert into SDetasds (U107, “Name”, "Rallng, DO, "0 ,Phong”, “Email”, "Cotar, “Location)
values ('8, "Ranjith Singh’, ‘67, "12-03-99' "X, ‘435363, ranjthS0@gmail.com’, “White', ‘Bihar');

Infcmiakegn ]ijl:hn:ll:r!;!.'




Aler inserting the data into the table. use select gueny 1o view the updated tabde, Aller execulion
you should see 8 wWindow simelar fo e one IZI'SFHE-'!.'EU bl
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Figuro 31 :
UPDATE statemont

Update statemend is used for modifying records in a database. The general syntax of the update
siatement is as follows:

UPDATE <table_name> SET <column_name> = value [, column_name = value ...] [WHERE
<gondition=]

To update a recond L3NG update statemend. by thi r-:}lh:;li.'l.'u'q;; and chek Execube,
update SDetalls sef Location = ‘Bhubaneswar' where Rollno = 14;

Execute select quary 1o view the updaled table. Afler axecution you should s&e a window similar
to the e displayed below

:_'l'q-'-.-l-. i

Figuro 32
DELETE statement

Dedete Statement 5 used 10 remove one of more records in a database, The general syntax of the
delele statement is as follows:

DELETE FROM =table_nama> [WHERE] <condition=;




To delete ane of 1he records in the lable crepled earker LSIng delete statement. fype the foliowing
and click Execute:

defete from SDetalls where [D=8;

Execuie select guery 10 view the updaled table. Afler exxecution you should s&e a window similar
to th one displayed Delow

B e e e e e
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Figurg 33

Motice the recond with the Roll Mo 8§ i delated from the databasa

CREATE Statement

d O A lakle n any RODBMS Solbwang .ﬂ.rnnn:n.-nln,.
used CRE M'.E r'umm'lnu:l 5 I:hr - HE ATE TABLE command, The general symax of the creale
sigiemnent is shown below.

CREATE TABLE <TABLEMAME®= (feolumn definftions]) [table parameters)
Ciodumn definiions: A comma-separated st consisting of any of the following
Ciodumn definition: [column name] [data type] (MULL | MOT MULL) {column options)
Primary kay definilion: PRIMARY KEY ([comma separated colemmn list])

For axampla, if you would ke 1o créale a table using the Create stalement, type the following and
chck Exgcute

CREATE TABLE Emgdopine (ID INTEGER, Name VARCHAR {50,
Deparment VARCHAR (50)
Address VARCHAR (120),
Contaci_Number INTEGER)

Mo create 5 records in the table and use the S0L statements fo view, n‘.~::u:h|":.- and delefe them

Irfcmiadegn '|i_'||:l'|r'|-=l|:|!;!|'




Perform the following activities till you are confident:

[ 8.Mo.

1

]

| Use the select gquery statement 1o query and sodt on subjects marks scored was |
greater than 50%

| Create a databage tor @ school ibrary
| Hink : Create fields for book fithe, cost, provider, availability, etc

| Create a database for maintaining a song collection,
| Hint - Create fieids for fiekis such as antist, movie, year released, etc

;r.:re:aw_: A dalahage tor -:_‘.'{LII-EH_.I.ulg and |‘|':.'_i||'|[.'_i||‘|||'|£| T a

“H|r'|l: Crdale helds Iod hebds such as First Name. Last Name. DOE, PiaoE of bath .

| Employmmant Status, elc

ASSESSMENT

Fill im the blanks:

A 15 helps (o collech specihic information from the ol 0d

statement ratrieves zero or more rows from one or more dalabase tables or
database vikws

statement is used io add one or mone records to a database.
statement s used for madifying records in a database
statement i3 used lo remove one of more records in a database

slatement i used for creating a database or a table in any RDEMS Softwara




SESSION 8: DESIGN REPORTS

Relavant Knowladga

A report is used 1o generate the overall work outcome in a clear format, Youw can also create
raports in databasa

Chck on Hepons sechon under Dalabase in the Openlithce b apphicatgn

Cnce you select the ophon, you shoukd see B wineow samedar (o ihe one displayed below.

Figure 34
Mo we can genarate the report for the table created aarlier,
Chick on Use Wizard fo Create Report... option available under Tasks

Once you select ihe Use Wizard to Create Report... ophion. You should sie a window sirmilar (o
one displayed below

o

brll
25

e S st e e & P
= -.- =T = -
Figura 35

o Sedect ol the table Relds by Sebecting the >> button, once you click the buthon == you
should s a dialeg Dox simikar (o ihe one displayed below

Infcrmakegn Tachingd ooy
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Figure 36
k Next >,
Cnce you click Next>you should see a :_lu'lh:rg Box sirmilar (o e S IZIIE;:F.i:I':r'E‘;! Edow

[N S
L F

Figung 37

You can redefing the Bbel of the fields n the reports oF else you can sel the defaull name
& Mext >,

Cince you dclick Mext =, you should see a dialog box similar to the one displayed below

e




Yol can delme GrOURING far the Belds of the table

Chick Naxi =,

Onece you click Next >, vou showld see a dialog box similar 1o the one gigplayed below
I =

iy, b b by i g v P it

it
+ i

oy
+ gy
oy

F|!:4| o 39
You can sort the hebd vanables n the repor by r:-.E:IE:{:Iu‘-E]I the appropriate feld and '!Ei{lf‘llr'l!.:[
el tegsd

b Mext >,

Once you click Next =, you should see a dialog box similar to the one displayed below

PR g g el it SO b e

ady iy e et g ot
By e Le B e e P
R e

Figure 40
You can select the layouwt of the report by selecting the appropriale oplion available under the
Layout of data dowm list and you can also selet! the orientation of the report

Click Next =,

LDnce you click Mext >, yvou should see a dialog box sirmilar b the one displayed balow

Infcmategn Tachingd ooy
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Figure 41

You can define a name for the report or you can use the name of the table isell for the report
also.

Click Einigh.

e S —
EE .. =

Figuro 42

eabe & repor containing only MHame, Koo and Phone details. Use different layouts for
the report design




Perform the following activities till you are confident:

| SNo. | Activities

1 Create a repor 1o display data from able

2 Open the achdemic database credted aaier

ASSESSMENT

Fill in the blanks:

3 Duxsign a repon o display youwr enting academic scone cand,

1. A is used 1o generate the overall work outcome in a clear format

2. Tocreale reporis you need o selecl opban avalable undar Tasks

Informaton Techno ogy
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